
 
 

RRB PO Mains 2025 Reasoning Section Memory-Based Paper (28 Dec 

2025) 
 
Directions (1-3): In the question below, some statements are given followed by two conclusions 

numbered I and II. You have to take the given statements to be true even if they seem to be at 

variance with commonly known facts. Read all the conclusions and then decide which of the 

given conclusions logically follows from the given statements, disregarding commonly known 

facts. Give answer- 

 

Q1. Statements: 

Only a few books are copies 

All copies are markers 

Some markers are pens 

No pens are paper 

Conclusions: 

I. All copies being books is a possibility 

II. Some markers are not paper 

III. No books being markers is a possibility 

(a) Only I follow 

(b) Only III follow 

(c) Both I and II follow 

(d) Both II and III follow 

(e) All I, II and III follow 

 

Q2. Statements: 

All boxes are tools. 

Only a few tools are sharp. 

Some boxes are not heavy. 

No sharp is plastic. 

Conclusions:  

I. All heavy being tools is a possibility  

II. Some boxes are plastic 

III. No boxes are plastic 

(a) Only II follow 

(b) Only I follow 

(c) Both I and II follow 

(d) Only I follow and Either II and III follow 

(e) Both II and III follow 

 

Q3. Statements: 

Only cups are mugs 

Some cups are table 

Some kettle is chair 

All table is kettle 
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Conclusions: 

I. No mugs being chair is a possibility 

II. All cups are kettle 

III. Some table being chair is a possibility. 

(a) Only I follow 

(b) Only III follow 

(c) Both I and II follow 

(d) Both II and III follow 

(e) All I, II and III follow 

 

Directions (4-8): Read the given information carefully and answer the questions that follow: 

Eight boxes A, B, C, D, E, F, G, and H are kept one above the other in a vertical stack, but not necessarily 

in the same order. Each box has a different stationery item among: Pen, Pencil, Eraser, Pins, Marker, 

Plates, Cups, Stapler 

Three boxes are kept between box A and the box which has pencil. Box A is kept above the box which 

has pencil. Two boxes are kept between box C and the box which has pencil. Box A is not kept 

immediately above box C. The box which has eraser is kept five boxes above box C. More than two boxes 

are kept between box G and the box which has eraser. Same number of boxes are kept below box G and 

above the box which has cups. The box which has pen is kept immediately below the box which has 

marker. The box which has pen and stapler is not kept at bottom-most position. One box is kept between 

box E and the box which has marker. The box which has pins is kept two boxes above the box D. Two 

boxes are kept between box D and box F. Box F is neither kept adjacent to box H nor has eraser.  

 

Q4. Which of the following statement is NOT true? 

(a) No box is kept between box E and the box which has pencil. 

(b) Box G is kept below the box which has cups. 

(c) The number of boxes kept above box E is one more than the number of boxes kept below the box 

which has stapler. 

(d) Box B has pencil 

(e) Two boxes are kept between boxes which has Cups and Pencil 

 

Q5. Box C has which item? 

(a) Marker 

(b) Pencil 

(c) Pen 

(d) Plates 

(e) Stapler 

 

Q6. How many boxes are kept above the box which has the Marker? 

(a) Two 

(b) Three 

(c) Four 

(d) Five 

(e) One 
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Q7. Four of the following five are alike in a certain way and thus form a group. 

Which one does not belong to the group?  

(a) Box E and the box which has cups 

(b) Box B and the box which has eraser 

(c) Box F and the box which has stapler 

(d) Box C and the box which has marker 

(e) Box G and the box which has pins 

 

Q8. Which of the following box has Stapler? 

(a) Box B  

(b) Box D 

(c) Box E 

(d) Box A 

(e) Box H 

 

Directions (9-11): The question below is followed by two statements numbered I and II. You have 

to decide whether the data provided in the statements are sufficient to answer the question. 

Read both statements carefully and give the answer: 

 

Q9. Six persons A, B, C, D, E and F sit around a circular table and face towards the centre. Who sits 

immediately to the right of E? 

Statements: 

I. A sits immediate right of D. C is not an immediate neighbour of D and A. One person sits between C 

and E. E and A are not immediate neighbours. 

II. Two persons sit between F and G. B sits second to the right of G. D sits immediate left of A. 

(a) Only statement I is sufficient 

(b) Both statements I and II together are sufficient 

(c) Either statement I or statement II is sufficient 

(d) Only statement II is sufficient 

(e) Both statements I and II, even together are not sufficient 

 

Q10. Six persons P, Q, R, S, T and U go for trip on six different days of the week from Monday to 

Saturday. On which day does S goes for trip? 

Statements: 

I. U goes for trip after Tuesday. Two persons go for trip between U and Q. T goes for trip before S. 

II. Q goes for the trip three persons before S. T goes for trip immediately before S. T goes for trip before 

Thursday.  

(a) Only statement II is sufficient 

(b) Both statements I and II together are sufficient 

(c) Either statement I or statement II is sufficient 

(d) Only statement I is sufficient 

(e) Both statements I and II, even together are not sufficient 
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Q11. In a certain code language, how is the word “Against” coded? 

Statements: 

I. In that language, “Rise against odds” is coded as “hb tr tp” and “Rise Strong Always” is coded as “tp ef 

gv”. 

II. In that language, “Speak against lies” is coded as “wn hb ur” and “Speak against time” is coded as “ur 

hv hb”. 

(a) Only statement II is sufficient 

(b) Both statements I and II together are sufficient 

(c) Either statement I or statement II is sufficient 

(d) Only statement I is sufficient 

(e) Both statements I and II, even together are not sufficient 

 

Directions (12-16): Study the following information carefully and answer the questions given 

below. 

Seven persons – A, B, C, D, E, F, and G –are designated at seven different designations in a company, 

namely Peon, Trainee, Assistant Manager (AM), Manager (MG), Assistant General Manager (AGM), 

General Manager (GM) and CEO and each of them bought a different book – Macbeth, Inferno, Rebecca, 

Othello, Persuasion, Ivanhoe, and Matilda (not necessarily in the same order). All the posts are in 

increasing order of seniority, where Peon is the junior-most and CEO is the senior-most. 

D is designated four persons junior to the one who bought Rebecca. No person was designated between 

the ones who bought Rebecca and Inferno. The one who bought Inferno is designated senior to the one 

who bought Rebecca. Two persons are designated between G and the ones who bought Inferno. The 

number of persons designated junior to G is one more than the number of persons designated senior to 

E. Four persons are designated between E and the one who bought Ivanhoe. A is designated junior to 

MG and two persons junior to the one who bought Macbeth. Three persons are designated between the 

ones who bought Othello and Matilda. The one who bought Othello is designated immediately junior to 

F. B doesn’t bought Matilda. 

 

Q12. How many persons are designated senior to the one who bought Matilda? 

(a) Six 

(b) Two 

(c) Three 

(d) Four 

(e) None 

 

Q13. What is the designation of F? 

(a) GM 

(b) CEO 

(c) AGM 

(d) MG 

(e) AM 
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Q14. Who is designated three designations senior to the one who bought Ivanhoe? 

(a) The one who bought Persuasion 

(b) The one who bought Macbeth 

(c) D 

(d) The one who is AGM 

(e) G 

 

Q15. Which of the following statements is correct? 

I. C is designated senior to the one who bought Persuasion. 

II. Only four persons are designated senior to F.  

III. More than two persons are designated between E and D. 

(a) Both I and II 

(b) Only II 

(c) Only III 

(d) Both I and III 

(e) All I, II and III 

 

Q16. Which of the following combinations is correct? 

(a) G – Othello – Trainee 

(b) E – Inferno – AGM 

(c) A – Persuasion – Trainee  

(d) B – Ivanhoe – Peon 

(e) D – Matilda – Manager 

 

Directions (17-21): Study the following information carefully and answer the questions given 

below. 

Ten persons sit in two rows parallel to each other, Row-1 and Row-2. Each row consists of five persons. 

A, B, C, D and E sit in Row-1 face south and M, N, O, P, Q sit in Row-2 face north. All persons of both rows 

face each other. Each person is studying a different type of bird namely Eagle, Sparrow, Parrot, Pigeon, 

Peacock, Owl, Duck, Swan, Falcon and Kite, but not necessarily in the same order. 

The one who studies about sparrow sits third to the right of M. The one who sits opposite to M, sits 

immediate right of the one who studies about eagle. Only one person sits between the one who studies 

about eagle and pigeon. E sits immediate right of the one who studies about pigeon. Immediate 

neighbour of the one who sits opposite to E, studies about duck. More than one person sits between Q 

and the one who studies about duck. A sits second to the left of the one who studied about swan. A sits 

opposite to the one who sits third to the right of P. One of the immediate neighbour of P, studies about 

owl. M doesn’t study about falcon and owl. The one who studies about falcon faces north and sits 

opposite to the one who studies about Parrot. B sits opposite to the one who studies about kite. N neither 

sits opposite to D nor studies about owl. 

 

Q17. The person who sits opposite to D, sits in which position with respect to the one who studies 

about falcon? 

(a) Immediate left 
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(b) Second to the left 

(c) Second to the right 

(d) Third to the right 

(e) Third to the left 

 

Q18. Which of the following statements is/are true? 

I. Q studies about duck. 

II. The person who studies about parrot sits diagonally opposite to the one who studies about kite. 

III. The number of persons who sit to the right of O is one less than the number of persons who sit to 

the right of C. 

(a) Only I 

(b) Both II and III 

(c) Only III 

(d) Both I and II 

(e) Both I and III 

 

Q19. How many persons sit between O and the person who faces the one who studies about 

peacock? 

(a) None 

(b) One 

(c) Two 

(d) Three 

(e) Can’t be determined 

 

Q20. Who among the following sits second to the right of C? 

(a) A 

(b) B 

(c) The person who faces O 

(d) The person who studies about eagle 

(e) The one who sits opposite to Q 

 

Q21. Four of the following five pairs are alike in a certain way and thus form a group. Which one 

pair does not belong to that group? 

(a) The one who studies about sparrow – C 

(b) B – the one who studies about kite 

(c) The ones who studies about parrot and falcon 

(d) D-M 

(e) E- the one who studies about owl. 

 

Directions (22–26): A word–number arrangement machine, when given an input line of words 

and two-digit numbers, rearranges them following a particular rule in each step. The example of 

input and its rearrangement is given below. 

Input: 22  goat  45  egg  15  sun  68  hair  54  pens 
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Step I: 20  22  goat  45  sun  68  hair  54  pens  gee 

Step II: 27  20  45  sun  68  hair  54  pens  gee  eqcr 

Step III: 50  27  20  sun  68  54  pens  gee  eqcr  fckp 

Step IV: 59  50  27  20 sun  68 gee  eqcr  fckp  nglq 

Step V: 73  59  50  27  20  gee  eqcr  fckp  nglq  qwl 

Step V is the last step of the given example. Illustrate the above input arrangement and obtain the steps 

for the asked input given below: 

Input: 64  lamp  58  toy  33  fan  26 cook  49  net 

 

Q22. Which of the following word is third from the right end of Step III? 

(a) toy 

(b) aqqi  

(c) aqzi 

(d) jckn 

(e) qqz 

 

Q23. What is the sum of the first numbers from the left end in Step IV and Step V respectively? 

(a) 119 

(b) 142 

(c) 132 

(d) 122 

(e) 127 

 

Q24. Which of the following is second to the left of the word ‘rqw’ in Step V? 

(a) dcl  

(b) 54 

(c) lgr 

(d) 31 

(e) jckn 

 

Q25. What is the difference between the highest and the lowest number in Step II? 

(a) 35 

(b) 48 

(c) 34 

(d) 33 

(e) 63 

 

Q26. Which of the following combination of words and numbers is present in Step IV correctly in 

the same sequence? 

(a) 31 64 toy aqqi dcl jckn  

(b) 38 31 65 toy dcl 

(c) 31 64 toy aqqi jbkn dbl  

(d) 31 64 toy aqqi jckn dcl  
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(e) 38 31 64 toy acqi 

 

Directions (27-30): Study the following information carefully and answer the given questions: 

Seven persons – A, B, C, D, E, F and G – purchased different numbers of books, but not necessarily in the 

same order. 

C purchased more books than D but less books than A. The person who purchased the third highest 

number of books purchased 12 books. The person who purchased the lowest number of books 

purchased a prime number of books. Only one person purchased books between B and G. G purchased 

less books than B. F purchased more books than B but less books than C. A purchased 14 books but did 

not purchase the highest number of books.  

 

Q27. What is the highest possible number of books purchased by G, if B purchased 10 books? 

(a) 11 

(b) 9 

(c) 8 

(d) 7 

(e) 5 

 

Q28. If the sum of books purchased by A and B is 24 and the sum of books purchased by C and G 

is 17, then what is the sum of the number of books purchased by B and G? 

(a) 16 

(b) 17 

(c) 18 

(d) 15 

(e) Can’t be determined 

 

Q29. How many persons purchased less books than E? 

(a) Two 

(b) None 

(c) Four 

(d) Five 

(e) Six 

 

Q30. Which of the following persons purchased the third 

highest number of books? 

(a) The one who purchased immediately more books than A 

(b) C 

(c) A 

(d) D 

(e) F 
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Directions (31-33): Study the following information carefully and answer the questions given 

below. 

F is the sister-in-law of B. S is married to G. F is the only daughter of M. A is the brother-in-law of G. N is 

the son-in-law of K. D is the mother of B. B and G doesn’t have any siblings. S is the grandson of M. T is 

the mother of H. H is the uncle of S. D is the married member of the family. H is not married to B. N 

doesn’t have any child. There is one single parent in the family.  

 

Q31. How is N related to M? 

(a) Nephew 

(b) Son 

(c) Cousin 

(d) Grandson 

(e) Brother 

 

Q32. How many female members are there in the family? 

(a) Four 

(b) Can’t be determined 

(c) Six 

(d) Seven 

(e) Five 

 

Q33. Which of the following statement is not true? 

(a) T is the grandmother of S 

(b) D’s son-in-law is the brother of H. 

(c) There are three persons in first generation in the family. 

(d) There are four married couples in the family. 

(e) K is married to D 

 

Q34. In the number ‘7853468359’, if the digits at even place from left end is subtracted by 2 and rest 

of the digits are added by 1 then remove all the digits which are repeated more than twice. After that 

arrange the resultant digits in descending order from left. Now, find the sum of first digit and last digit 

in the new number formed after rearrangement?  

(a) 11  

(b) 7  

(c) 10  

(d) 9  

(e) 4 

 

Q35. From the options given below, the numbers represent the positions of letters in the word 

from the left end. If using those letters which are denoted by the numbers, a four-letter 

meaningful word is formed, then which of the following options will NOT form a four-letter 

meaningful word? 

(a) TRAINING : 1, 2, 4, 6 
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(b) HOSPITAL : 1, 2, 3, 6 

(c) GARDENER : 2, 3, 5, 8 

(d) FRIENDLY : 1, 2, 3, 4 

(e) All of these 

 

Q36. Statement: A manufacturing company has observed a steady increase in workplace accidents over 

the last six months. Most accidents are reported during night shifts. The management is concerned 

about employee safety and production loss. 

Which of the following is the most appropriate course of action? 

(a) The company should shut down night shifts permanently. 

(b) The company should ignore the issue as accidents are unavoidable. 

(c) The company should review safety measures and provide additional training for night-shift workers. 

(d) The company should dismiss workers involved in accidents. 

(e) The company should reduce production targets. 

 

Q37.  Statement: A private fitness club allows all its registered members to use the gym facilities 

without any restriction during working hours. In addition to this, the club management occasionally 

permits a few non-member visitors to use the gym for a limited time after completing a formal 

permission process. These visitors are not part of the registered membership list. 

Which of the following is a valid inference? 

(a) All visitors are registered members. 

(b) Some gym users are not registered members. 

(c) Registered members need special permission to use the gym. 

(d) Visitors use the gym more frequently than members. 

(e) Only visitors are allowed to use the gym. 

 

Q38. Statement: A city park authority observed that during festive seasons, the demand for decorative 

flowers increases sharply. To meet this demand, vendors often store large quantities of flowers in open 

areas for several days. After such periods, complaints about foul smell and increased insect activity 

around the park rise noticeably. Officials suspect that improper handling and storage of flowers may be 

causing these issues. 

Which of the following hypotheses is most likely true? 

(a) Decorative flowers should not be used during festivals. 

(b) Festivals are responsible for environmental pollution. 

(c) Proper storage and timely disposal of decorative flowers can reduce insect problems. 

(d) Insects increase only due to seasonal weather changes. 

(e) Flower vendors intentionally create unhygienic conditions. 

 

Q39. Statement: Ayan, a resident of a semi-urban area, observed that children around his house rarely 

interacted with each other and spent most of their evenings indoors using smartphones and tablets. 

Concerned that this lifestyle might reduce physical fitness and limit real-world social interaction, Ayan 

planned to arrange regular outdoor games and sports activities for children on weekends. 

Which of the following is an implicit assumption in the above statement? 
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(a) Children will immediately stop using smartphones if outdoor games are arranged. 

(b) Outdoor games can help improve physical health and social bonding among children. 

(c) Schools have failed to encourage physical activities among children. 

(d) Parents are forcing children to use smartphones. 

(e) All children dislike indoor activities. 

 

Q40. Statements: A shopkeeper purchased a batch of goods at a certain price and sold all of them at a 

discount. Even after offering the discount, the shopkeeper earned an overall profit because the goods 

were purchased at a comparatively lower cost. 

Conclusions: 

I. The shopkeeper must have sold each item at a price higher than its cost price. 

II. Purchasing goods at a lower cost can help earn profit even after offering discounts. 

III. Offering discounts always leads to loss for the seller. 

Which of the following conclusion supports the above statement? 

(a) Only I follows 

(b) Only III follows 

(c) Only I and II follow 

(d) Only II and III follow 

(e) Only II follows 

 

Solutions 
 

S1. Ans.(c) 

Sol. I. Follow: The relation of ‘all copy being books’ will follow in possibility because the relation of all 

copies towards books in undefined in definite case.  

II. Follow: The part of markers which is pens will not be paper.  

III. Not follow: As per the statement, it is already given that some parts of books are markers. So, their 

negative relation will not follow even in possibility.  

 
 

S2. Ans.(d) 

Sol. I. Follow: Heavy and tools are not directly related to each other. Hence, possible relation will follow 

between them.  

Conclusion II and III do not follow individually in definite case because boxes and plastic are not directly 

related to each other.  

But conclusion II and III are satisfying the condition of ‘either-or’ 
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S3. Ans.(b) 

Sol. I. Not follow: Because of ‘only’ relation, mugs is related to cups only and its relation is restricted 

with other elements even in possibility.  

II. Not follow: As per the statement ‘some part of cups are kettle’ but the definite relation of all cups 

being kettle will not follow.  

III. Follow: Table and chair are not directly related to each other, hence the possible relation between 

them will follow.  

 
 

Solutions (4-8): 

Boxes Colours 

A Pins 

H Cups 

D Eraser 

E Stapler 

B Pencil 

F Marker 

G Pen 

C Plates 

 

S4. Ans.(c) 

Sol. Statement in option (c) is not true 

 

S5. Ans.(d) 

Sol. Box C has plates 
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S6. Ans.(d) 

Sol. Five boxes are kept above the box which has marker 

 

S7. Ans.(e) 

Sol. Except option (e) i.e., G and pins, the logic followed in rest pair is: First box is placed two boxes 

below that box containing given item.  

 

S8. Ans.(c) 

Sol. Box E has stapler 

 

S9. Ans.(c) 

Sol. Either statement I or statement II is sufficient 

From Statement I: D sits immediately to the right of E. 

 

From Statement II: B sits immediately to the right of E. 

 

 

S10. Ans.(a) 

Sol. From Statement II: S goes for trip on Thursday. 

Days Persons 

Monday Q 

Tuesday  

Wednesday T 

Thursday S 

Friday  

Saturday  
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S11. Ans.(b) 

Sol. From Statement I: 

Words Codes 

Rise tp 

Against/Odds hb/tr 

Strong/ Always ef/gv 

From Statement II: 

Words Codes 

Lies wn 

Against/Speak hb/ur 

Time hv 

After combining both the statements, the code of the word “Against” is “hb”. 

Words Codes 

Rise tp 

Lies wn 

Time hv 

Against hb 

Odds tr 

Speak ur 

Strong/ Always ef/gv 

 

Solutions (12-16): 

Designations Persons Books 

CEO C Matilda 

GM E Inferno 

AGM B Rebecca 

 MG F Macbeth 

AM G Othello 

Trainee A Persuasion 

Peon D Ivanhoe 

 

S12. Ans.(e) 

Sol. No one is designated senior to the one who bought Matilda. 

 

S13. Ans.(d) 

Sol. F is designated as MG (Manager). 

 

S14. Ans.(b) 

Sol. The one who bought Macbeth is three designations senior to the one who bought Ivanhoe.  

 

S15. Ans.(d) 

Sol. Statement I and III is correct.  
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S16. Ans.(c) 

Sol. The combination given in option (c) is correct.  

 

Solutions (17-21): 

Final Arrangement: 

 
Clues: The one who studies about sparrow sits third to the right of M. The one who sits opposite to M, 

sits immediate right of the one who studies about eagle. Only one person sits between the one who 

studies about eagle and pigeon. E sits immediate right of the one who studies about pigeon. 

Inference: Here we get two possible cases: 

 
Clues: Immediate neighbour of the one who sits opposite to E, studies about duck. More than one person 

sits between Q and the one who studies about duck 

Inference: Case 2 gets cancelled here because there is no place for Q: 

 
Clues: A sits second to the left of the one who studied about swan. A sits opposite to the one who sits 

third to the right of P. One of the immediate neighbours of P, studies about owl. M doesn’t study about 

falcon and owl. The one who studies about falcon faces north and sits opposite to the one who studies 

about Parrot. 

Inference: Above clues are arranged and we get the following output. 
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Clues: B sits opposite to the one who studies about kite. N neither sits opposite to D nor studies about 

owl. 

Inference: Only place for C, O and Peacock is left. Now, the final arrangement is here: 

 
 

S17. Ans.(e) 

Sol. P sits opposite to D and P sits third to the left of the one who studies about falcon. 

 

S18. Ans.(b) 

Sol. Statements II and III, both are true. 

 

S19. Ans.(b) 

Sol One person sits between O and the person who faces the one who studies about peacock. 

 

S20. Ans.(d) 

Sol. The person who studies about eagle i.e. D sits second to the right of C.  

 

S21. Ans.(d) 

Sol. Except D-M, all the persons sit opposite to each other. 

 

Solutions (22–26): 

Sol. Logic of the given arrangement:  

For numbers: The numbers are picked in ascending order and arranged after adding 5, at extreme left 

end in each step. 

For words: The words are picked in dictionary order and in the given word vowels are changed to 

second succeeding letter and consonants are changed to second preceding letter and then they are 

arranged at extreme right end in each step.  
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Input: 64  lamp  58  toy  33  fan  26 cook  49  net 

Step I: 31 64  lamp  58  toy 33  fan 49  net aqqi 

Step II: 38 31 64 lamp  58  toy 49  net aqqi dcl 

Step III: 54 38 31 64 58 toy net aqqi dcl jckn 

Step IV: 63 54 38 31 64 toy aqqi dcl jckn lgr 

Step V: 69 63 54 38 31 aqqi dcl jckn lgr rqw 

 

S22. Ans.(b) 

Sol. ‘aqqi’ is third word from the right end of Step III. 

 

S23. Ans.(c) 

Sol. The sum of the first two numbers from the left end of Step IV and Step V: 63+69=132. 

 

S24. Ans.(e) 

Sol ‘jckn’ is second to the left of the word ‘rqw’ in Step V. 

 

S25. Ans.(d) 

Sol. The difference between the highest and the lowest number in Step II: 64-31= 33. 

 

S26. Ans.(a) 

 

Solutions (27-30): 

Final Arrangement: 

 
Clues: C purchased more books than D but less books than A. The person who purchased the third 

highest number of books purchased 12 books. The person who purchased the lowest number of books 

purchased a prime number of books. 

Inference: 

 

 
Clues: A purchased 14 books but did not purchase the highest number of books. 

Only one person purchased books between B and G. G purchased less books than B. F purchased more 

books than B but less books than C.  

Inference: Only E was left to be arranged. Now the final arrangement is:  
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S27. Ans.(d) 

Sol. The highest possible number of books purchased by G is 7, if B purchased 10 books (because G has 

prime number of books). 

 

S28. Ans.(d) 

Sol. A+B =24; 14+B=24; B = 24-14 = 10 

C+G = 17; 12+G=17; G=17-12 =5 

B+G= 10+5 = 15. 

 

S29. Ans.(e) 

Sol. Six persons purchased less books than E. 

 

S30. Ans.(b) 

Sol. C purchased the third highest number of books. 

 

Solutions (31-33): 

 
 

S31. Ans.(b) 

Sol. N is the son of M. 

 

S32. Ans.(e) 

Sol. Five female members are there in the family. 

 

S33. Ans.(c) 

Sol. Statement (c) is not true.  

 

S34. Ans.(c) 

Sol. Given number = 7853468359 

Operation 1 = 8661549167 (even place digit from left – 2, rest digit + 1) 

Operation 2 = 8154917 (remove digits repeating more than twice i.e., 6) 

Operation 3 = 9875411 (rearrange the digit in descending order from left) 

Sum of first and last digit= 9 + 1 = 10 

 

S35. Ans.(a) 

Sol. TRAINING → positions 1,2,4,6 → T, R, I, I 

No meaningful 4-letter word can be formed.  

HOSPITAL → positions 1,2,3,6 → H, O, S, T 
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Rearranged as HOST (meaningful).  

GARDENER → positions 2,3,5,8 → A, R, E, R 

Rearranged as RARE & REAR (meaningful).  

FRIENDLY → positions 1,2,3,4 → F, R, I, E 

Rearranged as FIRE (meaningful). 

 

S36. Ans.(c) 

Sol. Explanation: The action directly addresses the cause (safety during night shifts) and is practical 

and preventive. 

 

S37. Ans.(b) 

Sol. Explanation: 

The statement clearly mentions that some visitors (who are not registered members) are also allowed 

to use the gym. Hence, it logically follows that some gym users are not registered members. 

 

S38. Ans.(c) 

Sol. Explanation: 

The statement links improper storage of flowers with increased insect activity and foul smell. Hence, 

the most logical hypothesis is that better storage and disposal practices can reduce the problem. 

 

S39. Ans.(b) 

Sol. Explanation: 

Ayan’s plan to organize outdoor games is based on the belief that outdoor activities positively impact 

children’s physical health and social interaction. This assumption is necessary for his action to be 

meaningful. 

 

S40. Ans.(e) 

Sol. Explanation: 

Conclusion I does not necessarily follow because overall profit does not guarantee profit on each 

individual item. 

Conclusion II directly follows from the statement and is clearly supported. 

Conclusion III is false, as the statement itself shows profit despite 

discount. 

Hence, only Conclusion II follows. 

 

 

 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://www.adda247.com/product-testseries/79075/test-prime?productId=79076


 
 

RRB PO Mains 2025 Quantitative Aptitude Section Memory-Based 

Paper (28 Dec 2025) 
 

Directions (1-6): Find the missing number in the following number series. 

 

Q1. 7, ?, 34, 70,142, 286  
(a) 16 
(b) 10  
(c) 21  
(d) 7  
(e) 14  
 
Q2. 13, ?, 52, 130, 442, 2002  

(a) 51 
(b) 13  
(c) 26  
(d) 39  
(e) 35  
 
Q3. 78, 121, 168, 221, ?, 341  

(a) 210 
(b) 280  
(c) 205  
(d) 235  
(e) 225  
 
Q4. 87, ?, 144, 204, 285, 387  

(a) 110 
(b) 100  
(c) 105  
(d) 135  
(e) 125  
 
Q5. 12, 133, 214, 263, ?, 297  

(a) 288 
(b) 270  
(c) 289  
(d) 290  
(e) 295  
 
Q6. 96, 48, 72, 180, ?, 2835  

(a) 610 
(b) 680  
(c) 605  
(d) 635  
(e) 630  
 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://www.adda247.com/product-testseries/79075/test-prime?productId=79076


 
 

Directions (7-12): The pie chart given below shows the percentage distribution of fictional 

books and non-fictional books sold by four sellers and another pie chart shows the percentage 

distribution of fictional books sold by these sellers. 

 

Note – (I) Total fictional books and non-fictional books sold = 1500 

(II) Total fictional books sold = 1000 

 

Q7. Find the ratio of fictional books sold by A and B together to non – fictional books sold by C.  

(a) 37:10 

(b) 10:37 

(c) 11:13 

(d) 13:12 

(e) 15:17 

 

Q8. There are two type of fictional books Hindi and English. If the number of English fictional 

book sold by D is 25% of total non-fictional books sold by sold by C, then find the Hindi fictional 

books sold by D is what percentage of difference between total books sold by C and D.  

(a) 100% 

(b) 110% 

(c) 90% 

(d) 30% 

(e) 130% 

x%

2x%

25%

45%

Percentage distribution of 
fictional books and non-

fictional books sold

A

B

C

D

12%

y%

27.5%

35.5%

Percentage distribution 
of fictional books sold

A

B

C

D
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Q9. Find the difference between average number of fictional books sold by A and B together to 

non-fictional books sold by A, B and C. 

(a) 120 

(b) 100 

(c) 110 

(d) 115 

(e) 125 

 

Q10. If the cost of fiction books is 14.28% more than that of non-fictional book for all the sellers 

and total revenue generated by C after selling all the books is Rs. 5800. Find the sum of revenue 

generated after selling fictional books by A and D.  

(a) 7600 

(b) 7100 

(c) 8100 

(d) 7500 

(e) 7250 

 Q11. The ratio of total books sold by E and C is 2:1 and out of the total books sold by E, 1/5th are 

the non-fictional books. If the ratio of fictional books sold by E to F is 2:5, then find the fictional 

books sold by F. 

(a) 1500 

(b) 1000 

(c) 1100 

(d) 1150 

(e) 1250 

 

Q12. Find the difference between total fictional books sold by C and D together and total non-

fictional books sold by all the given seller. 

(a) 130 

(b) 100 

(c) 110 

(d) 115 

(e) 125 

 

Directions (13-18): The bar graph shows the total number of orders (veg + non-veg) delivered 

by different restaurants (A, B, C and D) in the month of March. The table shows the distribution 

of non-veg orders for each restaurant out of the total non-veg orders delivered by all four 

restaurants. 

Restaurants  
Percentage distribution of non-veg orders for each restaurant out of the total 
non-veg orders delivered 

A 10% 
B 40% 
C 15% 
D 35% 
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Note – Difference between number of veg and non-veg orders delivered is 36.  

 

Q13. In D, the ratio of chicken fry to fish curry orders is 3:4, and the total number of dine-in 

chicken fry orders is 5 and rest are take away. Find the take away chicken fry orders is what 

percentage of veg orders placed in C. (non-veg= chicken fry to fish curry) 

(a) 28 

(b) 18 

(c) 38 

(d) 48 

(e) 58 

 

Q14. The selling price of non- veg orders is 50% more than the veg orders for all the restaurants 

and the revenue generate by selling all the veg orders by B is Rs.M. Find the ratio revenue of 25% 

veg orders sold by A to 50% non-veg orders sold by D. 

(a) 2:7 

(b) 7:2 

(c) 1:3 

(d) CND 

(e) None of these 

 

Q15. Find the veg orders delivered by C is what percentage of 

non-veg orders delivered by A and C.  

(a) 133.33 

(b) 153.33 

(c) 113.33 

(d) 83.33 

(e) 125.33 
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Q16. Restaurant E, sold 75% more veg orders then veg orders sold by A and the ratio of total 

orders sold by E to D is 2:1, then find the non-veg orders sold by E. 

(a) 120 

(b) 100 

(c) 81 

(d) 90 

(e) 125 

 

Q17. The ratio of 5 rating to 3 rating given by the customers on veg orders delivered by D is 1:4 

and percentage of rating 3 with comment is 40% more than rating 3 with no comment. Find the 

rating 3 with no comment  is what percentage more/less than total orders placed by B. 

(a) 133.33 

(b) 106.33 

(c) 113.33 

(d) 83.33 

(e) 125.33 

 

Q18. Find the difference between total veg orders delivered to non-veg orders delivered by all 

the restaurants. 

(a) 0 

(b) 1 

(c) 2 

(d) 3 

(e) 4 

 

Q19. P can complete 1/10 of a work in 14 days. P and Q together can complete the same work in 

42 days. If R can complete 85% of the work in 25½ days, then in how many days will Q and R 

together complete 2/3 of the work? 

(a) 16.67 

(b) 12.5 

(c) 13 1/3 

(d) 14.28 

(e) 19 

 

Q20. The ratio of the curved surface area of a cylinder to the area of its base is 3 : 2. If the volume 

of the cylinder is 6468 cubic cm, find the height of the cylinder (in cm). 

(a) 14.5 

(b) 12.5 

(c) 11 

(d) 10.5 

(e) 17.5 

 

Q21. A person invests Rs 2399.69 in Scheme A, which offers a compound interest rate of 19.99% 

for 2 years and 4 days. Another sum of Rs 3999.70 is invested in Scheme B for T years and 3 days 
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at an interest rate of 9.01%. If the total interest earned from both schemes is Rs 2496, find the 

value of T. 

(a) 8 

(b) 6 

(c) 3 

(d) 5 

(e) 4 

 

Q22. A and B enter into a partnership by investing Rs 4400 and Rs 3000 respectively. After x 

months, B withdrew Rs 1200. If the ratio of the annual profit of A to that of B is 11 : 17, find the 

value of x. 

(a) 10 

(b) 5 

(c) 9 

(d) 7 

(e) None of these 

 

Q23. The marked price of item A is twice that of item B. Item A is sold at a discount of 40%, while 

item B is sold with a flat discount of Rs 800. The combined cost price (CP) of both items is Rs 

4000. If the overall transaction results in a loss of 10%, calculate the marked price of item A. 

(a) 4400 

(b) 3800 

(c) 4000 

(d) 5000 

(e) 6500 

 

Q24. A person spends 40% of their monthly income on rent and 15% on other items. From the 

remaining income, 30% is spent on groceries, and the rest is saved. If the difference between the 

amount spent on groceries and the amount saved is Rs 8999.99, find the difference between the 

amount (in Rs) spent on rent and the amount spent on groceries. 

(a) 13250 

(b) 14550 

(c) 19200 

(d) 18500 

(e) 15150 

 

Q25. Train P, running at 108 km/hr, crosses Train Q in 36 seconds when traveling in the same 

direction. The two trains cross each other in 30 seconds when traveling in the opposite direction. 

Find the ratio of the length of Train P to the length of Train Q. 

(a) 7:5 

(b) 5:1 

(c) 3:5 

(d) 1:2 

(e) Can’t be determined  
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Q26. The average weight of 30 students in a class is 48.6 kg. The ratio of the average weight of 

boys to that of girls is 6 : 5. If the average weight of the girls is 9 kg less than the average weight 

of the boys, find the total number of girls in the class. 

(a) 12 

(b) 18 

(c) 15 

(d) 24 

(e) 8 

 

Q27. Two boats, A and B, are operating in the same stream. The downstream speed of Boat A is 

equal to the upstream speed of Boat B. The ratio of the upstream speed of Boat A to the 

downstream speed of Boat B is 1 : 3. 

Quantity I: 500% of the speed of the stream. 

Quantity II: The speed of Boat B in still water. 

(a) Quantity I > Quantity II  

(b) Quantity I < Quantity II 

(c) Quantity I ≥ Quantity II  

(d) Quantity I ≤ Quantity II  

(e) Quantity I = Quantity II or no relation 

 

Q28. The Highest Common Factor (HCF) of a number x and 630 is 70. The Least Common Multiple 

(LCM) of the same number x and 60 is 420.  

It is given that x = 35y², where y is a prime number. 

Quantity I: 2x − 3y 

Quantity II: 198y − x 

(a) Quantity I > Quantity II  

(b) Quantity I < Quantity II 

(c) Quantity I ≥ Quantity II  

(d) Quantity I ≤ Quantity II  

(e) Quantity I = Quantity II or no relation 

 

Q29. P invested Rs. X in Scheme A which offers R% simple interest for eight years after eight 

years the interest becomes 2.8 times of the amount he invested. If he invested Rs. (X+280) in 

scheme B which offers simple interest for three years at the same rate of interest, the interest 

received is Rs.1995, then find the value of X/2? 

(a) 740 

(b) 680 

(c) 920 

(d) 810 

(e) 1020 

 

Q30. ‘A’ purchased two beds at same price. He further sold one bed to ‘B’ at 60% profit and other 

bed to ‘C’ at 20% profit. ‘C’ further sold the bed to ‘D’ at 20% less than the average of cost price 

of bed for ‘B’ & ‘C’. If D incurred 25% loss by selling the bed to ‘E’ at Rs.2100, then find the 

difference between the cost price of a bed for ‘A’ and ‘D’ 
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(a) 180 

(b) 560 

(c) 440 

(d) 240 

(e) 300 

 

Q31. In a 124-litre mixture, the ratio of milk to water is 3 : 1. If x liters of milk and 1.5x liters of 

water are added to the mixture, the difference between the quantity of milk and water in the 

resultant mixture becomes (2x + 2). Find the value of x. 

(a) 30 

(b) 24 

(c) 32 

(d) 15 

(e) 18 

 

Q32. The ratio of the present ages of Amit and his father is 1 : 4. The sum of the present ages of 

Amit, his father, and his mother is 140 years. Furthermore, 3 years ago, Amit’s mother’s age was 

28 years less than 5 times Amit’s age at that time. Find the present age (in years) of Amit. 

(a) 18 

(b) 23 

(c) 25 

(d) 14 

(e) 31 

 

Directions (33-37): Read the information carefully and answer the following questions. The 

number of males travelling on Tuesday is 30 less than the number of males travelling on Sunday. The 

number of females travelling on Tuesday is 2 less than the number of females travelling on Monday. 

On Sunday: The total number of males travelling is 60% of the total males and females travelling. 

On Monday: The total number of males travelling is 75% of the total males and females travelling. 

On Tuesday: The total number of males and females travelling is 40 less than the average of the total 

males and females who travelled on Sunday and Monday.  

Note - 260 males and females travel in three days (i.e. Sunday, Monday, and Tuesday). 

 

Q33. Find the ratio of males travelling on Sunday to females travelling on Tuesday. 

(a) 1:7 

(b) 4:1 

(c) 4:3 

(d) CND 

(e) None of these 

 

Q34. Find the difference between males and females in all the given days. 

(a) 108 

(b) 105 

(c) 88 

(d) 84 
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(e) 90 

 

Q35. Find the males travelling on Sunday and Monday together is what percentage of total 

people travelling on Sunday and Monday. 

(a) 66 

(b) 72 

(c) 25 

(d) 16 

(e) 32 

 

Q36. Total Males and females travelling on Wednesday is 50% more than total females working 

in all the given days. Find the difference between total males and females working on 

Wednesday and females working on Monday. 

(a) 108 

(b) 103 

(c) 105 

(d) 104 

(e) 109 

 

Q37. Find the sum of 25% less males in Monday and 60% more females in Tuesday. 

(a) 333 

(b) 233 

(c) 325 

(d) 314 

(e) 331 

 

Q38. Set A consists of 5 distinct prime number. Set B consists of 5 consecutive odd numbers. How many 

numbers in set A are greater than or less than the second smallest number in set B. 

Statement I- The product of the largest number in set B and smallest number in Set A is 55.  

Statement II- The sum of the smallest number in set A and one of the numbers in set B is 10 and their 

product is greater than 21.  

(a) Statement I alone is sufficient. 

(b) Statement II alone is sufficient. 

(c) Both statements together are sufficient. 

(d) either Statements I or II together are sufficient.  

(e) neither Statements I nor II together are not sufficient. 

 

Q39. What is the perimeter of a circle? 

Statement I. The side of a square is equal to the diameter of the circle.  

Statement II. Length of a square equals half of the length of a rectangle whose  

 (a) Statement I alone is sufficient. 

(b) Statement II alone is sufficient. 

(c) Both statements together are sufficient. 

(d) either Statements I or II together are sufficient.  

(e) neither Statements I nor II together are not sufficient. 
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Q40. The radius of circles X is 25% less than that of circle Y and the sum of circumference of 

circle X and diameter of circle Y is 188 cm. If the ratio of height of a right angle triangle to the 

radius of circle Y is 5 : 4 and area of triangle is 350 cm square, then find based of the triangle? 

(a) 20 cm 

(b) 16 cm 

(c) 18 cm 

(d) 24 cm 

(e) 30 cm 

 

Solution  
 

S1. Ans.(a) 
Sol. Pattern of the series –  

 
 
S2. Ans.(c) 

Sol. Pattern of the series – 

 
 
S3. Ans.(b) 

Sol. Pattern of the series – 

 
 
S4. Ans.(c) 

Sol. 

Pattern of the series –  

 
 
S5. Ans.(a) 

Sol. Pattern of the series –  
(square of consecutive odd numbers)  
12 +121 = 133  
122 +81 = 214  
214+49 = 263  
263+25 = 288  
288 + 9 = 297  
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S6. Ans.(e) 

Sol. Pattern of the series –  

 
 

Solutions (7-12): 

From pie chart 1-  

(45 +25 +2x + x)% = 100 % 

3x = 30 

10 = x  

From pie chart 2,  

(27.5+12+35.5+y)% = 100% 

25 = y  

Sellers Total books Fictional books Non – fictional books 

A 10% of 1500 = 150  12% of 1000 = 120 30 

B 20% of 1500 = 300 25% of 1000 = 250 50 

C 25% of 1500 = 375 27.5% of 1000 =275 100 

D 45% of 1500 = 675 35.5% of 1000 =355 320 

Total  1500 1000 500 

 

S7. Ans.(a) 

Sol. 120 +250: 100 = 370:100 = 37:10  

 

S8. Ans.(b) 

Sol. Number of English fictional book sold by D = 25% of 100 = 25 

Number of Hindi fictional book sold by D = 355 – 25 = 330  

Required answer = 330/(675-375)x100 = 110% 

 

S9. Ans.(e) 

Sol. Required difference = 
120+250

2
−

30+50+100

3
=185 – 60 = 125 

 

S10. Ans.(a) 

Sol. Let cost of non-fictional book be = 7x 

Let cost of fictional book be = 8x 

275×8x+100×7x= 5800 

2 = x  

Required answer = (120 + 355) × 8 × 2 = 7600 

 

S11. Ans.(a) 

Sol. Total books sold by E = 2 x375 = 750  

Non-fictional books sold by E = 1/5th of 750 = 150  

Fictional books sold by E =750 – 150 = 600  

Fictional books sold by F =
5

2
× 600 = 1500 
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S12. Ans.(a) 

Sol. Required answer = 275 +355 – (500)= 130 

Sol (13-17) 

Let the veg and non-veg orders in B are x and y. 

60 = x + y  

Case 1.  

36 = x – y   

Then,  

48 = x and y = 12  

Case2.  

36 = y – x 

Then  

48 = y and 12 =x  

Using case 1.  

48 = x and y = 12  

40% = 12  

1% = 12/40 

So,  

10% = 3, 15% = 4.5 (decimal value is obtained) 

Using case2.  

48 = y and 12 =x  

40% = 48  

1% = 1.2 

10%= 12, 15% = 18, 35% = 42  

Case 2 is correct. 

Restaurants Total orders Veg orders Non-veg orders 

A 48 36 12 

B 60 12 48 

C 64 46 18 

D 72 30 42 

 

S13. Ans.(a) 

Sol. Chicken fry orders in D = 
3

(3+4)
× 42 = 18  

Fish curry orders in D = 42 – 18 = 24 

The total number of dine-in chicken fry orders = 5 

The total number of take away chicken fry orders =18 – 5 = 13 

Required answer =
13

46
× 100 = 28.26% = 28 

 

S14. Ans.(a) 

Sol. Let the cost of veg orders be 100x 

So, the cost of non-veg orders be 150x 
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12× 100𝑥 = 𝑀  

Required ratio = (25% of 36 )×100x:(50% of 42)×150x  

900x:3150x = 90:315 = 10:35 = 2:7 

 

S15. Ans.(b) 

Sol. Required answer = 46/12+18 × 100 = 153.33% 

 

S16. Ans.(c) 

Sol. Veg orders sold by E = 175% of 36 = 63  

Total orders sold by E = 2× 72 = 144 

Required answer = 144 – 63 = 81  

 

S17. Ans.(d) 

Sol. Customer giving 5 rating = 
1

5
× 30 = 6  

Customer giving 3 rating = 30 – 6 = 24 

Rating 3 with comment/ rating 3 with no comment =140/100 = 7x:5x 

12x = 24  

2 =x  

Required answer = 
60− 5×2

60
× 100 = 83.33% 

 

S18. Ans.(e) 

Sol. Required difference = 36+12+46+30 – (12+48+18+42) = 124 – 120 = 4  

 

S19. Ans.(c)  

Sol. Information Given in the Question: 

P does 1/10 work in 14 days → Total work = 140 days for full work 

P + Q together do full work in 42 days 

R does 85% work in 25.5 days 

Required: Time taken by Q and R to complete 2/3 of the work 

Concept/Formula Used in the Question: 

LCM Method: Assume total work = LCM of all work units (use 840 units) 

Work = Time × Rate 

85% = 85/100 = 17/20 

Use: Time = Work / (Q + R)'s combined rate 

Detailed Explanation: 

Assume Total Work = 840 units (LCM of 140, 42, etc.) 

→ P does full work in 140 days → P’s 1-day work = 840 / 140 = 6 units/day 

→ P + Q together complete work in 42 days → (P + Q)'s 1-day work = 840 / 42 = 20 units/day 

→ Q’s 1-day work = (P + Q) - P = 20 - 6 = 14 units/day 

R's Work 

R does 85% of the work in 25.5 days 

→ 85% of 840 = (85/100) × 840 = 714 units 
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→ R’s 1-day work = 714 / 25.5 = 28 units/day 

Q + R Together 

Q = 14 units/day, R = 28 units/day 

→ Q + R = 14 + 28 = 42 units/day 

We need time to complete 2/3 of the work: 

→ 2/3 of 840 = 560 units 

Time = Work / Rate = 560 / 42 = 13⅓ days 

 

S20. Ans.(d) 

Sol. Information Given in the Question: 

Ratio of curved surface area (CSA) to base area = 3 : 2 

Volume of the cylinder = 6468 cm³ 

Concept/Formula Used in the Question: 

CSA of cylinder = 2𝜋𝑟ℎ 

Base Area of cylinder = 𝜋𝑟2 

Volume of cylinder = 𝜋𝑟2ℎ 

Given: 
2𝜋𝑟ℎ

𝜋𝑟2 =
3

2
⇒

2ℎ

𝑟
=

3

2
 

Detailed Explanation: 

Use the ratio of CSA to base area:  
2𝜋𝑟ℎ

𝜋𝑟2
=

3

2
⇒

2ℎ

𝑟
=

3

2
 

4ℎ = 3𝑟 ⇒ 𝑟 =
4ℎ

3
 

𝜋𝑟2ℎ = 6468  

𝑟 =
4ℎ

3
: 

𝜋 (
4ℎ

3
)

2

ℎ = 6468 

⇒ 𝜋
16ℎ3

9
= 6468 

⇒
16𝜋ℎ3

9
= 6468  

ℎ3 =
6468×9

16𝜋
  

⇒ ℎ3 =
58212

50.24
 

ℎ3 = 1157.625 

⇒ ℎ = √1157.625
3

 

ℎ = 10.5 cm  

 

S21. Ans.(e) 

Sol. Information Given in the Question: 

We take approx. values 

Scheme A: Principal = Rs 2400, Rate = 20%, Time = 2 years 
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Scheme B: Principal = Rs 4000, Rate = 9%, Time = T years 

Total Interest = Rs 2496 

Concept/Formula Used in the Question: 

Compound Interest (CI): 

𝐶𝐼 = 𝑃 [(1 +
𝑅

100
)𝑇 − 1] 

Simple Interest (SI): 

𝑆𝐼 =
𝑃 × 𝑅 × 𝑇

100
 

Detailed Explanation: 

Scheme A (Compound Interest): 

𝐶𝐼 = 2400 [(1 +
20

100
)2 − 1] 

= 2400[(1.2)2 − 1] 

= 2400(1.44 − 1) 

= 2400 × 0.44 = Rs 1056  

Total Interest from both = 2496 

Interest from Scheme B = 2496 − 1056 = Rs 1440 

Use Simple Interest formula: 

𝑆𝐼 =
4000 × 9 × 𝑇

100
= 1440 

⇒ 360𝑇 = 1440 

⇒ 𝑇 =
1440

360
= 4 years  

 

S22. Ans.(e) 

Sol. Information Given in the Question: 

A invests Rs 4400 for 12 months 

B invests Rs 3000 for x months, then reduces to Rs 1800 for (12 - x) months 

Final profit ratio (A : B) = 11 : 17 

Concept/Formula Used in the Question: 

Profit is distributed in the ratio of investment × time. 

Detailed Explanation: 

Let’s 

A’s investment × time = 4400 × 12 = 52800 

B’s investment × time = 3000x + 1800(12 - x) 

= 3000x + 21600 - 1800x 

= (3000 - 1800)x + 21600 = 1200x + 21600 

Now, as per question: 

A : B = 11 : 17 

So, 
52800

1200𝑥+21600
=

11

17
  

52800 × 17 = 11 × (1200𝑥 + 21600)  

897600 = 13200𝑥 + 237600  
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13200𝑥 = 897600 − 237600 = 660000  

𝑥 =
660000

13200
= 50  

 

S23. Ans.(c) 

Sol. Information Given in the Question: 

MP of A = 2 × MP of B 

Discount on A = 40% 

Discount on B = Rs 800 

Combined Cost Price (CP of A + CP of B) = Rs 4000 

Overall transaction results in 10% loss 

Concept/Formula Used in the Question: 

Selling Price (SP) = MP - Discount 

Loss % = [(CP - SP) / CP] × 100 

Overall SP = 90% of total CP = 0.9 × 4000 = Rs 3600 

Detailed Explanation: 

Let the marked price of item B = Rs x 

Then, marked price of item A = Rs 2x 

Selling Price of A = 60% of 2x = 0.6 × 2x = Rs 1.2x 

Selling Price of B = x – 800 

Total SP = 1.2x + (x - 800) = 2.2x - 800 

Total CP = Rs 4000 

We are told the total SP = 90% of total CP = Rs 3600 

So, 

2.2x - 800 = 3600 

→ 2.2x = 4400 

→ x = 2000 

So, MP of A = 2x = Rs 4000 

 

S24. Ans.(a) 

Sol. We take approx. values 

Information Given in the Question: 

Rent = 40% of monthly income 

Other items = 15% of monthly income 

From remaining 45%, groceries = 30%, savings = 70% 

Difference between groceries and savings = Rs 9000 

Concept/Formula Used in the Question: 

Total remaining income = 100% - 40% - 15% = 45% 

Grocery amount = 30% of 45% = 0.30 × 0.45 × income = 0.135 × income 

Savings = 70% of 45% = 0.70 × 0.45 × income = 0.315 × income 

Difference = Savings - Grocery = 0.315x - 0.135x = 0.18x = 9000 

→ Solve for x (monthly income) 

Detailed Explanation: 
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Let monthly income = Rs x 

Then: 

Grocery amount = 13.5% of x = 0.135x 

Savings = 31.5% of x = 0.315x 

Difference = 0.315x - 0.135x = 0.18x = 9000 

→ 0.18x = 9000 

→ x = 9000 / 0.18 = 50,000 

Now, 

Rent = 40% of 50000 = Rs 20,000 

Grocery = 13.5% of 50000 = Rs 6,750 

Required difference = 20000 - 6750 = Rs 13,250 

 

S25. Ans.(e) 

Sol. Information Given in the Question: 

Speed of Train P = 108 km/hr = 30 m/s 

Time to cross Train Q when moving in the same direction = 36 seconds 

Time to cross each other when moving in opposite directions = 30 seconds 

Concept/Formula Used in the Question: 

Relative Speed (same direction) = Speed of P − Speed of Q 

Relative Speed (opposite direction) = Speed of P + Speed of Q 

Distance = Speed × Time 

Total length covered = Sum of lengths of both trains 

Detailed Explanation: 

Convert speed of Train P: 

108 × 5/18 = 30 m/s 

Let: 

Speed of Q = v m/s 

Length of P = LP 

Length of Q = LQ 

Same direction: 

LP + LQ = (30 − v) × 36 …(1) 

Opposite direction: 

LP + LQ = (30 + v) × 30 …(2) 

Equate (1) and (2): 

(30 − v) × 36 = (30 + v) × 30 

1080 − 36v = 900 + 30v 

180 = 66v 

v = 180 / 66 = 30 / 11 m/s 

Now total length: 

LP + LQ = (30 + 30/11) × 30 

= (360/11) × 30 

= 10800 / 11 m 
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There is no extra information to separately get LP and LQ, so their ratio LP : LQ cannot be found uniquely 

by any “normal” (algebraic) method. 

So, Can’t be determined  

 

S26. Ans.(b) 

Sol. Information Given in the Question: 

Total students = 30 

Overall average weight = 48.6 kg 

Ratio of average weight (boys : girls) = 6 : 5 

Average weight of girls is 9 kg less than boys 

Required: Number of girls in the class 

Concept/Formula Used in the Question: 

Let number of boys = B, number of girls = G 

So, B + G = 30 

Let average weight of boys = 6x, average of girls = 5x 

Given: 6x − 5x = 9 ⇒ x = 9 

ATQ, 
𝐵(6𝑥)+𝐺(5𝑥)

30
= 48.6  

Detailed Explanation: 

From the given: 

Average of boys = 6x, average of girls = 5x 

Difference = 9 ⇒ x = 9 

So, boys' average = 54 kg, girls' average = 45 kg 

Let number of girls = G 

Then number of boys = 30 − G 

Total weight = 48.6 × 30 = 1458 kg 

Now: 

Weight of boys = (30 − G) × 54 

Weight of girls = G × 45 

So, 

(30 − 𝐺) × 54 + 𝐺 × 45 = 1458  

1620 − 54𝐺 + 45𝐺 = 1458  

⇒ 1620 − 9𝐺 = 1458 

⇒ 9𝐺 = 162 

⇒ 𝐺 = 18  

 

S27. Ans.(e) 

Sol. Given: 

Let the speed of stream = s 

Let the speed of Boat A in still water = a 

Let the speed of Boat B in still water = b 

Downstream speed of Boat A = Upstream speed of Boat B 
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𝑎 + 𝑠 = 𝑏 − 𝑠. . . (1)  

Ratio of the upstream speed of Boat A to the downstream speed of Boat B is 1 : 3 
𝑎−𝑠

𝑏+𝑠
=

1

3
. . . (2)  

From (1): 

𝑎 + 𝑠 = 𝑏 − 𝑠 ⇒ 𝑏 = 𝑎 + 2𝑠  

Substitute in (2): 
𝑎−𝑠

(𝑎+2𝑠)+𝑠
=

1

3
  

𝑎−𝑠

𝑎+3𝑠
=

1

3
  

3(𝑎 − 𝑠) = 𝑎 + 3𝑠  

3𝑎 − 3𝑠 = 𝑎 + 3𝑠  

2𝑎 = 6𝑠  

𝑎 = 3𝑠  

From 𝑏 = 𝑎 + 2𝑠 = 3𝑠 + 2𝑠 = 5𝑠 

Quantity I: 500% of the speed of stream = 5𝑠 

Quantity II: Speed of Boat B in still water = 𝑏 = 5𝑠 

So, Quantity I = Quantity II 

 

S28. Ans.(a) 

Sol. Given: 

HCF(𝑥, 630) = 70  

LCM(𝑥, 60) = 420  

And 

𝑥 = 35𝑦2, where 𝑦 is a prime.  

Prime factorization of given numbers 

630 = 2 × 32 × 5 × 7  

60 = 22 × 3 × 5  

70 = 2 × 5 × 7  

420 = 22 × 3 × 5 × 7  

Use HCF condition 

HCF(𝑥, 630) = 70  

means 𝑥 shares exactly the prime factors 2,5,7with the same or higher powers as in 70, but not 

introducing higher common powers with 630. 

𝑥 = 35𝑦2 = 5 × 7 × 𝑦2  

Let’s find what 𝑦can be. 

For the HCF to be 70 = 2 × 5 × 7, 𝑥must contain 5and 7, and 630 must contain at least one factor of 2 in 

common with 𝑥. 

But 𝑥 = 35𝑦2 = 5 × 7 × 𝑦2. 

This has no factor 2 unless 𝑦 = 2. 

So 𝑦 = 2must be the prime. 

Check: 

Then 𝑥 = 35 × 22 = 140. 
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Check HCF(140, 630) 

140 = 22 × 5 × 7  

630 = 2 × 32 × 5 × 7  

HCF = 21 × 5 × 7 = 70 correct. 

Check LCM(140, 60) 

140 = 22 × 5 × 7  

60 = 22 × 3 × 5  

LCM = 22 × 3 × 5 × 7 = 420 correct. 

So 𝑥 = 140 and 𝑦 = 2 satisfy both. 

Compute the quantities 

Quantity I = 2𝑥 − 3𝑦 = 2(140) − 3(2) = 280 − 6 = 274  

Quantity II = 198𝑦 − 𝑥 = 198(2) − 140 = 396 − 140 = 256  

So, Quantity I > Quantity II  

 

S29. Ans.(d) 

Sol. Information Given in the Question: 

Principal for Scheme A = Rs. X 

Time for Scheme A = 8 years 

Simple Interest from Scheme A = 2.8 × X 

Principal for Scheme B = Rs. (X + 280) 

Time for Scheme B = 3 years 

Interest from Scheme B = Rs. 1995 

Same rate R% is used in both schemes 

Concept/Formula Used in the Question: 

Simple Interest (SI) = (P × R × T) / 100 

Detailed Explanation: 

From Scheme A: 

SI =
𝑋×𝑅×8

100
= 2.8𝑋  

Divide both sides by X: 
𝑅×8

100
= 2.8  

𝑅 =
2.8×100

8
= 35%  

Use this rate R = 35% in Scheme B: 

SI =
(𝑋 + 280) × 35 × 3

100
= 1995 

Calculate: 
(𝑋+280)×105

100
= 1995  

(𝑋 + 280) × 1.05 = 1995  

𝑋 + 280 =
1995

1.05
= 1900  

𝑋 = 1900 − 280 = 1620  

Required value = X / 2 = 1620 / 2 = 810 

 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://www.adda247.com/product-testseries/79075/test-prime?productId=79076


 
 

S30. Ans.(e) 

Sol. Information Given: 

A buys 2 beds at same CP = x each. 

Bed 1 → sold to B at 60% profit. 

Bed 2 → sold to C at 20% profit. 

C sells to D at 20% less than the average of CP for B and C. 

D sells to E at Rs 2100 with 25% loss. 

Asked: Difference between CP of a bed for A and CP for D. 

Formula Used: 

Profit SP = CP × (1 + profit%). 

Loss SP = CP × (1 − loss%). 

Average of two numbers = (a + b)/2. 

Explanation: 

Let the cost price of each bed for A = Rs x. 

He bought two beds at the same price. 

Selling prices for B and C 

To B: sold at 60% profit 

⇒ Selling price to B = 𝑥 + 0.6𝑥 = 1.6𝑥 

To C: sold at 20% profit 

⇒ Selling price to C = 𝑥 + 0.2𝑥 = 1.2𝑥 

C sells to D 

D bought the bed from C at 20% less than the average of cost prices of the bed for B and C. 

Average of cost prices of the bed for B and C = 
1.6𝑥+1.2𝑥

2
= 1.4𝑥 

20% less than this average =1.4𝑥 − 0.2(1.4𝑥) = 1.4𝑥 × 0.8 = 1.12𝑥 

So, Cost Price for D = 1.12x 

D sells to E at 25% loss for ₹2100 

Selling price for D = ₹2100 

Loss = 25% 

So, Cost Price for D = 
2100

0.75
= 2800 

Hence, 

1.12𝑥 = 2800  

Solve for x 

𝑥 =
2800

1.12
= 2500  

Cost price for A = Rs 2500 

Cost price for D = Rs 2800 

Required Difference = 2800 − 2500 = Rs 300 

 

S31. Ans.(b) 

Sol. Information Given in the Question: 

Total mixture = 124 litres 

Ratio of milk to water = 3 : 1 
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Milk added = x litres 

Water added = 1.5x litres 

Difference between milk and water in final mixture = (2x + 2) 

Detailed Explanation: 

Initial Milk and Water 

Total mixture = 124 litres 

Ratio of Milk : Water = 3 : 1 

So, 

Milk = (3/4) × 124 = 93 litres 

Water = (1/4) × 124 = 31 litres 

Additions 

Milk added = x litres 

Water added = 1.5x litres 

Final Milk = 93 + x 

Final Water = 31 + 1.5x 

Final Difference 

ATQ, (93 + x) - (31 + 1.5x) = 2x + 2 

93 - 31 + x - 1.5x = 2x + 2 

62 - 0.5x = 2x + 2 

62 - 0.5x - 2x - 2 = 0 

60 - 2.5x = 0 

2.5x = 60 

x = 60 / 2.5 = 24 

 

S32. Ans.(a) 

Sol. Information Given in the Question: 

Present age ratio (Amit : Father) = 1 : 4 

Sum of present ages of Amit, father, and mother = 140 years 

3 years ago: Mother's age = 5 × (Amit’s age at that time) – 28 

Detailed Explanation: 

Let Amit’s present age be x 

Father’s present age = 4x 

Total present ages = x + 4x + Mother's age = 140 

→ 5x + Mother’s age = 140 

→ Mother’s age = 140 - 5x ...(1) 

Now, use the condition from 3 years ago: 

Mother’s age 3 years ago = (140 - 5x) - 3 = 137 - 5x 

Amit’s age 3 years ago = x - 3 

Given: 

137 - 5x = 5(x - 3) - 28 

→ 137 - 5x = 5x - 15 - 28 

→ 137 - 5x = 5x - 43 

→ 137 + 43 = 10x 
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→ 180 = 10x 

→ x = 18 

Sol (33-37) 

Let the males travelling on Sunday be 3x  

So, the females travelling on Sunday = 2x 

Let the males travelling on Monday be 3y  

So, the females travelling on Monday = y  

Total females and males travelling on Tuesday = 
5𝑥+4𝑦

2
− 40  

5x + 4y + 
5𝑥+4𝑦

2
− 40 = 260  

7.5x + 6y = 300  

5x + 4y = 200 (1) 

Also,  

Males travelling on Tuesday = 3x – 30  

Females travelling on Tuesday = y – 2  

3x – 30 + y -2 = 
5𝑥+4𝑦

2
− 40  

3x +y – 32 = 2.5x +2y – 40  

0.5x – y = - 8  

y - 0.5x = 8  

10y – 5x = 80  

2y – x = 16  (2) 

24 = x and y = 20  

Days Total  Males  Females 

Sunday  120 72 48 

Monday  80 60 20 

Tuesday  60 42 18 

Total 260 174 86 

 

S33. Ans.(b) 

Sol. Required answer = 72:18 = 4:1 

 

S34. Ans.(c) 

Sol. Required answer = 174 - 86 = 88 

 

S35. Ans.(a) 

Sol. Required percentage = 
72+60

120+80
× 100 = 66% 

 

S36. Ans.(e) 

Sol. Total Males and females travelling on Wednesday = 150% of 86 = 129 

Required answer = 129 – 20 =109  

 

S37. Ans.(a) 
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Sol. Required answer = 
75

100
× 60 +

160

100
× 18 = 45 + 288 = 333 

 

S38. Ans.(b) 

Sol. Let the prime number be a,b,c,d,e 

Let the odd number be x, x+2, x+4, x+6, x+8 

Statement I- 

product of the largest number in set B and smallest number in Set A = 55  

55 x 1 = 55 (wrong) 

11 x 5 = 55 

Case 1.  

(x+8)× a = 55  

11× 5 = 55  

a = 5, x = 11-8 = 3 

A – 5, 7,11,13,17 

B – 3,5,7,9,11 

4 numbers are greater. 

Case 2. 

(x+8)× a = 55  

5×11 = 55  

a = 11, x = 8 – 11 = -3 

A – 11,13,17,19,23 

B – -3,-1,1,3,5 

5 numbers are greater. 

Answer is Contradicting. So, Statement I alone is not sufficient 

Statement II- 

Sum = 10  

(1,9), (3,7), (4,5), (5,5) 

Only (3,7), (5,5) is possible. 

Product of 3 and 7 is 21 (which is not greater than 21) 

5,5 is the possible value. 

Statement II alone is sufficient. 

 

S39. Ans.(a) 

Sol.  
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S40. Ans.(a) 

Sol. Information Given: 

Radius of circle X is 25% less than circle Y  

Sum of circumference of X and diameter of Y=188 cm 

Height to radius ratio of triangle =5: 4 

Area of triangle =350  

Formula Used: 

Circumference of a circle =2πr 

Area of a triangle =1/2× base × height 

Ratio and circumference relationships 

Explanation: 

Let radius of circle X & Y be 3r and 4r respectively 

2 ×
22

7
× 3𝑟 + 2 × 4𝑟 = 188 cm 

r = 7 cm 

Height of triangle = 5/4 ×(4×7)=35 cm 

ATQ, 

350 = 1/2 × base ×35 

Base = 20 cm 
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RRB PO Mains 2025 English Section Memory-Based Paper (28 Dec 

2025) 
 
Q1. In the given sentence, four words are highlighted which may not be grammatically and 
contextually correct. Choose the option from the given options that can be the best replacement 
for the highlighted words. 
The central bank has eulogised a framework to exacerbate monetary stability by diluting regulatory 
vigilance, while impeding financial resilience. 
(a) instituted, reinforce, tightening, bolstering 
(b) absconded, enhance, moderating, supporting 
(c) collapsed, confine, easing, advancing 
(d) endorsed, rectify, relaxing, encouraging 
(e) No replacement required 
 
Q2. In the given sentence, four words are highlighted which may not be grammatically and 
contextually correct. Choose the option from the given options that can be the best replacement 
for the highlighted words. 
The issued money advisory led to the disruption of assets and ultimately caused the restriction of 
the shell company. 
(a) planned, cursory, acquisition, survival 
(b) launched, delusory, adaptation, assumption 
(c) attempted, laundering, confiscation, defunction 
(d) intended, incite, looting, concession 
(e) No replacement required 
 
Q3. In the given sentence, four words are highlighted which may not be grammatically and 
contextually correct. Choose the option from the given options that can be the best replacement 
for the highlighted words. 
Attempts to fetter progress through dissipative policies that aim to communalize resources were met 
with widespread incredulity. 
(a) expedite, disillusionment, scrutinize, credibility 
(b) trammel, disburdened, revolutionize, habituality 
(c) dispatch, dissolutive, categorize, originality 
(d) whisk, dissuasions, recognize, scalability 
(e) No replacement required 
 
Q4. In the given sentence, four words are highlighted which may not be grammatically and 
contextually correct. Choose the option from the given options that can be the best replacement 
for the highlighted words. 
The barrage that profits would rise unchecked threats investors to be cautious in grappling their 
finances despite attractive earnings. 
(a) barge, insulting, exploring, remuneration 
(b) bias, complaints, dealing, associate 
(c) flooding, accusations, struggled, profits 
(d) delusion, warned, handling, dividends 
(e) No replacement required 
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Q5. In the question below, a sentence is divided into several parts. Select the most appropriate 
sequence to rearrange the parts into a grammatically correct and contextually coherent 
sentence. 
(A) sufficient to ensure success warned  
(B) professionals against complacency, emphasizing  
(C) an increasingly competitive and evolving environment 
(D) the perception that experiences alone is 
(E) the need to continuously update their skills in 
(a) BADEC 
(b) DCBAE 
(c) DABEC 
(d) BACED 
(e) No rearrangement required 
 
Q6. In the question below, a sentence is divided into several parts. Select the most appropriate 
sequence to rearrange the parts into a grammatically correct and contextually coherent 
sentence. 
$ques$ 
(A) allocating capital and  
(B) scaling operations prematurely 
(C) the belief that rapid expansion  
(D) guarantees stability advised  
(E) entrepreneurs to stay cautious when 
(a) CDEAB 
(b) BAECD 
(c) CABDE 
(d) BECAD 
(e) No rearrangement required  
 
Q7. In the question below, a sentence is divided into several parts. Select the most appropriate 
sequence to rearrange the parts into a grammatically correct and contextually coherent 
sentence.  
(A) the expectation of immediate  
(B) policies that could have 
(C) public approval urged administrators  
(D) to act prudently while drafting  
(E) long-term social consequences 
(a) CDEAB 
(b) CEBAD 
(c) ACEDB 
(d) ACDBE 
(e) No rearrangement required 
 
Q8. In the question below, a sentence is divided into several 
parts. Select the most appropriate sequence to rearrange the 
parts into a grammatically correct and contextually coherent 
sentence. 
(A) managing workforce transitions 
(B) the assumption that automation would  
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(C) while redesigning workflows and 
(D) solve all inefficiencies alerted  
(E) organizations to remain vigilant  
(a) EDCAB 
(b) BDECA 
(c) EBDAC 
(d) BEDAC 
(e) No rearrangement required 
 
Q9. In the question below, a sentence is divided into several parts. Select the most appropriate 
sequence to rearrange the parts into a grammatically correct and contextually coherent 
sentence. 
(A) global inequality of opportunity, creating a  
(B) those who merely consume technology 
(C) new digital divide between those who build and 
(D) advanced economies, risks widening the 
(E) the AI revolution, concentrated in a handful of 
(a) EDCAB 
(b) BDECA 
(c) EDACB 
(d) BEDAC 
(e) No rearrangement required 
 
Directions (10-16) : Read the following passage carefully and answer the questions given below 
them. 
Migration to Europe has emerged as one of the most complex and contentious issues of the twenty-first 
century, shaped by a convergence of economic disparities, political instability, demographic changes, 
and humanitarian crises. While Europe has historically been both a source and destination of migration, 
recent decades have witnessed a sharp rise in immigration from Africa, West Asia, and parts of Eastern 
Europe, fundamentally altering the continent’s social and political landscape. 
A primary driver of migration to Europe is economic inequality. Many migrants are drawn by the 
promise of better employment opportunities, higher wages, and social security systems unavailable in 
their home countries. For individuals from conflict-affected or economically fragile regions, Europe 
represents stability and upward mobility. Simultaneously, Europe’s ageing population and declining 
birth rates have created labour shortages in sectors such as healthcare, construction, and agriculture, 
making immigrant labour economically indispensable despite political resistance. 
Conflict and persecution also play a significant role. Wars in Syria, Afghanistan, and parts of Africa have 
forced millions to flee their homes, with Europe often perceived as a safe haven due to its commitment 
to human rights and asylum norms. However, the sudden influx of refugees has strained asylum systems, 
border management, and public services, exposing the limitations of existing institutional frameworks. 
European responses to immigration have been uneven and deeply polarised. While some countries have 
adopted relatively open policies, emphasising humanitarian obligations and integration, others have 
prioritised border control and deterrence, driven by domestic political pressures and the rise of 
nationalist movements. The lack of a unified migration policy within the European Union has further 
complicated burden-sharing, leading to tensions between member states. 
Beyond policy challenges, immigration has sparked broader debates about cultural identity, social 
cohesion, and security. Although evidence suggests that migrants contribute positively to host 
economies over time, public perception is often shaped by fears of job competition and cultural dilution. 
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In essence, migration to Europe is not a temporary phenomenon but a structural reality rooted in global 
inequalities and demographic trends. Addressing it effectively requires a balanced approach that 
combines humane asylum practices, legal migration pathways, integration policies, and cooperation 
with origin countries, rather than reactive and fragmented responses. 
 
Q10. Why does the author describe migration to Europe as a “structural reality”? 
(a) It is mainly the outcome of short-lived administrative shortcomings and policy lapses within 
European nations. 
(b) It emerges from long-standing global inequalities along with persistent demographic trends shaping 
migration flows. 
(c) It is shaped almost entirely by temporary economic fluctuations that influence migration only in the 
short run. 
(d) It can be effectively undone by implementing more rigorous border controls and stricter 
enforcement mechanisms. 
(e) It is confined largely to migration originating from a limited number of conflict-affected regions only. 
 
Q11. Which of the following can be most logically inferred from the passage? 
(a) Migration to Europe is primarily a short-term reaction to recent conflicts. 
(b) Migration pressures on Europe are declining due to global development.  
(c) Economic migration is replacing humanitarian migration entirely. 
(d) Restrictive policies have eliminated labour shortages in Europe. 
(e) Europe’s demographic trends create labour shortages, sustaining immigration. 
 
Q12. Consider the following statements: 
I. Europe’s labour demand and ageing population have reduced opposition to immigrants. 
II. Economic disparity between regions is a significant push factor for migration. 
III. Immigration has uniformly strengthened social cohesion across Europe. 
Which of the statements given above is/are correct? 
(a) Only I 
(b) Both I and II 
(c) Only II 
(d) Both II and III 
(e) Only III 
 
Q13. The discussion on European policy responses in the passage primarily highlights: 
(a) The success of strict border enforcement across all member states. 
(b) The absence of political influence on migration decisions. 
(c) Complete consensus on humanitarian responsibilities. 
(d) Divergent national approaches causing internal disagreements. 
(e) The replacement of national laws with a unified EU framework. 
 
Q14. According to the passage, which of the following best explains the strain on asylum systems? 
(a) The rapid influx of forcibly displaced people that overwhelms existing asylum and reception 
capacities. 
(b) A steady rise in population movement occurring within European countries themselves. 
(c) A significant reduction in financial assistance provided by international humanitarian organisations. 
(d) The absence of well-defined legal and institutional mechanisms to regulate refugee movement. 
(e) A gradual weakening of adherence to international treaties and humanitarian commitments. 
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Q15. Examine the following statements: 
I. Migration to Europe has altered political discourse within several countries. 
II. Nationalist movements have influenced migration-related policies. 
III. Public opinion on immigration is shaped solely by economic evidence. 
Which of the statements above is/are incorrect? 
(a) Only I 
(b) Only II 
(c) Only I and II 
(d) Only II and III 
(e) Only III 
 
Q16. The author’s approach toward migration to Europe can best be described as: 
(a) Alarmist and dismissive of humanitarian concerns 
(b) Analytical with emphasis on structural realities 
(c) Emotional and strongly advocative of open borders 
(d) Critical without acknowledging economic benefits 
(e) Optimistic about immediate policy resolutions 
 
Directions (17-22) : In the following passage there are blanks, each of which has been denoted 
by a letter. For each blank, five options are given. Choose the most appropriate idiom from the 
options that fits the blank appropriately. 
Ananya: “Alright, everyone. The situation with the national sports federation has become a hot potato. 
Mishandling it could _____________ (A), especially with international scrutiny increasing. Karan, where do 
we stand?” 
Karan: “We’ve initiated talks with athletes’ associations, but trust is fragile. Many players feel the system 
has failed them repeatedly. Still, we should _____________ (B)—there’s unprecedented public support for 
reform.” 
Ananya: “That’s true. But this is a _____________ (C). If we delay structural changes, we risk losing 
credibility with global bodies. Mehul, what about accountability?” 
Mehul: “Several officials accused of misconduct may need to be _____________ (D). Without firm action, 
cosmetic reforms won’t convince anyone that we’re serious.” 
Ananya: “I agree. Reform isn’t just about policies; it’s about enforcing standards. Remember, many 
athletes have gone from _____________ (E) despite systemic barriers, purely on talent and resilience. They 
deserve a fair ecosystem.” 
Karan: “Absolutely. And we’re not starting from scratch. Independent regulators, former Olympians, and 
legal experts are _____________ (F). They can step in to strengthen governance once the framework is 
approved.” 
Ananya: “Good. But we must proceed carefully. One wrong move, and vested interests will derail the 
process. Long-term credibility matters more than short-term applause.” 
Mehul: “If we combine transparency with strict enforcement, we can turn this crisis into an opportunity. 
Clean governance could redefine Indian sports administration.” 
Ananya: “Exactly. Let’s move forward with clarity and resolve. If we get this right, it could set a 
benchmark for sports reforms globally.” 
 
Q17. Which of the following idioms will fit in the given blank (A)? 
(a) steal the limelight 
(b) jump the gun 
(c) cut corners 
(d) beat around the bush  
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(e) blow up in our face 
 
Q18. Which of the following idioms will fit in the given blank (B)? 
(a) add fuel to the fire 
(b) cross the bridge when you come to it 
(c) rain on someone’s parade  
(d) look on the bright side 
(e) cry over spilled milk 
 
Q19. Which of the following idioms will fit in the given blank (C)? 
(a) blessing in disguise 
(b) double-edged sword 
(c) now or never moment 
(d) uphill battle 
(e) shot in the dark 
 
Q20. Which of the following idioms will fit in the given blank (D)? 
(a) given a free hand 
(b) shown the red card 
(c) swept under the carpet 
(d) passed the buck 
(e) turned a blind eye 
 
Q21. Which of the following idioms will fit in the given blank (E)? 
(a) rags to riches 
(b) back to square one 
(c) out of the blue 
(d) on thin ice 
(e) at one’s wit’s end 
 
Q22. Which of the following idioms will fit in the given blank (F)? 
(a) under the weather 
(b) out of the loop 
(c) waiting in the wings 
(d) barking up the wrong tree 
(e) in deep waters 
 
Directions (23-27): In the following question, a paragraph is provided with a few highlighted 
words. Select the most appropriate option that can replace the highlighted word to ensure the 
paragraph is both grammatically and contextually accurate. 
Recent advances in artificial intelligence have significantly diluted (A) productivity across multiple 
industries by automating repetitive tasks and enhancing decision-making efficiency. However, experts 
caution that negligent reliance on ethical frameworks may lead to unintended consequences, including 
algorithmic bias. While some policymakers view regulation as a double blessing (B), others argue that 
premature constraints could hinder innovation. To address these concerns, governments must act in a 
haphazard manner (C), ensuring transparency without stifling growth. Furthermore, lack of skilled 
oversight continues to rectify (D) accountability gaps in AI deployment. If left unchecked, these 
challenges could open a can of harmony (E) in global technological governance. 
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Q23. Which of the following is most suitable to replace (A)? 
(a) No replacement required 
(b) acquitted 
(c) augmented 
(d) undermined 
(e) intensified 
 
Q24. Which of the following is most suitable to replace (B)? 
(a) an inevitable outcome 
(b) a necessary safeguard 
(c) No replacement required 
(d) a calculated compromise 
(e) a source of contention 
 
Q25. Which of the following is most suitable to replace (C)? 
(a) with deliberate caution 
(b) without prior consultation 
(c) No replacement required 
(d) through unilateral action 
(e) hastily and arbitrarily 
 
Q26. Which of the following is most suitable to replace (D)? 
(a) obscure 
(b) No replacement required 
(c) expose 
(d) widen 
(e) complicate 
 
Q27. Which of the following is most suitable to replace (E)? 
(a) set the ball rolling 
(b) No replacement required 
(c) open a can of worms 
(d) change the status quo 
(e) draw a fine line 
 
Q28. Fill in the blanks with the most appropriate pairs of words. Select the best pair from the 
given options to make the sentence grammatically and contextually correct. 
The outspoken actor managed to _____ public _____ through an unexpectedly candid interview that 
challenged long-held perceptions. 
(a) confirm / generation 
(b) deplore / aspiration 
(c) astonish / expectation 
(d) endorse / apparel 
(e) banish / asset 
 
Q29. Fill in the blanks with the most appropriate pairs of words. Select the best pair from the 
given options to make the sentence grammatically and contextually correct. 
The prolonged heatwave began to _____ public patience and _____ everyday routines across several 
regions simultaneously. 
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(a) unsettle / reorganise 
(b) soothe / preserve 
(c) quantify / validate 
(d) erode / disrupt 
(e) narrate / compile 
 
Q30. Fill in the blanks with the most appropriate pairs of words. Select the best pair from the 
given options to make the sentence grammatically and contextually correct. 
The central bank announced measures to _____ stressed loans and _____ liquidity support to cooperative 
banks nationwide. 
(a) detest / oppose 
(b) redeem / allot 
(c) graze / furnish 
(d) assail / erupt 
(e) barter / abet 
 
Q31. Fill in the blanks with the most appropriate pairs of words. Select the best pair from the 
given options to make the sentence grammatically and contextually correct. 
A sudden supply disruption threatened to _____ essential services and _____ public confidence within 
affected urban centres rapidly. 
(a) paralyse / undermine 
(b) embellish / magnify 
(c) audit / reconcile 
(d) pacify / stabilise 
(e) imitate / rehearse 
 
Directions (32-36): Rearrange the following sentences to form a logically coherent and 
meaningful paragraph. 
(A) After processing and refinement, this cost rose sharply to around 1025 dollars due to limited supply 
and complex extraction. 
(B) To reduce such extreme cost escalation, synthetic alternatives are developed to ensure consistency, 
scalability, and controlled pricing. 
(C) In contrast, natural flavour sources like vanilla rely on agricultural conditions, labour availability, 
and lengthy extraction processes. 
(D) Post-pandemic disruptions further intensified shortages, pushing market prices beyond 11000 
dollars globally. 
(E) Advances in formulation science make it possible to design artificial components that remain stable 
longer than natural ones. 
(F) Prior to the pandemic, the price of raw natural vanilla was close to 125 dollars per kilogram. 
 
Q32. Which sentence will come FIRST after rearrangement?  
(a) A 
(b) C 
(c) E 
(d) B 
(e) D 
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Q33. Which sentence will come SECOND after rearrangement? 
(a) C 
(b) F 
(c) A 
(d) D 
(e) B 
 
Q34. Which sentence will come THIRD after rearrangement? 
(a) F 
(b) A 
(c) D 
(d) B 
(e) C 
 
Q35. Which sentence will come FIFTH after rearrangement? 
(a) B 
(b) D 
(c) A 
(d) C 
(e) F 
 
Q36. Which sentence will come LAST after rearrangement? 
(a) A 
(b) B 
(c) C 
(d) D 
(e) F 
 
Q37. Given below are four sentences, out of which one sentence is grammatically incorrect. 
Choose the option which points out the grammatically incorrect sentence. If all sentences are 
correct, choose ‘All are correct’ as the correct answer. 
(a) Neither of the two solutions appears effective under the current circumstances. 
(b) The number of applicants have increased significantly over the past few years. 
(c) She was confident that the explanation would satisfy all reasonable doubts. 
(d) Proper documentation helps in avoiding unnecessary delays during verification. 
(e) All are correct 
 
Q38. Given below are four sentences, out of which one sentence is grammatically incorrect. 
Choose the option which points out the grammatically incorrect sentence. If all sentences are 
correct, choose ‘All are correct’ as the correct answer. 
(a) Hardly had the curtain risen than the audience sensed something unusual about the performance. 
(b) The manuscript, along with several handwritten notes, was preserved carefully for future reference.  
(c) Economic recovery often depends on factors that extend beyond immediate fiscal measures. 
(d) The hikers were warned that the trail, though scenic, required considerable endurance. 
(e) All are correct 
 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://www.adda247.com/product-testseries/79075/test-prime?productId=79076


 
 

Q39. Given below are four sentences, out of which one sentence is grammatically incorrect. 
Choose the option which points out the grammatically incorrect sentence. If all sentences are 
correct, choose ‘All are correct’ as the correct answer. 
(a) Despite repeated revisions, the final draft managed to retain clarity and coherence. 
(b) The panel recommended that the issue be examined before any formal announcement. 
(c) Little did she realize how profoundly the decision would alter subsequent events. 
(d) He behaves as if he was unaware of the implications of his earlier actions. 
(e) All are correct 
 
Q40. Given below are four sentences, out of which only one sentence is grammatically correct. 
Choose the option which points out the grammatically correct sentence. If all sentences are 
incorrect, choose ‘All are incorrect’ as the correct answer. 
(a) The extent to which these measures impacts public confidence remains unclear. 
(b) Seldom people recognize how subtle changes alters long-term outcomes. 
(c) The director, along with the senior advisors, have approved the revised framework. 
(d) Greater emphasis on consistency help reduce avoidable procedural lapses. 
(e) All are incorrect 
 
Q41. Given below are four sentences, out of which only one sentence is grammatically correct. 
Choose the option which points out the grammatically correct sentence. If all sentences are 
incorrect, choose ‘All are incorrect’ as the correct answer. 
(a) The researcher, along with several assistants, were documenting the observations carefully. 
(b) She reacted as though she knew nothing about the decision taken earlier. 
(c) Rarely people appreciate how minor adjustments improves long-term efficiency. 
(d) The instructions given to him lacks clarity and consistency. 
(e) All are incorrect 
 

Solutions 
 
S1. Ans.(a) 
Sol. Let’s analyse the sentence step by step, keeping grammar, context (central banking & 
regulation), and meaning firmly in view. 
Original sentence 
The central bank has eulogised a framework to exacerbate monetary stability by diluting regulatory 
vigilance, while impeding financial resilience. 
The sentence talks about a central bank’s policy framework, which is supposed to strengthen 
stability and resilience, not weaken them. 
So the highlighted words must align with positive regulatory intent, not negative or absurd actions. 
Meanings of the highlighted words (Original) 
1. Eulogised 

• English: Praised highly, especially in a speech (often for someone who has died) 

• Hindi: अत्यधिक प्रशंसा करना (धिशेषकर मृत्यु के बाद) 
Example (English): 
The leader was eulogised for his service to the nation. 
Why incorrect here: 
A central bank does not eulogise a framework; it introduces / adopts / institutes it. 
Also, eulogise is stylistically inappropriate for policy actions. 
2. Exacerbate 
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• English: To make a problem worse 

• Hindi: धथिधि को और धबगाड़ना 
Example (English): 
Poor planning exacerbated the economic crisis. 
Why incorrect here: 
You do not worsen monetary stability. Stability is something to be strengthened or reinforced. 
3. Diluting 

• English: Making something weaker or less strict 

• Hindi: कमजोर करना / धशधिल करना 
Example (English): 
Diluting safety norms can increase risks. 
Why incorrect here: 
Central banks aim to tighten, not dilute, regulatory vigilance. 
4. Impeding 

• English: Hindering or obstructing progress 

• Hindi: बािा डालना 
Example (English): 
Poor infrastructure is impeding economic growth. 
Why incorrect here: 
Financial resilience should be strengthened, not obstructed. 
Correct Option (a) 
(a) instituted, reinforce, tightening, bolstering 
Why option (a) is correct 
All four replacements: 

• Match central bank objectives 
• Are positive, policy-appropriate verbs 
• Maintain logical coherence 

Revised sentence: 
The central bank has instituted a framework to reinforce monetary stability by tightening regulatory 
vigilance, while bolstering financial resilience. 
(Grammatically and contextually sound) 
Option-wise Analysis (with meanings & examples) 
Option (a) Correct 

Word Meaning (English) Meaning (Hindi) Example 
instituted formally introduced औपचाररक रूप से लागू करना The policy was instituted last year. 

reinforce strengthening मजबूि करना New rules are reinforcing stability. 

tightening making stricter कड़ा करना The RBI is tightening regulations. 

bolstering supporting strongly मजबूिी देना Capital buffers bolster resilience. 

Why correct: 
Perfect alignment with regulatory language and intent. 
Option (b) Incorrect 

Word Issue 

absconded means to run away → absurd for a central bank 

enhance acceptable alone 

moderating weakens the idea of vigilance 

supporting acceptable alone 
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Why incorrect: 
“Absconded” makes the sentence nonsensical. 
Option (c) Incorrect 

Word Issue 

collapsed implies failure 

confine restrictive, not stabilising 

easing opposite of vigilance 

advancing acceptable alone 

Why incorrect: 
Overall negative and contradictory to central bank goals. 
Option (d) Incorrect 

Word Issue 

endorsed acceptable 

rectify does not collocate with “stability” 

relaxing opposite of vigilance 

encouraging weaker than “bolstering” 

Why incorrect: 
“Relaxing regulatory vigilance” undermines the sentence’s logic. 
Option (e) Incorrect 
Why incorrect: 
All original words convey negative or inappropriate meanings for a central bank framework. 
Final Answer 
Correct option: (a) 
 
S2. Ans.(c) 
Sol. Original sentence 
The issued money advisory led to the disruption of assets and ultimately caused the restriction 
of the shell company. 
The sentence is about financial regulation / enforcement. 
Key ideas expected: 

• an official action by authorities 
• related to money (illegal funds / shell companies) 
• resulting in seizure of assets and closure of the shell company 

So, replacements must fit legal–financial enforcement context. 
Meanings of the highlighted words (Original) 
1. Issued 

• English: officially released or made public 

• Hindi: जारी ककया गया 
Example: 
The government issued a new notification. 
Partially acceptable, but vague for enforcement action. 
2. Advisory 

• English: a notice giving advice or guidance 

• Hindi: परामशश / सलाह-सूचना 
Example: 
The ministry released a travel advisory. 
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Why weak here: 
An advisory usually guides, not causes disruption, asset seizure, or closure. 
3. Disruption 

• English: disturbance or interruption 

• Hindi: व्यििान 
Example: 
The strike caused disruption in services. 
Why incorrect here: 
Assets are not disrupted; they are confiscated / seized. 
4. Restriction 

• English: limitation or control 

• Hindi: प्रधिबंि 
Example: 
Restrictions were imposed on travel. 
Why incorrect here: 
A shell company is typically shut down / rendered defunct, not merely restricted. 
Best Option Analysis  
Option (c) — Correct Answer 
(c) attempted, laundering, confiscation, defunction 
Meanings & fit 

Replacement Meaning (English) 
Meaning 
(Hindi) 

Example 

attempted tried to carry out प्रयास ककया हुआ An attempted fraud was detected. 

laundering illegal concealment of money िन शोिन 
Money laundering is a serious 
crime. 

confiscation official seizure of property जब्िी Assets were confiscated by the ED. 

defunction 
state of being 
closed/inoperative 

धनधरियिा The firm went into defunction. 

Why correct: 
• Attempted money laundering → realistic legal trigger 
• Confiscation of assets → precise legal action 
• Defunction of shell company → exact legal outcome 

Revised sentence (logical & precise): 
The attempted money laundering led to the confiscation of assets and ultimately caused the 
defunction of the shell company. 
Option-wise Rejection Analysis 
Option (a) 
planned, cursory, acquisition, survival 

Issue 

“cursory” does not collocate with money 

“acquisition of assets” is positive, not punitive 

“survival of shell company” contradicts enforcement 

Contextually illogical. 
Option (b) 
launched, delusory, adaptation, assumption 
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Issue 

“delusory money” is meaningless 

“adaptation of assets” is incorrect 

“assumption of company” has no legal sense 

Semantically invalid. 
Option (d) 
intended, incite, looting, concession 

Issue 

“incite money” is grammatically wrong 

“looting of assets” suggests chaos, not law 

“concession of shell company” is irrelevant 

Grammatically and contextually flawed. 
Option (e) 
No replacement required 
Incorrect because: 

• Advisory does not lead to confiscation 
• Disruption ≠ seizure 
• Restriction ≠ closure 

Final Answer 
Correct option: (c) 
 
S3. Ans.(e) 
Sol. Original sentence 
Attempts to fetter progress through dissipative policies that aim to communalize resources were 
met with widespread incredulity. 
The sentence discusses: 

• Policies 
• That restrict progress 
• Are wasteful 
• Seek collective ownership of resources 
• And are received with public disbelief 

This is a political–economic critique, and all four highlighted words must align with that theme. 
Meanings of the highlighted words (Original) 
1. Fetter 

• English: To restrain, restrict, or hold back 

• Hindi: बिंन डालना / रोकना 
Example (English): 
Excessive regulations can fetter innovation. 
Correct here: 
“Fetter progress” is a standard and precise collocation. 
2. Dissipative 

• English: Wasteful; causing loss of energy or resources 

• Hindi: अपव्ययी / ससंािनों को नष्ट करन ेिाला 
Example (English): 
Dissipative spending weakened the economy. 
Correct here: 
Policies can logically be dissipative. 
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3. Communalize 
• English: To place under collective or community ownership 

• Hindi: सामधूहक थिाधमत्ि में बदलना 
Example (English): 
The regime tried to communalize agricultural land. 
Correct here: 
Used accurately in political-economic contexts. 
4. Incredulity 

• English: Disbelief or skepticism 

• Hindi: अधिश्वास / सदंेह 
Example (English): 
The announcement was greeted with incredulity. 
Correct here: 
Perfectly matches public reaction to controversial policies. 
Option-wise Analysis 
Option (a) 
expedite, disillusionment, scrutinize, credibility 

Issue 

“expedite progress” is opposite of original meaning 

“disillusionment policies” is illogical 

“scrutinize resources” mismatches intent 

“credibility” ≠ reaction 

Contextually wrong. 
Option (b) 
trammel, disburdened, revolutionize, habituality 

Issue 

“disburdened policies” is meaningless 

“revolutionize resources” is incorrect 

“habituality” does not fit reaction 

Semantically incoherent. 
Option (c) 
dispatch, dissolutive, categorize, originality 

Issue 

“dispatch progress” is incorrect 

“categorize resources” misses ideological sense 

“originality” is not a public response 

Incorrect replacements. 
Option (d) 
whisk, dissuasions, recognize, scalability 

Issue 

“whisk progress” is idiomatically wrong 

“dissuasion policies” incorrect 

“scalability” is technical, not emotional 

Context mismatch. 
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Option (e) — Correct Answer 
No replacement required 
All four highlighted words: 

• Are grammatically correct 
• Are contextually precise 
• Fit the ideological, economic, and rhetorical tone of the sentence 

Final Answer 
Correct option: (e) 
 
S4. Ans.(d) 
Sol. Let’s analyse carefully, keeping grammar, logic, and exam-level contextual accuracy in focus. 
Original sentence 
The barrage that profits would rise unchecked threats investors to be cautious in grappling their 
finances despite attractive earnings. 
Intended meaning (clearly): 

• A false belief/assumption 
• About unchecked profit growth 
• Warned investors 
• To be careful while managing finances 
• Despite tempting returns 

The original sentence fails because several highlighted words do not fit grammatically or 
contextually. 
Meanings of the highlighted words (Original) 
1. Barrage 

• English: A sudden outpouring or bombardment (of questions, criticism, attacks) 

• Hindi: बौछार / अचानक हमला 
Example (English): 
The minister faced a barrage of questions. 
Why incorrect here: 
“Barrage” cannot introduce a belief or assumption. 
We need a word meaning false belief or misconception. 
2. Threats 

• English: Statements of intent to cause harm 

• Hindi: िमकी 
Example (English): 
The criminals issued threats to witnesses. 
Why incorrect here: 
An idea or belief does not threaten investors. 
It may warn, alert, or caution them. 
(Also grammatically wrong: should be threatens, even if meaning worked.) 
3. Grappling 

• English: Struggling physically or mentally 

• Hindi: जूझना 
Example (English): 
She is grappling with anxiety. 
Why incorrect here: 
You don’t grapple finances; you handle / manage them. 
4. Earnings 
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• English: Income or profits 

• Hindi: आय / कमाई 
Example (English): 
The company reported higher earnings. 
Contextually weak: 
In investor context, “dividends” is more precise than generic earnings. 
Option-wise Analysis 
Option (a) 
barge, insulting, exploring, remuneration 

• “barge that profits…” incorrect  
• “insulting investors” incorrect 
• “exploring finances” incorrect 
• “remuneration” ≠ investor returns 

Completely illogical. 
Option (b) 
bias, complaints, dealing, associate 

• “bias that profits…” incorrect 
• “complaints investors” incorrect 
• “associate finances” incorrect 

Grammatically broken. 
Option (c) 
flooding, accusations, struggled, profits 

• “flooding that profits…” incorrect 
• “accusations investors” incorrect 
• “struggled their finances” incorrect 

Meaningless construction. 
Option (d) — Correct Answer 
delusion, warned, handling, dividends 
Let’s verify each replacement: 

Replacement Meaning (English) Meaning (Hindi) Example 

delusion false belief भ्रम The delusion of easy wealth misled many. 

warned cautioned चेिािनी दी Experts warned investors of risks. 

handling managing प्रबंिन करना He is careful in handling finances. 

dividends shareholder returns लाभांश Dividends attracted investors. 

Revised sentence (logical & grammatical): 
The delusion that profits would rise unchecked warned investors to be cautious in handling their 
finances despite attractive dividends.  
Coherent 
Contextually accurate 
Exam-appropriate vocabulary 
Option (e) 
No replacement required 
Incorrect because: 

• “barrage” is wrong 
• “threats” is grammatically wrong 
• “grappling finances” is idiomatically incorrect 

Final Answer 
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Correct option: (d) 
 
S5. Ans.(c) 
Sol. Step 1: Identify the opening part 
A good sentence opening should: 

• Introduce the subject 
• Not depend on any previous information 

(D) 
the perception that experiences alone is 
This clearly introduces the core idea and sets up what follows. 
So, D must come first. 
Step 2: Find what logically follows D 
(D) ends with: 
experience alone is … 
It clearly demands completion. 
(A) fits perfectly: 
sufficient to ensure success warned 
So we now have: 
the perception that experiences alone is sufficient to ensure success warned 
D → A is grammatically mandatory. 
Step 3: Who is being warned? 
(A) ends with “warned”, which must be followed by who is warned. 
(B) fits naturally: 
professionals against complacency, emphasizing 
So far: 
the perception that experiences alone is sufficient to ensure success warned professionals 
against complacency, emphasizing 
D → A → B 
Step 4: What is being emphasized? 
(B) ends with “emphasizing”, which must be followed by what is emphasized. 
(E): 
the need to continuously update their skills in 
This completes the idea. 
D → A → B → E 
Step 5: Final qualifier / context 
(E) ends with: 
skills in … 
This clearly needs a contextual phrase. 
(C) fits perfectly: 
an increasingly competitive and evolving environment 
Final order: D → A → B → E → C 
Correct Option: (c) DABEC 
Complete Correct Sentence 
The perception that experiences alone is sufficient to ensure success warned professionals 
against complacency, emphasizing the need to continuously update their skills in an increasingly 
competitive and evolving environment. 
Why other options are incorrect (briefly) 

• (a) BADEC – starts mid-thought, no subject 
• (b) DCBAE – breaks verb–object flow 
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• (d) BACED – grammatically disjointed 
• (e) incorrect because rearrangement is required 

Final Answer 
Correct option: (c) 
 
S6. Ans.(a) 
Sol. Correct option: (a) CDEAB 
Why this sequence works 

• (C) starts the sentence properly with the subject: “the belief that rapid expansion …” 
• (D) completes that thought: “… guarantees stability …” and introduces the verb: “advised …” 
• (E) gives the object: “entrepreneurs” and continues the idea: “to stay cautious when …” 
• (A) and (B) complete the “when…” clause with parallel actions: “allocating capital and scaling 

operations prematurely.” 
Complete sentence 
The belief that rapid expansion guarantees stability advised entrepreneurs to stay cautious 
when allocating capital and scaling operations prematurely. 
Why the other options are incorrect (brief) 

• (b) BAECD starts with a fragment (“scaling operations…”), no proper subject. 
• (c) CABDE breaks the flow: “belief that rapid expansion … advised … guarantees” (misplaced 

verb/idea). 
• (d) BECAD begins with a fragment and misorders the clause logic. 
• (e) incorrect because rearrangement is needed. 

 
S7. Ans.(d) 
Sol. Option (d) ACDBE is correct. 
Sequence explanation 

• (A) the expectation of immediate + (C) public approval urged administrators 
• → forms the subject + main verb idea: “The expectation of immediate public approval urged 

administrators…” 
• (D) to act prudently while drafting 
• → completes what the administrators were urged to do. 
• (B) policies that could have + (E) long-term social consequences 
• → completes the object with the correct relative clause: “policies that could have long-term social 

consequences.” 
Complete sentence 
The expectation of immediate public approval urged administrators to act prudently while 
drafting policies that could have long-term social consequences. 
 
S8. Ans.(b) 
Sol. Option (b) BDECA is correct. 
How the sequence works 

• (B) introduces the subject clearly: 
• “the assumption that automation would …” 
• (D) completes that assumption and adds the verb: 
• “… solve all inefficiencies alerted …” 
• (E) gives the object of the verb: 
• “… organizations to remain vigilant …” 
• (C) adds the simultaneous condition: 
• “… while redesigning workflows and …” 
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• (A) completes the parallel action: 
• “… managing workforce transitions.” 

The sentence flows logically as: 
assumption → warning → who is warned → while doing what (two parallel actions). 
Complete coherent sentence 
The assumption that automation would solve all inefficiencies alerted organizations to remain 
vigilant while redesigning workflows and managing workforce transitions. 
Why other options are incorrect (brief) 

• (a) EDCAB: starts with “organizations” but lacks a clear verb before it. 
• (c) EBDAC: breaks the subject–verb relationship and misplaces “alerted.” 
• (d) BEDAC: disrupts the logical flow between assumption and consequence. 
• (e): rearrangement is clearly required. 

Final answer: (b) 
 
S9. Ans.(c) 
Sol. Correct Answer: (c) EDACB 
Step-by-step explanation of the sequence 
Let’s first look at what kind of sentence we are forming. 
The sentence talks about AI revolution, its concentration in advanced economies, and how this 
worsens global inequality by creating a digital divide. So, the sentence must: 

1. Introduce the subject (AI revolution), 
2. Explain where it is concentrated, 
3. State the consequence (widening inequality), 
4. Describe what inequality looks like (digital divide), 
5. Specify the two groups being divided. 

Correct logical flow: E → D → A → C → B 
E 
“the AI revolution, concentrated in a handful of” 
Introduces the main subject: the AI revolution. 
D 
“advanced economies, risks widening the” 
Completes the idea of where AI is concentrated and introduces the risk/consequence. 
“the AI revolution, concentrated in a handful of advanced economies, risks widening the …” 
A 
“global inequality of opportunity, creating a” 
Specifies what is being widened: global inequality of opportunity. 
C 
“new digital divide between those who build and” 
Explains how this inequality manifests — as a digital divide. 
B 
“those who merely consume technology” 
Completes the contrast introduced in C. 
Final reconstructed sentence 
“The AI revolution, concentrated in a handful of advanced economies, risks widening the global 
inequality of opportunity, creating a new digital divide between those who build and those who 
merely consume technology.” 
Why the other options don’t work (briefly) 

• (a) EDCAB – breaks the flow between inequality and digital divide. 
• (b) BDECA – starts abruptly with “those who”, which cannot begin a sentence. 
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• (d) BEDAC – illogical opening and misplaced modifiers. 
• (e) No rearrangement required – original order is grammatically broken. 

Final Answer: 
(c) EDACB 
 
S10. Ans.(b) 
Sol. Correct Answer: (b) 
It emerges from long-standing global inequalities along with persistent demographic trends 
shaping migration flows. 
Textual Reference from the Passage 
The answer comes directly from the concluding paragraph, where the author states: 
“Migration to Europe is not a temporary phenomenon but a structural reality rooted in global 
inequalities and demographic trends.” 
This line explicitly explains why migration is called a structural reality: 

• It is not temporary 
• It is rooted in long-term causes, namely: 

o Global inequalities 
o Demographic trends (ageing population, declining birth rates) 

Hence, option (b) accurately paraphrases this idea. 
Option-wise Analysis 
(a) Incorrect 
“It is mainly the outcome of short-lived administrative shortcomings and policy lapses within European 
nations.” 
Why incorrect: 

• The passage repeatedly emphasises deep-rooted causes, not administrative lapses. 
• Migration is linked to economic inequality, conflicts, and demographic shifts, not temporary 

governance failures. 
(b) Correct 
“It emerges from long-standing global inequalities along with persistent demographic trends shaping 
migration flows.” 
Why correct: 

• Directly reflects the author’s concluding claim. 
• Accurately captures: 

o Global inequalities (economic disparity, conflict, instability) 
o Demographic trends (ageing population, labour shortages) 

(c) Incorrect 
“It is shaped almost entirely by temporary economic fluctuations that influence migration only in the 
short run.” 
Why incorrect: 

• The passage clearly rejects the idea of migration being short-term or cyclical. 
• Economic factors discussed (inequality, labour shortages) are structural and enduring, not 

temporary. 
(d) Incorrect 
“It can be effectively undone by implementing more rigorous border controls and stricter enforcement 
mechanisms.” 
Why incorrect: 

• The author argues against reactive and fragmented responses, including overreliance on 
deterrence. 

• Structural problems cannot be “undone” by enforcement alone. 
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(e) Incorrect 
“It is confined largely to migration originating from a limited number of conflict-affected regions only.” 
Why incorrect: 

• Migration is shown to originate from multiple regions (Africa, West Asia, Eastern Europe). 
• Causes include economic, demographic, and humanitarian factors, not just conflict. 

Final Takeaway 
The author calls migration a “structural reality” because it is: 

• Long-term 
• Deeply rooted 
• Driven by global inequalities and demographic forces, not by temporary crises or policy 

failures. 
Final Answer: (b) 
 
S11. Ans.(e) 
Sol. Correct Answer: (e) 
Europe’s demographic trends create labour shortages, sustaining immigration. 
Reference from the passage (Textual basis) 
The inference is drawn from the second paragraph, where the author states: 
“Europe’s ageing population and declining birth rates have created labour shortages in sectors 
such as healthcare, construction, and agriculture, making immigrant labour economically 
indispensable despite political resistance.” 
This line clearly indicates: 

• Demographic trends (ageing population, low birth rates) 
• → Labour shortages 
• → Economic dependence on immigrant labour 

Hence, it is logically inferred that these demographic trends sustain continued immigration, making 
option (e) correct. 
Option-wise Analysis 
(a) Migration to Europe is primarily a short-term reaction to recent conflicts. 
Incorrect 
Why: 
The passage repeatedly describes migration as a long-term and structural phenomenon, not a short-
term reaction. 
Supporting line: 
“Migration to Europe is not a temporary phenomenon but a structural reality…” 
Thus, option (a) contradicts the passage. 
(b) Migration pressures on Europe are declining due to global development. 
Incorrect 
Why: 
Nowhere does the passage suggest that migration pressures are declining. Instead, it highlights: 

• Rising immigration in recent decades 
• Persistent economic and demographic drivers 

Hence, this option introduces an idea not supported by the text. 
(c) Economic migration is replacing humanitarian migration entirely. 
Incorrect 
Why: 
The passage discusses both forms of migration: 

• Economic migration (labour shortages, inequality) 
• Humanitarian migration (wars, persecution, asylum) 
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Supporting lines: 
“A primary driver of migration… is economic inequality.” 
“Conflict and persecution also play a significant role.” 
This shows coexistence, not replacement. 
(d) Restrictive policies have eliminated labour shortages in Europe. 
Incorrect 
Why: 
The passage explicitly states that labour shortages continue: 
“…making immigrant labour economically indispensable despite political resistance.” 
This implies that restrictive policies have not eliminated labour shortages. 
(e) Europe’s demographic trends create labour shortages, sustaining immigration. 
Correct 
Why: 
This option accurately infers what is clearly implied: 

• Demographic trends → labour shortages 
• Labour shortages → continued immigration 

It neither exaggerates nor adds new information beyond the passage. 
Final Answer 
(e) 
 
S12. Ans.(c) 
Sol. Correct Answer: (c) Only II 
Statement-wise Analysis with passage references 
Statement I: Incorrect 
Europe’s labour demand and ageing population have reduced opposition to immigrants. 
Why incorrect: 
While the passage acknowledges that Europe’s ageing population and labour shortages make immigrant 
labour economically indispensable, it clearly states that political resistance and opposition still 
persist. 
Relevant line from the passage: 
“…making immigrant labour economically indispensable despite political resistance.” 
This shows that labour demand has not reduced opposition; instead, opposition continues alongside 
economic dependence. 
Statement II: Correct 
Economic disparity between regions is a significant push factor for migration. 
Why correct: 
The passage explicitly identifies economic inequality as a primary driver of migration. 
Supporting lines: 
“A primary driver of migration to Europe is economic inequality.” 
“Many migrants are drawn by the promise of better employment opportunities, higher wages, and social 
security systems unavailable in their home countries.” 
Thus, Statement II is directly supported by the passage. 
Statement III: Incorrect 
Immigration has uniformly strengthened social cohesion across Europe. 
Why incorrect: 
The passage presents a mixed picture, highlighting debates, fears, and polarisation rather than uniform 
strengthening. 
Supporting lines: 
“European responses to immigration have been uneven and deeply polarised.” 
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“Immigration has sparked broader debates about cultural identity, social cohesion, and security.” 
This contradicts the claim of uniform strengthening. 
Final Answer 
(c) Only II 
 
S13. Ans.(d) 
Sol. Correct Answer: (d) 
Divergent national approaches causing internal disagreements 
Reference from the passage 
The answer is supported mainly by the fourth paragraph, which states: 
“European responses to immigration have been uneven and deeply polarised.” 
“The lack of a unified migration policy within the European Union has further complicated burden-
sharing, leading to tensions between member states.” 
These lines clearly point to: 

• Divergent national approaches 
• Internal disagreements and tensions among EU members 

Hence, option (d) best captures the core idea of the discussion on policy responses. 
Why the other options are incorrect: 
(a) The success of strict border enforcement across all member states 
Incorrect 
The passage does not describe border enforcement as uniformly successful; instead, it highlights strain, 
polarisation, and limitations. 
(b) The absence of political influence on migration decisions 
Incorrect 
The passage explicitly mentions domestic political pressures and nationalist movements shaping 
policies. 
Supporting line: 
“…driven by domestic political pressures and the rise of nationalist movements.” 
(c) Complete consensus on humanitarian responsibilities 
Incorrect 
The passage stresses lack of consensus, not unanimity. 
(e) The replacement of national laws with a unified EU framework 
Incorrect 
The passage says the lack of a unified migration policy has complicated matters, meaning such a 
framework does not exist. 
Final Answer 
(d) 
 
S14. Ans.(a) 
Sol. Correct Answer: (a) 
The rapid influx of forcibly displaced people that overwhelms existing asylum and reception 
capacities. 
Textual reference from the passage 
The explanation comes from the third paragraph, where the author notes: 
“The sudden influx of refugees has strained asylum systems, border management, and public services, 
exposing the limitations of existing institutional frameworks.” 
Key points from this line: 

• Sudden / rapid influx 
• Refugees (forcibly displaced people) 
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• Strain on asylum systems due to capacity overload 
Option (a) accurately paraphrases this idea. 
Option-wise Analysis 
(a) The rapid influx of forcibly displaced people that overwhelms existing asylum and reception 
capacities. 
Correct 
Why: 

• Directly reflects “sudden influx of refugees” 
• Clearly explains why systems are strained (overwhelmed capacities) 

(b) A steady rise in population movement occurring within European countries themselves. 
Incorrect 
Why: 

• The passage discusses cross-border refugee inflows, not internal migration within Europe. 
• Also, the strain is attributed to a sudden influx, not a steady rise. 

(c) A significant reduction in financial assistance provided by international humanitarian 
organisations. 
Incorrect 
Why: 

• The passage makes no mention of reduced funding or international aid cuts. 
• Introducing this idea goes beyond the text. 

(d) The absence of well-defined legal and institutional mechanisms to regulate refugee 
movement. 
Incorrect 
Why: 

• The passage says systems were strained, not absent. 
• It refers to limitations of existing frameworks, not a complete lack of mechanisms. 

Relevant phrase: 
“exposing the limitations of existing institutional frameworks” 
This implies inadequacy, not non-existence. 
(e) A gradual weakening of adherence to international treaties and humanitarian commitments. 
Incorrect 
Why: 

• The passage actually highlights Europe’s commitment to human rights and asylum norms, 
not weakening adherence. 

Supporting line: 
“Europe often perceived as a safe haven due to its commitment to human rights and asylum norms.” 
Final Answer 
(a) 
 
S15. Ans.(e) 
Sol. Correct Answer: (e) Only III 
Statement-wise Analysis with reference to the passage 
Statement I 
Migration to Europe has altered political discourse within several countries. 
Correct (NOT incorrect) 
Why: 
The passage clearly indicates that migration has reshaped political debates and policies across Europe. 
Supporting lines: 
“…fundamentally altering the continent’s social and political landscape.” 
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“European responses to immigration have been uneven and deeply polarised.” 
These lines show that migration has influenced political discourse and debates in multiple countries.  
Statement II 
Nationalist movements have influenced migration-related policies. 
Correct (NOT incorrect) 
Why: 
The passage explicitly mentions the role of nationalist movements in shaping restrictive policies. 
Supporting line: 
“…driven by domestic political pressures and the rise of nationalist movements.” 
Thus, Statement II is directly supported by the passage. 
Statement III 
Public opinion on immigration is shaped solely by economic evidence. 
Incorrect 
Why: 
The passage makes it clear that public opinion is influenced by multiple factors, not just economic 
evidence. 
Supporting lines: 
“Beyond policy challenges, immigration has sparked broader debates about cultural identity, social 
cohesion, and security.” 
“Although evidence suggests that migrants contribute positively to host economies over time, public 
perception is often shaped by fears of job competition and cultural dilution.” 
This shows that: 

• Economic evidence exists, but 
• Public opinion is also shaped by fears, cultural concerns, and security issues 

Hence, saying it is shaped solely by economic evidence is incorrect. 
Final Answer 
(e) Only III 
 
S16. Ans.(b) 
Sol. Correct Answer: (b) 
Analytical with emphasis on structural realities 
Why option (b) is correct (with passage reference) 
Throughout the passage, the author: 

• Examines multiple drivers of migration (economic inequality, demographic change, conflict, 
policy gaps) 

• Avoids emotional or moralistic language 
• Repeatedly frames migration as long-term and structural, not temporary 

Most clearly stated in the concluding paragraph: 
“Migration to Europe is not a temporary phenomenon but a structural reality rooted in global 
inequalities and demographic trends.” 
The author: 

• Analyses causes 
• Assesses policy responses 
• Weighs economic benefits against political and social challenges 

This confirms an analytical, balanced approach grounded in structural realities. 
Why the other options are incorrect: 
(a) Alarmist and dismissive of humanitarian concerns 
Incorrect 
The author acknowledges humanitarian crises and asylum norms respectfully: 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


 
 

“…Europe often perceived as a safe haven due to its commitment to human rights and asylum norms.” 
This shows concern, not dismissal. 
(c) Emotional and strongly advocative of open borders 
Incorrect 
The tone is measured and analytical, not emotional or activist. 
The author does not advocate open borders but calls for balanced approaches. 
(d) Critical without acknowledging economic benefits 
Incorrect 
The passage explicitly recognises economic contributions: 
“Evidence suggests that migrants contribute positively to host economies over time.” 
So the author does acknowledge benefits. 
(e) Optimistic about immediate policy resolutions 
Incorrect 
The author rejects quick fixes and criticises reactive and fragmented responses, implying no 
immediate resolution. 
Final Answer 
(b) 
 
S17. Ans.(e) 
Sol. Correct answer for Blank (A): (e) blow up in our face 
Why “blow up in our face” fits best 
Context from the passage: 
“Mishandling it could _____________, especially with international scrutiny increasing.” 
The speaker is warning that any wrong handling of the issue could lead to serious negative 
consequences, particularly embarrassment or backlash at an international level. 
“Blow up in our face” perfectly captures this idea. 
Meaning, Example & Explanation 
(e) blow up in our face — Correct 
English Meaning: 
To backfire badly; to result in serious trouble or embarrassment instead of the intended outcome. 
Hindi Meaning: 

उलटा पड़ जाना; कोई काम ऐसा धबगड़ जाना धजससे गंभीर नुकसान या शर्मिंदगी हो। 
Example (English): 

• Ignoring the athletes’ complaints could blow up in our face when international bodies step in. 
Why correct: 

• The idiom clearly conveys risk, backlash, and unintended negative consequences, which 
aligns exactly with the warning tone of Ananya’s statement. 

• It fits both logically and idiomatically with “mishandling” and “international scrutiny.” 
Why the other options are incorrect: 
(a) steal the limelight 
English Meaning: 
To attract all the attention. 
Hindi Meaning: 

सारी सुर्खशयााँ बटोर लेना। 
Why incorrect: 

• The sentence is about risk and failure, not about gaining attention. 
• Completely mismatched with the negative consequence implied. 

(b) jump the gun 
English Meaning: 
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To act too early or prematurely. 
Hindi Meaning: 

जल्दबाजी करना। 
Why incorrect: 

• The issue here is mishandling, not acting too early. 
• Premature action ≠ disastrous consequences. 

(c) cut corners 
English Meaning: 
To do something cheaply or carelessly by skipping proper procedures. 
Hindi Meaning: 

काम में शॉटशकट अपनाना; गुणित्ता से समझौिा करना। 
Why incorrect: 

• This describes a method, not a result. 
• The blank requires an outcome that may occur because of mishandling, not the act itself. 

(d) beat around the bush 
English Meaning: 
To avoid speaking directly about an issue. 
Hindi Meaning: 

सीिी बाि से बचना; गोलमोल बाि करना। 
Why incorrect: 

• This idiom refers to communication style, not consequences. 
• Does not fit grammatically or logically in the sentence. 

Final Answer: 
(e) blow up in our face 
 
S18. Ans.(d) 
Sol. Correct answer for Blank (B): (d) look on the bright side 
Why “look on the bright side” fits best 
Context from the passage: 
“Still, we should _____________—there’s unprecedented public support for reform.” 
Here, Karan is urging optimism despite fragile trust. He points out a positive aspect of the situation—
strong public backing. The idiom must therefore convey finding hope or positivity in a difficult 
situation. 
“Look on the bright side” fits both the tone and meaning perfectly. 
Meaning, Example & Explanation 
(d) look on the bright side — Correct 
English Meaning: 
To focus on the positive aspects of a situation, even when circumstances are difficult. 
Hindi Meaning: 

धथिधि के सकारात्मक पक्ष पर ध्यान देना; मुधककल हालाि में भी अच्छाई दखेना। 
Example (English): 

• The reforms will take time, but let’s look on the bright side—public support has never been stronger. 
Why correct: 

• The idiom aligns directly with the justification that follows the dash. 
• It expresses optimism grounded in reality, which suits the reform-oriented discussion. 

Why the other options are incorrect 
(a) add fuel to the fire — Incorrect 
English Meaning: 
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To make a bad situation worse. 
Hindi Meaning: 

आग में घी डालना; हालाि और धबगाड़ देना। 
Why incorrect: 

• The speaker is trying to encourage confidence, not worsen the situation. 
• Opposite in meaning to the context. 

(b) cross the bridge when you come to it — Incorrect 
English Meaning: 
To deal with a problem only when it actually arises. 
Hindi Meaning: 

समथया आने पर ही उससे धनपटना। 
Why incorrect: 

• The sentence is about current attitude, not postponing decisions. 
• Does not connect logically with public support. 

(c) rain on someone’s parade — Incorrect 
English Meaning: 
To spoil someone’s happiness or plans. 
Hindi Meaning: 

ककसी की खुशी खराब करना। 
Why incorrect: 

• The idiom suggests negativity, whereas the speaker is highlighting encouragement. 
• Contextually mismatched. 

(e) cry over spilled milk — Incorrect 
English Meaning: 
To complain about something that has already happened and cannot be changed. 
Hindi Meaning: 

बीिी बािों पर पछिाना। 
Why incorrect: 

• The conversation is future-focused and solution-oriented. 
• No sense of regret is expressed in the line. 

Final Answer: 
(d) look on the bright side 
 
S19. Ans.(c) 
Sol. Correct answer for Blank (C): (c) now or never moment 
Why “now or never moment” fits best 
Context from the passage: 
“That’s true. But this is a _____________. If we delay structural changes, we risk losing credibility with global 
bodies.” 
The speaker stresses urgency and warns that delay will cause irreversible damage. The idiom must 
therefore convey a critical point in time where action is imperative. 
“Now or never moment” captures exactly this sense of decisive urgency. 
Meaning, Example & Explanation 
(c) now or never moment — Correct 
English Meaning: 
A situation where action must be taken immediately, or the opportunity will be lost forever. 
Hindi Meaning: 

अब नहीं िो कभी नहीं की धथिधि; ऐसा समय जब िुरंि धनणशय लेना अधनिायश हो। 
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Example (English): 
• This reform is a now or never moment for restoring faith in the sports federation. 

Why correct: 
• It directly aligns with the warning that delaying action will lead to loss of credibility. 
• The idiom emphasizes time sensitivity and irreversible consequences, which is central to the 

sentence. 
Why the other options are incorrect: 
(a) blessing in disguise — Incorrect 
English Meaning: 
Something that seems bad at first but turns out to be good. 
Hindi Meaning: 

छुपा हुआ िरदान। 
Why incorrect: 

• The sentence highlights risk due to delay, not unexpected benefit. 
• The tone is cautionary, not reassuring. 

(b) double-edged sword — Incorrect 
English Meaning: 
A situation with both positive and negative consequences. 
Hindi Meaning: 

दोनों ओर नुकसान और फायदा रखने िाली धथिधि। 
Why incorrect: 

• The focus here is on urgency, not dual outcomes. 
• No contrast of pros and cons is being discussed. 

(d) uphill battle — Incorrect 
English Meaning: 
A difficult struggle with little chance of success. 
Hindi Meaning: 

करिन और संघषशपूणश प्रयास। 
Why incorrect: 

• The issue is not about difficulty but about timing. 
• The passage does not suggest low chances of success. 

(e) shot in the dark — Incorrect 
English Meaning: 
A guess or attempt with little chance of success. 
Hindi Meaning: 

अंदाजे से ककया गया प्रयास। 
Why incorrect: 

• Structural reforms are presented as necessary and calculated, not random guesses. 
• Completely misaligned with the seriousness of the context. 

Final Answer: 
(c) now or never moment 
 
S20. Ans.(b) 
Sol. Correct answer for Blank (D): (b) shown the red card 
Why “shown the red card” fits best 
Context from the passage: 
“Several officials accused of misconduct may need to be _____________. Without firm action, cosmetic reforms 
won’t convince anyone that we’re serious.” 
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The speaker is clearly arguing for strict punitive action against officials accused of wrongdoing. The 
idiom must therefore imply removal, dismissal, or expulsion as a disciplinary measure. 
“Shown the red card”, borrowed from sports terminology, aptly conveys being expelled or removed 
for misconduct, making it especially relevant in a sports governance context. 
Meaning, Example & Explanation 
(b) shown the red card — Correct 
English Meaning: 
To be dismissed or expelled for unacceptable behaviour. 
Hindi Meaning: 

दरुाचार के कारण पद या भूधमका से हटाया जाना; कड़ी सजा धमलना। 
Example (English): 

• Officials found guilty of corruption must be shown the red card to restore trust. 
Why correct: 

• The idiom directly aligns with accountability and enforcement. 
• It reinforces the idea that strong action, not superficial reform, is necessary. 
• The sports-based idiom fits naturally in a discussion about a sports federation. 

Why the other options are incorrect: 
(a) given a free hand — Incorrect 
English Meaning: 
To allow someone complete freedom to act. 
Hindi Meaning: 

पूरी छूट देना। 
Why incorrect: 

• The context demands punishment, not empowerment. 
• Opposite in meaning to disciplinary action. 

(c) swept under the carpet — Incorrect 
English Meaning: 
To hide or ignore a problem. 
Hindi Meaning: 

समथया को दबा देना। 
Why incorrect: 

• The speaker explicitly criticises cosmetic reforms and lack of action. 
• This idiom contradicts the demand for accountability. 

(d) passed the buck — Incorrect 
English Meaning: 
To shift responsibility onto someone else. 
Hindi Meaning: 

धजम्मेदारी टालना। 
Why incorrect: 

• The sentence argues for taking responsibility, not avoiding it. 
• Does not fit grammatically with “may need to be”. 

(e) turned a blind eye — Incorrect 
English Meaning: 
To deliberately ignore wrongdoing. 
Hindi Meaning: 

जानबूझकर अनदेखा करना। 
Why incorrect: 

• The speaker is advocating action, not ignorance. 
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• Semantically opposite to the intent of the sentence. 
Final Answer: 
(b) shown the red card 
 
S21. Ans.(a) 
Sol. Correct answer for Blank (E): (a) rags to riches 
Why “rags to riches” fits best 
Context from the passage: 
“Remember, many athletes have gone from _____________ despite systemic barriers, purely on talent and 
resilience.” 
The sentence highlights extraordinary upward journeys, where athletes succeed despite hardship 
and lack of support. The idiom must therefore convey a rise from poverty or disadvantage to 
success. 
“Rags to riches” perfectly captures this transformation. 
Meaning, Example & Explanation 
(a) rags to riches — Correct 
English Meaning: 
A situation in which someone rises from poverty or an extremely disadvantaged position to wealth, 
success, or fame. 
Hindi Meaning: 

गरीबी से समृधि िक का सफर; अत्यंि करिन पररधथिधियों से सफलिा प्राप्त करना। 
Example (English): 

• Her journey from rags to riches inspired young athletes across the country. 
Why correct: 

• It directly matches the idea of overcoming systemic barriers. 
• The idiom emphasises talent, perseverance, and social mobility, all of which are central to the 

sentence. 
Why the other options are incorrect: 
(b) back to square one — Incorrect 
English Meaning: 
To return to the starting point after a failure. 
Hindi Meaning: 

कफर से शुरुआि की धथिधि में लौट जाना। 
Why incorrect: 

• The sentence talks about progress and success, not failure or restarting. 
(c) out of the blue — Incorrect 
English Meaning: 
Something that happens suddenly and unexpectedly.  
Hindi Meaning: 

अचानक; धबना ककसी पूिश संकेि के। 
Why incorrect: 

• The success described is due to talent and resilience, not 
sudden or random events. 

(d) on thin ice — Incorrect 
English Meaning: 
In a risky or precarious situation. 
Hindi Meaning: 

खिरे की धथिधि में होना। 
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Why incorrect: 
• The focus is on achievement, not ongoing risk or danger. 

(e) at one’s wit’s end — Incorrect 
English Meaning: 
To be extremely frustrated or confused, not knowing what to do. 
Hindi Meaning: 

बेहद परेशान या हिाश होना। 
Why incorrect: 

• The idiom conveys despair, whereas the passage celebrates success despite adversity. 
Final Answer: 
(a) rags to riches 
 
S22. Ans.(c) 
Sol. Correct answer for Blank (F): (c) waiting in the wings 
Why “waiting in the wings” fits best 
Context from the passage: 
“Independent regulators, former Olympians, and legal experts are _____________. They can step in to 
strengthen governance once the framework is approved.” 
The sentence clearly suggests that capable people are ready and available, but will act once the right 
moment arrives. The idiom must therefore convey readiness without current involvement. 
“Waiting in the wings” fits this idea precisely. 
Meaning, Example & Explanation 
(c) waiting in the wings — Correct 
English Meaning: 
Ready to act or take over when the time is right. 
Hindi Meaning: 

परदे के पीछे िैयार रहना; अिसर धमलने की प्रिीक्षा में होना। 
Example (English): 

• Several experienced administrators are waiting in the wings to take charge once reforms are 
implemented. 

Why correct: 
• It perfectly matches “can step in once the framework is approved.” 
• Conveys preparedness, expertise, and timely intervention. 

Why the other options are incorrect: 
(a) under the weather — Incorrect 
English Meaning: 
Feeling unwell or sick. 
Hindi Meaning: 

अथिथि महसूस करना। 
Why incorrect: 

• The context is about availability and readiness, not health. 
(b) out of the loop — Incorrect 
English Meaning: 
Not informed or excluded from information. 
Hindi Meaning: 

जानकारी से बाहर होना। 
Why incorrect: 

• These experts are clearly informed and involved in planning. 
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(d) barking up the wrong tree — Incorrect 
English Meaning: 
Pursuing a mistaken or misguided course of action. 
Hindi Meaning: 

गलि कदशा में प्रयास करना। 
Why incorrect: 

• The sentence expresses confidence in their role, not error. 
(e) in deep waters — Incorrect 
English Meaning: 
In serious trouble or difficulty. 
Hindi Meaning: 

गंभीर परेशानी में होना। 
Why incorrect: 

• No sense of danger or crisis is associated with these experts. 
Final Answer: 
(c) waiting in the wings 
 
S23. Ans.(c) 
Sol. Replacement for highlighted word (A): diluted 
“Recent advances in artificial intelligence have significantly diluted productivity across multiple industries 
by automating repetitive tasks and enhancing decision-making efficiency.” 
1. Meaning & evaluation of the highlighted word 
Highlighted word: diluted 
English meaning: 
Made weaker, reduced in strength or concentration. 
Hindi meaning: 

कमजोर करना; प्रभाि या िीव्रिा घटा देना। 
Example (English): 

• Excessive regulations diluted the impact of the reform. 
Why the highlighted word is incorrect: 
In the given sentence, artificial intelligence is described as automating tasks and improving 
efficiency, which clearly increases productivity. 
However, “diluted” means weakened or reduced, which is contradictory to the positive impact being 
described. 
Hence, the highlighted word is contextually incorrect. 
2. Evaluation of the options 
(a) No replacement required — Incorrect 
Why incorrect: 

• Retaining diluted preserves the contradiction. 
• Productivity is not weakened; it is improved. 

(b) acquitted — Incorrect 
English meaning: 
Freed from blame or criminal charges. 
Hindi meaning: 

दोषमुक्त करना। 
Example (English): 

• The court acquitted the accused due to lack of evidence. 
Why incorrect: 
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• Used in legal contexts, not with abstract concepts like productivity. 
• Grammatically and semantically unsuitable. 

(c) augmented — Correct 
English meaning: 
Increased or enhanced in size, amount, or degree. 
Hindi meaning: 

बढाना; सुदढृ करना। 
Example (English): 

• Automation has augmented productivity in manufacturing. 
Why correct: 

• Accurately reflects the idea that AI boosts productivity. 
• Fits both grammatically and contextually with the sentence. 

(d) undermined — Incorrect 
English meaning: 
Weakened or damaged gradually. 
Hindi meaning: 

कमजोर करना; नुकसान पहुाँचाना। 
Example (English): 

• Corruption undermined public trust. 
Why incorrect: 

• Like diluted, it conveys a negative impact. 
• Contradicts the efficiency-enhancing role of AI. 

(e) intensified — Incorrect 
English meaning: 
Made stronger or more extreme. 
Hindi meaning: 

िीव्र करना। 
Example (English): 

• Competition intensified after deregulation. 
Why incorrect: 

• Productivity is typically augmented or enhanced, not “intensified.” 
• Less precise and slightly awkward collocation with productivity. 

Final Answer: 
(c) augmented 
 
S24. Ans.(e) 
Sol. Replacement for highlighted word (B): double blessing 
“While some policymakers view regulation as a double blessing (B), others argue that premature 
constraints could hinder innovation.” 
1. Meaning & evaluation of the highlighted phrase 
Highlighted phrase: double blessing 
English meaning: 
Something that brings two benefits or advantages. 
Hindi meaning: 

दोहरा लाभ; ऐसी चीज जो एक से अधिक फायदे दे। 
Example (English): 

• Working from home is a double blessing—it saves time and money. 
Why the highlighted phrase is incorrect: 
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The phrase “double blessing” is not an established or idiomatic expression in standard English. 
The commonly accepted idiom is “double-edged sword”, which refers to something having both 
advantages and disadvantages. In the given sentence, regulation is being viewed positively by some 
and critically by others, indicating debate and disagreement, not purely benefits. 
Hence, double blessing is contextually and idiomatically incorrect. 
2. Evaluation of the options 
(a) an inevitable outcome — Incorrect 
English meaning: 
Something that is certain to happen. 
Hindi meaning: 

अपररहायश पररणाम। 
Example (English): 

• Automation is an inevitable outcome of technological progress. 
Why incorrect: 

• The sentence discusses opinions about regulation, not certainty. 
• Does not contrast with “others argue” effectively. 

(b) a necessary safeguard — Incorrect 
English meaning: 
A protective measure essential to prevent harm. 
Hindi meaning: 

आिकयक सुरक्षा उपाय। 
Example (English): 

• Data protection laws are a necessary safeguard against misuse. 
Why incorrect: 

• Too one-sided and positive. 
• The sentence requires a phrase that allows room for disagreement, which this does not. 

(c) No replacement required — Incorrect 
Why incorrect: 

• Double blessing is not a standard collocation. 
• Fails the idiomatic accuracy required by the question. 

(d) a calculated compromise — Incorrect 
English meaning: 
A carefully planned middle ground. 
Hindi meaning: 

सोच-समझकर ककया गया समझौिा। 
Example (English): 

• The policy was a calculated compromise between growth and control. 
Why incorrect: 

• The sentence is about perception of regulation, not about how it was designed. 
• Context mismatch. 

(e) a source of contention — Correct 
English meaning: 
Something that causes disagreement or debate. 
Hindi meaning: 

धििाद या मिभेद का कारण। 
Example (English): 

• AI regulation has become a source of contention among policymakers. 
Why correct: 
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• Perfectly captures the conflicting viewpoints mentioned in the sentence. 
• Aligns logically with “others argue that premature constraints could hinder innovation.” 

Final Answer: 
(e) a source of contention 
 
S25. Ans.(a) 
Sol. Replacement for highlighted phrase (C): in a haphazard manner 
“To address these concerns, governments must act in a haphazard manner (C), ensuring transparency 
without stifling growth.” 
1. Meaning & evaluation of the highlighted phrase 
Highlighted phrase: in a haphazard manner 
English meaning: 
Done without planning, order, or careful thought; randomly. 
Hindi meaning: 

धबना योजना के; अव्यिधथिि ढंग से। 
Example (English): 

• The files were arranged in a haphazard manner. 
Why the highlighted phrase is incorrect: 
The sentence stresses that governments should ensure transparency without stifling growth, which 
clearly demands careful, balanced, and thoughtful action. 
However, “in a haphazard manner” implies carelessness and lack of planning, which contradicts the 
intended meaning. 
Hence, the highlighted phrase is contextually incorrect. 
2. Evaluation of the options 
(a) with deliberate caution — Correct 
English meaning: 
Acting carefully and thoughtfully, after due consideration. 
Hindi meaning: 

सोच-समझकर और साििानी से। 
Example (English): 

• Governments must regulate emerging technologies with deliberate caution. 
Why correct: 

• Matches the idea of balancing transparency and innovation. 
• Aligns perfectly with the responsible tone of the sentence. 

(b) without prior consultation — Incorrect 
English meaning: 
Acting without seeking advice or discussion beforehand. 
Hindi meaning: 

धबना पूिश परामशश के। 
Example (English): 

• The decision was taken without prior consultation. 
Why incorrect: 

• Suggests impulsiveness and lack of inclusivity. 
• Conflicts with the idea of careful governance. 

(c) No replacement required — Incorrect 
Why incorrect: 

• Retaining haphazard contradicts the intent of careful policymaking. 
• Makes the sentence logically inconsistent. 
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(d) through unilateral action — Incorrect 
English meaning: 
Acting independently without agreement from others. 
Hindi meaning: 

एकिरफा कारशिाई के माध्यम से। 
Example (English): 

• Unilateral action often leads to diplomatic friction. 
Why incorrect: 

• The sentence does not discuss cooperation vs independence. 
• Focus is on manner, not authority. 

(e) hastily and arbitrarily — Incorrect 
English meaning: 
Done too quickly and without reason. 
Hindi meaning: 

जल्दबाजी और मनमाने ढंग से। 
Example (English): 

• Rules were changed hastily and arbitrarily. 
Why incorrect: 

• Same negative sense as haphazard. 
• Opposite of what is required in governance. 

Final Answer: 
(a) with deliberate caution 
 
S26. Ans.(d) 
Sol. Replacement for highlighted word (D): rectify 
“Furthermore, lack of skilled oversight continues to rectify (D) accountability gaps in AI deployment.” 
1. Meaning & evaluation of the highlighted word 
Highlighted word: rectify 
English meaning: 
To correct or fix a problem. 
Hindi meaning: 

सुिारना; िीक करना। 
Example (English): 

• The new policy helped rectify long-standing errors in the system. 
Why the highlighted word is incorrect: 
In the given sentence, lack of skilled oversight is being discussed as a problem, not a solution. 
However, rectify means to fix or correct, which is logically opposite to what lack of oversight would do. 
Lack of oversight worsens accountability gaps; it does not fix them. 
Hence, rectify is contextually incorrect. 
2. Evaluation of the options 
(a) obscure — Incorrect 
Meaning: To hide or make unclear 
Why incorrect: 

• Accountability gaps are not being hidden; they are being worsened. 
(b) No replacement required — Incorrect 
Why incorrect: 

• Rectify directly contradicts the cause–effect logic of the sentence. 
(c) expose — Incorrect 
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Meaning: To reveal 
Why incorrect: 

• The sentence focuses on impact, not disclosure. 
(d) widen — Correct 
English meaning: 
To increase the size or extent of something. 
Hindi meaning: 

फैलाना; बढाना। 
Example (English): 

• Weak monitoring can widen accountability gaps. 
Why correct: 

• Perfectly captures the idea that lack of oversight makes gaps larger. 
• Fits grammatically and contextually. 

(e) complicate — Incorrect 
Meaning: To make something more complex 
Why incorrect: 

• Accountability gaps are becoming larger/severe, not merely complex. 
Final Answer: 
(d) widen 
 
S27. Ans.(c) 
Sol. Replacement for highlighted word (E): open a can of harmony 
“If left unchecked, these challenges could open a can of harmony (E) in global technological governance.” 
1. Meaning & evaluation of the highlighted phrase 
Highlighted phrase: open a can of harmony 
English meaning: 
No established meaning; this is not a recognised idiom in English. 
Hindi meaning: 

कोई प्रचधलि मुहािरा नहीं; अिशहीन प्रयोग। 
Example (English): 
The policy opened a can of harmony among nations. (unnatural and incorrect) 
Why the highlighted phrase is incorrect: 

• The standard idiom is “open a can of worms”, not harmony. 
• The context clearly suggests chaos, disputes, and complications, not peace or agreement. 
• Using harmony reverses the intended meaning and makes the sentence illogical. 

Hence, the highlighted phrase is idiomatically and contextually incorrect. 
2. Evaluation of the options 
(a) set the ball rolling — Incorrect 
English meaning: 
To start a process. 
Hindi meaning: 

ककसी प्रकिया की शुरुआि करना। 
Example (English): 

• The announcement set the ball rolling on reforms. 
Why incorrect: 

• The sentence warns about negative consequences, not initiation. 
• Meaning mismatch. 

(b) No replacement required — Incorrect 
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Why incorrect: 
• Open a can of harmony is not a valid idiom. 
• Retaining it breaks idiomatic correctness. 

(c) open a can of worms — Correct 
English meaning: 
To create a complicated, messy situation with many new problems. 
Hindi meaning: 

कई नई और जरटल समथयाओं को जन्म देना। 
Example (English): 

• Poorly designed AI laws could open a can of worms internationally. 
Why correct: 

• Perfectly aligns with the warning about unchecked challenges. 
• Accurately reflects complex disputes and governance issues. 
• Correct and commonly used idiom. 

(d) change the status quo — Incorrect 
English meaning: 
To alter the existing state of affairs. 
Hindi meaning: 

मौजूदा धथिधि को बदलना। 
Example (English): 

• The reform aims to change the status quo. 
Why incorrect: 

• Neutral or positive in tone. 
• Does not convey unintended negative consequences. 

(e) draw a fine line — Incorrect 
English meaning: 
To make a subtle distinction. 
Hindi meaning: 

सूक्ष्म अंिर करना। 
Example (English): 

• It is hard to draw a fine line between regulation and control. 
Why incorrect: 

• Refers to distinction, not escalation of problems. 
• Context mismatch. 

Final Answer: 
(c) open a can of worms 
 
S28. Ans.(c) 
Sol.  The correct answer is: (C) 
Explanation: 
(A) CONFIRM / GENERATION 
• Confirm: to verify or establish truth 
• Hindi meaning: पुष्टि करना 

• Generation: a group of people born around the same time 
• Hindi meaning: पीढी 

Context: An interview does not “confirm a generation”; the pairing is logically mismatched. 
(B) DEPLORE / ASPIRATION 
• Deplore: to strongly disapprove of 
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• Hindi meaning: कडी ष्टनिंदा करना 

• Aspiration: a strong desire or ambition 
• Hindi meaning: आकािंक्षा 

Context: An actor may challenge aspirations, but “deplore public aspiration” is contextually awkward 
and overly negative. 
(C) ASTONISH / EXPECTATION 
• Astonish: to surprise greatly 
• Hindi meaning: चष्टकत करना 

• Expectation: a belief about what will happen 
• Hindi meaning: अपेक्षा 

Context: A candid interview can genuinely surprise the public and alter what people expect from the 
actor, making this pair perfectly suitable. 
(D) ENDORSE / APPAREL 
• Endorse: to approve or support publicly 
• Hindi meaning: समर्थन करना 

• Apparel: clothing 
• Hindi meaning: पररधान 

Context: Interviews may endorse ideas, not clothing; the second filler is irrelevant. 
(E) BANISH / ASSET 
• Banish: to remove completely 
• Hindi meaning: ष्टनष्काष्टसत करना 

• Asset: something valuable 
• Hindi meaning: सिंपष्टि 

Context: “Banish public asset” is illogical and does not align with perception or reaction. 
 
S29. Ans.(d) 
Sol.  The correct answer is: (D) 
Explanation: 
(A) UNSETTLE / REORGANISE 
• Unsettle: to disturb mental calm or stability 
• Hindi meaning: अष्टथर्र करना 

• Reorganise: to arrange again in a new order 
• Hindi meaning: पुनः व्यवष्टथर्त करना 

Context: A heatwave may unsettle people, but it does not deliberately reorganise routines; disruption is 
more accurate than planned rearrangement. 
(B) SOOTHE / PRESERVE 
• Soothe: to calm or reduce discomfort 
• Hindi meaning: शािंत करना 

• Preserve: to maintain in original condition 
• Hindi meaning: सुरष्टक्षत रखना 

Context: Heatwaves do the opposite of soothing and preserving; they intensify discomfort and disturb 
routines. 
(C) QUANTIFY / VALIDATE 
• Quantify: to measure numerically 
• Hindi meaning: मात्रात्मक करना 

• Validate: to confirm correctness 
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• Hindi meaning: सत्याष्टपत करना 

Context: These are analytical actions, not effects caused by extreme weather on daily life. 
(D) ERODE / DISRUPT 
• Erode: to gradually wear away strength or patience 
• Hindi meaning: धीरे-धीरे क्षीण करना 

• Disrupt: to interrupt normal functioning 
• Hindi meaning: बाष्टधत करना 

Context: Extended heat weakens patience over time and interrupts normal routines, making this pair 
contextually precise. 
(E) NARRATE / COMPILE 
• Narrate: to describe or tell a story 
• Hindi meaning: वणथन करना 

• Compile: to collect information 
• Hindi meaning: सिंकष्टित करना 

Context: A heatwave does not tell or collect routines; these verbs do not express impact. 
 
S30. Ans.(b) 
Sol.  The correct answer is: (B) 
Explanation: 
(A) DETEST / OPPOSE 
• Detest: to hate strongly 
• Hindi meaning: घणृा करना 

• Oppose: to resist or be against 
• Hindi meaning: ष्टवरोध करना 

Context: The central bank does not hate or oppose loans or liquidity; it regulates and supports financial 
stability. 
(B) REDEEM / ALLOT 
• Redeem: to recover, restore, or compensate for losses 
• Hindi meaning: पुनः प्राप्त करना, सुधार करना 

• Allot: to distribute or assign officially 
• Hindi meaning: आविंष्टित करना 

Context: Banking authorities aim to recover stressed loans and officially distribute liquidity support to 
banks, making this pair contextually accurate. 
(C) GRAZE / FURNISH 
• Graze: to feed lightly or touch slightly 
• Hindi meaning: चरना / हल्का छूना 

• Furnish: to provide or supply 
• Hindi meaning: उपिब्ध कराना 

Context: “Graze loans” is incorrect usage, though furnish partially 
fits; the pair fails together. 
(D) ASSAIL / ERUPT 
• Assail: to attack verbally or physically 
• Hindi meaning: आक्रमण करना 

• Erupt: to burst out suddenly 
• Hindi meaning: फूि पडना 

Context: Banking measures do not involve attacking loans or 
erupting liquidity. 
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(E) BARTER / ABET 
• Barter: to exchange goods without money 
• Hindi meaning: वथतु-ष्टवष्टनमय करना 

• Abet: to encourage wrongdoing 
• Hindi meaning: अपराध में सहायता करना 

Context: Monetary policy neither relies on barter nor supports wrongdoing, making this option illogical. 
 
S31. Ans.(a) 
Sol.  The correct answer is: (A) 
Explanation: 
(A) PARALYSE / UNDERMINE 
• Paralyse: to make unable to function normally 
• Hindi meaning: पिंगु कर देना 

• Undermine: to weaken gradually or damage credibility 
• Hindi meaning: धीरे-धीरे कमजोर करना 

Context: Supply disruptions can halt essential services and slowly weaken public trust, fitting the cause–
effect tone perfectly. 
(B) EMBELLISH / MAGNIFY 
• Embellish: to decorate or add exaggerated details 
• Hindi meaning: सजाना 

• Magnify: to increase size or importance 
• Hindi meaning: बढाना 

Context: Disruptions do not decorate services or deliberately increase confidence. 
(C) AUDIT / RECONCILE 
• Audit: to examine accounts formally 
• Hindi meaning: िेखा-परीक्षा करना 

• Reconcile: to restore harmony or agreement 
• Hindi meaning: सुिह करना 

Context: These are administrative processes, not immediate impacts of disruption. 
(D) PACIFY / STABILISE 
• Pacify: to calm or appease 
• Hindi meaning: शािंत करना 

• Stabilise: to make steady 
• Hindi meaning: ष्टथर्र करना 

Context: The sentence suggests threat and damage, not calming or stabilising outcomes. 
(E) IMITATE / REHEARSE 
• Imitate: to copy 
• Hindi meaning: नकि करना 

• Rehearse: to practise beforehand 
• Hindi meaning: अभ्यास करना 

Context: These actions have no logical connection with service disruption or public confidence. 
 
S32. Ans.(c) 
Sol.  The correct answer is: E 
Explanation: 
The first sentence of a parajumble should introduce the broad theme without depending on prior 
information. 
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• E serves as a conceptual opener. It introduces the central idea of artificial components and their 
extended stability, which sets the direction of the paragraph. 

• The remaining sentences either depend on comparison (C), pricing history (F), cost escalation 
(A, D), or solution-based reasoning (B), all of which require the core idea in (E) to be established 
first. 

Therefore, (E) is the most logical opening sentence. 
Correct sequence: 
E → C → F → A → D → B 
Explanation: 

• E opens with the broad idea that artificial components can be designed to last longer than natural 
ones, setting the theme. 

• C follows logically because it begins with “In contrast” and explains why natural flavours like 
vanilla are vulnerable due to dependence on agriculture, labour, and lengthy extraction. 

• F comes next to give the baseline price of raw natural vanilla (125 dollars), which is needed 
before any increase can be discussed. 

• A must follow because it explicitly refers to the price after processing and refinement (1025 
dollars), which depends on the raw price mentioned in (F). 

• D then extends the same price trend to the post-pandemic period, stating that disruptions 
pushed prices beyond 11000 dollars, making it the peak of the problem. 

• B concludes the paragraph by offering the solution direction: developing synthetic alternatives 
to achieve consistency, scalability, and controlled pricing, directly responding to the cost 
escalation stated in (D). 

 
S33. Ans.(a) 
Sol.  The correct answer is: C 
Explanation: 
Once the paragraph opens with E, which introduces the idea of artificial components and their 
durability, the next logical step is to establish a contrast with natural alternatives. 

• C begins with “In contrast,” directly responding to the idea introduced in (E). It explains how 
natural flavour sources like vanilla depend on agriculture, labour, and time-intensive extraction. 

Correct sequence: 
E → C → F → A → D → B 
Explanation: 

• E opens with the broad idea that artificial components can be designed to last longer than natural 
ones, setting the theme. 

• C follows logically because it begins with “In contrast” and explains why natural flavours like 
vanilla are vulnerable due to dependence on agriculture, labour, and lengthy extraction. 

• F comes next to give the baseline price of raw natural vanilla (125 dollars), which is needed 
before any increase can be discussed. 

• A must follow because it explicitly refers to the price after processing and refinement (1025 
dollars), which depends on the raw price mentioned in (F). 

• D then extends the same price trend to the post-pandemic period, stating that disruptions 
pushed prices beyond 11000 dollars, making it the peak of the problem. 

• B concludes the paragraph by offering the solution direction: developing synthetic alternatives 
to achieve consistency, scalability, and controlled pricing, directly responding to the cost 
escalation stated in (D). 

 
S34. Ans.(a) 
Sol.  The correct answer is: F 
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Explanation: 
After E introduces artificial stability and C contrasts it with the fragile nature of natural vanilla sourcing, 
the paragraph must logically establish the baseline price before any discussion of increases. 

• F provides that baseline: the pre-pandemic price of raw natural vanilla at about 125 dollars per 
kilogram. 

• This is necessary groundwork because the next sentences build a step-wise escalation: raw price 
→ processed price → post-pandemic surge → solution. 

Correct sequence: 
E → C → F → A → D → B 
Explanation: 

• E opens with the broad idea that artificial components can be designed to last longer than natural 
ones, setting the theme. 

• C follows logically because it begins with “In contrast” and explains why natural flavours like 
vanilla are vulnerable due to dependence on agriculture, labour, and lengthy extraction. 

• F comes next to give the baseline price of raw natural vanilla (125 dollars), which is needed 
before any increase can be discussed. 

• A must follow because it explicitly refers to the price after processing and refinement (1025 
dollars), which depends on the raw price mentioned in (F). 

• D then extends the same price trend to the post-pandemic period, stating that disruptions 
pushed prices beyond 11000 dollars, making it the peak of the problem. 

• B concludes the paragraph by offering the solution direction: developing synthetic alternatives 
to achieve consistency, scalability, and controlled pricing, directly responding to the cost 
escalation stated in (D). 

 
S35. Ans.(b) 
Sol.  The correct answer is: D 
Explanation: 
The paragraph follows a clear escalation path: concept → contrast → pre-pandemic baseline → post-
processing cost → post-pandemic spike → solution. 
So, the fifth sentence must logically present the next and biggest escalation, which is the post-
pandemic surge. 

• D does exactly that by stating that disruptions pushed prices beyond 11000 dollars globally. 
This is a direct continuation of the cost trend established earlier and must appear just before the 
concluding solution. 

Correct sequence: 
E → C → F → A → D → B 
Explanation: 

• E opens with the broad idea that artificial components can be designed to last longer than natural 
ones, setting the theme. 

• C follows logically because it begins with “In contrast” and explains why natural flavours like 
vanilla are vulnerable due to dependence on agriculture, labour, and lengthy extraction. 

• F comes next to give the baseline price of raw natural vanilla (125 dollars), which is needed 
before any increase can be discussed. 

• A must follow because it explicitly refers to the price after processing and refinement (1025 
dollars), which depends on the raw price mentioned in (F). 

• D then extends the same price trend to the post-pandemic period, stating that disruptions 
pushed prices beyond 11000 dollars, making it the peak of the problem. 
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• B concludes the paragraph by offering the solution direction: developing synthetic alternatives 
to achieve consistency, scalability, and controlled pricing, directly responding to the cost 
escalation stated in (D). 

 
S36. Ans.(b) 
Sol.  The correct answer is: B 
Explanation: 
The final sentence must logically provide the response/solution to the problem presented. 

• B performs this concluding function by explaining that synthetic alternatives are developed to 
reduce extreme cost escalation through consistency, scalability, and controlled pricing. It directly 
addresses the issue raised by the preceding cost spike and gives the paragraph a complete, 
purposeful ending. 

Correct sequence: 
E → C → F → A → D → B 
Explanation: 

• E opens with the broad idea that artificial components can be designed to last longer than natural 
ones, setting the theme. 

• C follows logically because it begins with “In contrast” and explains why natural flavours like 
vanilla are vulnerable due to dependence on agriculture, labour, and lengthy extraction. 

• F comes next to give the baseline price of raw natural vanilla (125 dollars), which is needed 
before any increase can be discussed. 

• A must follow because it explicitly refers to the price after processing and refinement (1025 
dollars), which depends on the raw price mentioned in (F). 

• D then extends the same price trend to the post-pandemic period, stating that disruptions 
pushed prices beyond 11000 dollars, making it the peak of the problem. 

• B concludes the paragraph by offering the solution direction: developing synthetic alternatives 
to achieve consistency, scalability, and controlled pricing, directly responding to the cost 
escalation stated in (D). 

 
S37. Ans.(b) 
Sol.  The correct answer is (B). 
Explanation: 
Option-wise analysis: 

• (A) Correct. 
• “Neither” is a singular subject and correctly takes the singular verb “appears.” The sentence 

follows proper subject–verb agreement. 
• (B) Incorrect. 
• The subject is “the number”, which is singular and must take a singular verb. 
• The correct form should be: 
• “The number of applicants has increased significantly over the past few years.” 
• (C) Correct. 
• The sentence maintains proper tense consistency and logical structure. “Would satisfy” correctly 

follows “was confident.” 
• (D) Correct. 
• The gerund phrase “helps in avoiding” is correctly used, and the sentence is grammatically sound. 

Since only sentence (B) contains a grammatical error, option (B) is the correct answer. 
 
S38. Ans.(a) 
Sol.  The correct answer is (A). 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


 
 

Option-wise analysis: 
• (A) Incorrect. 
• The correlative conjunction used with “hardly” must be “when”, not “than.” 
• Correct structure: 
• Hardly had the curtain risen when the audience sensed something unusual about the performance. 
• (B) Correct. 
• The true subject is “the manuscript”, which is singular. The phrase “along with several 

handwritten notes” is additional information and does not affect verb agreement. Hence, “was 
preserved” is correct. 

• (C) Correct. 
• The sentence is grammatically sound and correctly uses a relative clause to explain dependency 

factors. 
• (D) Correct. 
• The concessive phrase “though scenic” is properly placed, and the verb agreement and overall 

structure are accurate. 
Since only sentence (A) contains a grammatical error, option (A) is the correct answer. 
 
S39. Ans.(d) 
Sol.  The correct answer is (D). 
Option-wise analysis: 

• (A) Correct. 
• The sentence correctly uses “despite” followed by a noun phrase, and the verb forms are 

appropriate. 
• (B) Correct. 
• The verb “recommended” is correctly followed by a subjunctive structure (“that the issue be 

examined”), which is standard in formal English. 
• (C) Correct. 
• The inverted structure “Little did she realize” is grammatically sound and correctly used for 

emphasis. 
• (D) Incorrect. 
• After “as if / as though”, when the situation is unreal or hypothetical, English prefers the past 

perfect to indicate unreality. 
• The sentence should be: 
• He behaves as if he had been unaware of the implications of his earlier actions. 

Since sentence (D) contains the grammatical error, option (D) is the correct answer. 
 
S40. Ans.(e) 
Sol.  The correct answer is (E). 
Option-wise analysis: 

• (A) Incorrect. 
• The subject is “extent”, which is singular. Therefore, the verb must also be singular. 
• Correct form: 
• The extent to which these measures impact public confidence remains unclear. 
• (B) Incorrect. 
• “Seldom” is a negative adverb and requires inversion. Also, there is a subject–verb agreement 

error. 
• Correct form: 
• Seldom do people recognize how subtle changes alter long-term outcomes. 
• (C) Incorrect. 
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• The true subject is “the director”, which is singular. The phrase “along with the senior advisors” 
does not affect verb agreement. 

• Correct form: 
• The director, along with the senior advisors, has approved the revised framework. 
• (D) Incorrect. 
• The subject is “emphasis”, which is singular and requires a singular verb. 
• Correct form: 
• Greater emphasis on consistency helps reduce avoidable procedural lapses. 

Since all sentences (A–D) contain grammatical errors, the correct answer is (E) All are incorrect. 
 
S41. Ans.(b) 
Sol.  The correct answer is (B). 
Option-wise analysis: 

• (A) Incorrect. 
• The true subject is “the researcher”, which is singular. The phrase “along with several 

assistants” does not affect verb agreement. 
• Correct form: 
• The researcher, along with several assistants, was documenting the observations carefully. 
• (B) Correct. 
• The structure “as though + past tense” is correctly used here to indicate an assumed or unreal 

situation in the past. The sentence is grammatically sound and contextually appropriate. 
• (C) Incorrect. 
• “Rarely” is a negative adverb and requires auxiliary inversion. There is also a subject–verb 

agreement error. 
• Correct form: 
• Rarely do people appreciate how minor adjustments improve long-term efficiency. 
• (D) Incorrect. 
• The subject “instructions” is plural, but the verb “lacks” is singular. 
• Correct form: 
• The instructions given to him lack clarity and consistency. 
• (E) Incorrect because option (B) is grammatically correct. 

Hence, option (B) is the only grammatically correct sentence. 
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RRB PO Mains 2025 Computer Knowledge Section Memory-Based 

Paper (28 Dec 2025) 
 
Q1. The PS/2 port was primarily developed by which company? 
(a) Microsoft 
(b) Intel 
(c) IBM 
(d) Apple 
(e) Dell 
 
Q2. In MS Excel, Which formula adds only values stored in cells A2 and A4? 
(a) =SUM(A2+A4) 
(b) =SUM(A2,A4) 
(c) =ADD(A2,A4) 
(d) =SUM(A2:A4) 
(e) None of the above 
 
Q3. The POP3 protocol is primarily used for? 
(a) Sending emails from client to server 
(b) Retrieving and downloading emails from server to client 
(c) Real-time email synchronization across multiple devices 
(d) Encrypting email messages during transmission 
(e) Managing email folders on the mail server  
 
Q4. In MS PowerPoint, when a new blank slide is opened, how many default text placeholders 
appear on the slide? 
(a) 1 placeholder 
(b) 2 placeholders 
(c) 3 placeholders 
(d) 4 placeholders 
(e) 5 placeholders 
 
Q5. In a computer’s audio port color coding, which color port is used to connect speakers or 
headphones? 
(a) Pink 
(b) Blue 
(c) Lime Green 
(d) Black 
(e) Orange  
 
Q6. Letters, journals, resumes, and other text-based documents can be easily created, edited, 
and formatted using which MS Office application? 
(a) Microsoft Excel 
(b) Microsoft PowerPoint 
(c) Microsoft Word 
(d) Microsoft Access 
(e) Microsoft Outlook  
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Q7. Where is BIOS software stored and loaded from? 
(a) Hard Disk Drive 
(b) RAM memory 
(c) ROM chip on motherboard 
(d) CPU cache 
(e) SSD storage 
 
Q8. Compared to a traditional Hard Disk Drive, Solid-State Drives generally lack which 
characteristic? 
(a) Non-volatile data storage 
(b) Mechanical moving parts 
(c) Support for operating system installation 
(d) Ability to store large files 
(e) Compatibility with SATA interface 
 
Q9. During an online meeting, a presenter wants to keep the audience’s attention focused on 
their video feed. Which meeting feature helps the presenter highlight their own video on 
everyone’s screen? 
(a) Raise hand 
(b) Pin video 
(c) Share screen 
(d) Spotlight video 
(e) Enable gallery view 
 
Q10. 3D Printing technology is primarily based on which of the following manufacturing 
processes? 
(a) Subtractive manufacturing 
(b) Casting process 
(c) Forming process 
(d) Additive manufacturing 
(e) Injection molding  
 
Q11. Which of the following is not considered an example of an operating system used in 
computers? 
(a) Windows 
(b) Linux 
(c) macOS 
(d) Python 
(e) Android  
 
Q12. The process of converting readable data into an unreadable or scrambled form to prevent 
access by unauthorized users is known as: 
(a) Decryption 
(b) Encryption 
(c) Compression 
(d) Encoding 
(e) Firewalling 
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Q13. What is the primary and most important function performed by the CPU in a computer 
system? 
(a) Managing input and output devices 
(b) Storing data permanently 
(c) Controlling network communication 
(d) Fetching, decoding, and executing instructions 
(e) Managing files and folders 
 
Q14. It is the central point of a network that connects multiple hosting devices together to form 
one network. Which of the following networking devices performs this function? 
(a) Router 
(b) Hub 
(c) Repeater 
(d) Bridge 
(e) Gateway 
 
Q15. Which output device is used to produce a printed, physical copy of digital data stored in a 
computer? 
(a) Monitor 
(b) Speaker 
(c) Printer 
(d) Plotter 
(e) Projector 
 
Q16. Which programming language was developed as a third-generation high-level language 
(3GL) designed to be easier for humans to read and write? 
(a) Assembly Language 
(b) COBOL 
(c) Machine Language 
(d) Binary Code 
(e) Microprocessor Language  
 
Q17. Which multi-user, time-sharing operating system was developed at Bell Labs and became 
highly influential in the history of computing? 
(a) MS-DOS 
(b) UNIX 
(c) Windows NT 
(d) macOS 
(e) CP/M.  
 
Q18. Which protocol operates at Layer 3 of the OSI reference 
model, enabling logical addressing and routing? 
(a) TCP 
(b) IP 
(c) HTTP 
(d) FTP 
(e) ARP 
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Q19. Which of the following is not available under the Insert tab in MS Excel? 
(a) Table 
(b) Chart 
(c) Picture 
(d) Macros 
(e) Shapes  
 
Q20. What do we call the area of a computer that temporarily stores data and instructions before 
they are processed by the CPU? 
(a) Hard Disk 
(b) ROM 
(c) RAM 
(d) Cache 
(e) Register  
 
Q21. Which HTML elements help search engines better understand and interpret webpage 
content for indexing and ranking? 
(a) div tags 
(b) meta tags 
(c) br tags 
(d) table tags 
(e) form tags  
 
Q22. Which function in MS Excel returns the remainder when one number is divided by another? 
(a) QUOTIENT() 
(b) DIVIDE() 
(c) REMAINDER() 
(d) MOD() 
(e) ROUND() 
 
Q23. What is the process called in which a user creates another copy of stored data to protect it 
from loss or damage? 
(a) Formatting 
(b) Backup 
(c) Restoration 
(d) Archiving 
(e) Encryption 
 
Q24. In the UNIX operating system, which program acts as an interface between the user and the 
system kernel, allowing communication with the hardware? 
(a) Compiler 
(b) Shell 
(c) Terminal 
(d) Command 
(e) Process 
 
Q25. Which of the following is commonly used in a Personal Area Network (PAN) for 
communication? 
(a) Twisted Pair Cable 
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(b) Coaxial Cable 
(c) Infrared 
(d) Satellite 
(e) Fiber Optic Cable 
 
Q26. Which keyboard shortcut key is used to activate and access the Menu Bar options in MS 
Excel? 
(a) Ctrl 
(b) Shift 
(c) Alt 
(d) Tab 
(e) Esc 
 
Q27. IC chips are used in which type of computer? 
(a) Mini Computer 
(b) Micro Computer 
(c) Mainframe Computer 
(d) Super Computer 
(e) Hybrid Computer 
 
Q28. Which of the following is not considered a component of a URL? 
(a) Protocol 
(b) Domain 
(c) Path 
(d) Query 
(e) Bandwidth 
 
Q29. In which format is an IPv6 address represented? 
(a) Binary 
(b) Decimal 
(c) Hexadecimal 
(d) Octal 
(e) ASCII 
 
Q30. Which of the following statements best describes the characteristics and behaviour of a 
dynamic website? 
(a) Displays fixed content to all users 
(b) Created only with static HTML pages 
(c) The website which updates frequently based on user interaction 
(d) Cannot be modified once published 
(e) Contains only text and images  
 
Q31. Which of the following operating systems is primarily recognized for its strong security 
features? 
(a) Windows 
(b) macOS 
(c) UNIX 
(d) Android 
(e) MS-DOS 
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Q32. Which type of malware can self-replicate and transfer from one computer to another 
automatically? 
(a) Virus 
(b) Worm 
(c) Trojan 
(d) Spyware 
(e) Adware 
 
Q33. Which service set includes only platforms that operate purely on core Voice-over-IP 
technology? 
(a) Skype, Zoom, Google Meet 
(b) WhatsApp, Facebook, Instagram 
(c) Gmail, Outlook, Yahoo 
(d) Telegram, Signal, Messenger 
(e) YouTube, Netflix, Spotify 
 
Q34. In research methodology, which element is responsible for clearly defining the scope, 
boundaries, and objectives of a project under the research design? 
(a) Research Hypothesis 
(b) Feasibility Study 
(c) System Requirement Specification (SRS) 
(d) Research Plan 
(e) Project Proposal  
 
Q35. What do we call the radio-based navigation system that consists of a sender, a computer, 
and a receiver working together for communication? 
(a) Bluetooth 
(b) GPS 
(c) Wi-Fi 
(d) Radar 
(e) Infrared  
 
Q36. Which of the following operating systems runs on servers and provides the capacity to 
manage, control, and distribute data or services to connected systems? 
(a) Windows Server 
(b) Solaris 
(c) MS-DOS 
(d) VxWorks 
(e) UNIX  

 
Q37. What does the Strikethrough option in MS Word do to the selected text? 
(a) Underlines the text 
(b) Draws a line above the text 
(c) Draws a line through the middle of the text 
(d) Changes text color 
(e) Converts text to uppercase 
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Q38. Which of the following groups contains only valid File 
Explorer View modes used in Windows? 
(a) Icons, Tiles, List, Details 
(b) Preview, Table, Grid, Zoom 
(c) Outline, Summary, Report, Icon 
(d) Sort, Filter, Group, Arrange 
(e) Folder, Link, Tree, Network 
 
Q39. What do we call the combination of headers used in 
networking to carry data packets from the source to the final 
destination? 
(a) Data Link 
(b) Data Encapsulation 
(c) Packet Switching 
(d) Protocol Stack 
(e) Frame Segmentation 
 
Q40. Which technology helps to store duplicate copies of data in a balanced way to improve 
performance and reliability? 
(a) Cloud Storage 
(b) RAID 
(c) Virtual Memory 
(d) Cache Memory 
(e) SSD 
 

Solutions 
 
S1. Ans.(c) 
The PS/2 port is a 6-pin mini-DIN connector used for connecting keyboards and mice to personal 
computers. It was introduced by IBM in 1987 with the launch of the Personal System/2 (PS/2) series 
of computers. The name "PS/2" directly comes from IBM's product line. This port became a standard in 
the PC industry for many years before being largely replaced by USB. 
Important Key Points: 
1. PS/2 port was introduced by IBM in 1987. 
2. It was part of the IBM Personal System/2 (PS/2) computer series. 
3. The port uses a 6-pin mini-DIN connector and supports both keyboard and mouse. 
4. PS/2 interfaces allowed colour-coded ports (purple for keyboard, green for mouse). 
Knowledge Booster: 
• (a) Microsoft → Collaborated with IBM on OS/2 but did not develop the PS/2 hardware port. 
• (b) Intel → Develops processors and chipsets, not the PS/2 connector standard. 
• (d) Apple → Used different connectors (ADB initially, later USB); never adopted PS/2. 
• (e) Dell → A PC manufacturer that used PS/2 ports but did not develop them. 
 
S2. Ans.(b) 
In Microsoft Excel, the SUM function can accept individual cell references separated by commas. The 
formula =SUM(A2,A4) adds only the values in cells A2 and A4, ignoring any cells in between. This is the 
correct way to sum non-contiguous cells. Other options either include extra cells or use incorrect syntax. 
Important Key Points: 
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1. SUM function in Excel can take multiple individual arguments separated by commas. 
2. =SUM(A2,A4) adds only the specified cells, skipping A3. 
3. Comma separator treats arguments as separate ranges or values. 
4. This method is useful for summing non-adjacent or non-contiguous cells. 
Knowledge Booster: 
• (a) =SUM(A2+A4) → First performs addition (A2+A4), then SUM on single result; works but 

unnecessary and less clear. 
• (c) =ADD(A2,A4) → No ADD function exists in Excel; invalid formula. 
• (d) =SUM(A2:A4) → Uses colon for contiguous range; adds A2, A3, and A4 together. 
• (e) =none of the above → Incorrect since option (b) is valid and correct. 
 
S3. Ans.(b) 
POP3 (Post Office Protocol version 3) is an email retrieval protocol designed to download emails from 
a mail server to a local email client. It typically removes the emails from the server after download 
(unless configured otherwise). This makes it suitable for users who access email from a single device. 
POP3 operates on port 110 (or 995 for secure POP3S). 
Important Key Points: 
1. POP3 is used primarily for downloading emails from server to client. 
2. It usually deletes emails from the server after retrieval. 
3. Default port is 110 (plain) or 995 (SSL/TLS). 
4. Suitable for offline email access on one device. 
Knowledge Booster: 
• (a) Sending emails from client to server → Handled by SMTP protocol, not POP3. 
• (c) Real-time email synchronization across multiple devices → Feature of IMAP, not POP3. 
• (d) Encrypting email messages during transmission → Provided by SSL/TLS (POP3S), but not the 

primary purpose of POP3. 
• (e) Managing email folders on the mail server → Supported by IMAP, not POP3. 
 
S4. Ans.(b) 
When you insert a new blank slide in Microsoft PowerPoint (using the "Blank" slide layout), it appears 
completely empty at first glance. However, it contains exactly two default text placeholders: one for 
the title ("Click to add title") and one for the subtitle ("Click to add subtitle"). These placeholders are 
centred on the slide and become visible when you click on them or start typing. No other placeholders 
(like bullets or content boxes) are present by default in a truly blank slide. 
Important Key Points: 
1. A blank slide uses the "Blank" layout in PowerPoint. 
2. It has exactly two text placeholders: title and subtitle. 
3. These placeholders are hidden until clicked or when text is added. 
4. Other layouts (e.g., Title and Content) add more placeholders like bullet lists. 
Knowledge Booster: 
• (a) 1 placeholder → Incorrect; blank slide includes both title and subtitle. 
• (c) 3 placeholders → No third placeholder exists in the blank layout. 
• (d) 4 placeholders → Far too many; only two are present. 
• (e) 5 placeholders → Far too many; only two are present. 
 
S5. Ans.(c) 
The standard PC audio port color coding (defined by Microsoft and Intel in the PC 99/PC 2001 
specifications) assigns Lime Green to the line-out or front stereo audio output port. This port is used 
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to connect speakers or headphones for audio playback from the computer. It is the most common output 
for standard stereo sound in desktop and laptop systems. 
Important Key Points: 
1. Lime Green is the standard color for audio line-out (speaker/headphone output). 
2. This coding is part of the PC System Design Guide for consistent identification. 
3. Commonly found on motherboard rear I/O panels and front case connectors. 
4. Headphones and powered speakers plug directly into this port. 
Knowledge Booster: 

• (a) Pink → Used for microphone input. 
• (b) Blue → Used for line-in (external audio source input). 
• (d) Black → Used for rear surround speakers in multi-channel setups. 
• (e) Orange → Used for center/subwoofer output in surround sound systems. 
 

S6. Ans.(c) 
Microsoft Word is the premier word processing application in the MS Office suite, specifically 
designed for creating, editing, and formatting text-based documents like letters, journals, resumes, 
reports, and books. It offers advanced features such as templates (e.g., resume builders), styles, mail 
merge, track changes, rich text formatting (fonts, paragraphs, tables), spell-check, and grammar tools. 
Unlike other Office apps, Word focuses on textual content rather than spreadsheets, presentations, 
databases, or email. 
Important Key Points: 

1. Microsoft Word is a word processor for primarily text-heavy documents. 
2. Key features include templates, styles, mail merge, and track changes. 
3. Supports advanced formatting like bullets, numbering, headers/footers, and sections. 
4. File formats: .docx (default), .doc (legacy), .pdf for sharing. 

Knowledge Booster: 
• (a) Microsoft Excel → Spreadsheet software for numerical data, calculations, charts; not for text 

documents. 
• (b) Microsoft PowerPoint → Presentation software for slides, visuals; unsuitable for long-form 

text. 
• (d) Microsoft Access → Database management system for structured data storage/queries; no 

text editing focus. 
• (e) Microsoft Outlook → Email client for messaging, calendars; basic editor but lacks document 

formatting tools. 
 

S7. Ans.(c) 
The BIOS (Basic Input/Output System) is firmware that initializes hardware during the boot process 
and provides runtime services. It is stored in a non-volatile ROM (Read-Only Memory) chip, typically a 
flashable EEPROM or UEFI firmware chip, directly on the motherboard. During system startup, the 
CPU loads and executes the BIOS code directly from this chip before any storage devices are accessed. 
Important Key Points: 

1. BIOS is stored on a dedicated ROM/Flash chip on the motherboard. 
2. It is non-volatile, retaining code even when power is off. 
3. Modern systems use UEFI (successor to traditional BIOS) stored in the same type of chip. 
4. BIOS executes first during POST (Power-On Self-Test) before loading the OS. 

Knowledge Booster: 
• (a) Hard Disk Drive → Contains the operating system and boot loader, not BIOS. 
• (b) RAM memory → Volatile memory; BIOS is loaded into RAM for execution but not stored there. 
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• (d) CPU cache → High-speed temporary storage for instructions/data; too small and volatile for 
BIOS. 

• (e) SSD storage → Fast storage medium like HDD; holds OS files, not firmware. 
 

S8. Ans.(b) 
Traditional Hard Disk Drives (HDDs) use spinning platters, read/write heads, and actuators, which 
are mechanical moving parts. Solid-State Drives (SSDs) use NAND flash memory chips with no 
moving components. This absence of mechanical parts makes SSDs faster, more durable, silent, and less 
prone to physical damage from drops or vibration. 
Important Key Points: 

1. HDDs rely on mechanical moving parts like platters and heads. 
2. SSDs have no moving parts, using flash memory instead. 
3. Lack of mechanical components gives SSDs higher speed and shock resistance. 
4. This design difference is the primary reason SSDs are quieter and more reliable in mobile 

devices. 
Knowledge Booster: 

• (a) Non-volatile data storage → Both HDDs and SSDs are non-volatile; data persists without 
power. 

• (c) Support for operating system installation → SSDs fully support OS installation, often 
preferred for faster boot times. 

• (d) Ability to store large files → SSDs can store large files just like HDDs; capacity is independent 
of technology. 

• (e) Compatibility with SATA interface → Many SSDs use SATA interface for backward 
compatibility with HDD systems. 

 
S9. Ans.(d) 
The Spotlight video feature (available in platforms like Zoom, Microsoft Teams, and Google Meet) 
allows a host or participant with permission to designate a specific video feed as the primary view for 
all attendees. When spotlighted, that person's video becomes the main or fixed view on everyone's 
screen, overriding individual pinning or gallery layouts. This is ideal for presenters who want to ensure 
the audience focuses on them rather than other participants. 
Important Key Points: 

1. Spotlight video makes one participant's video the primary/active view for all attendees. 
2. It is typically controlled by the host or co-host. 
3. Overrides personal pin settings and gallery view for everyone. 
4. Commonly used in webinars, lectures, or presentations to focus attention on the speaker. 

Knowledge Booster: 
• (a) Raise hand → Notifies the host of a request to speak; does not highlight video. 
• (b) Pin video → Allows individual users to fix a video on their own screen only; does not affect 

others. 
• (c) Share screen → Displays presented content (slides/documents); hides or minimizes 

participant videos. 
• (e) Enable gallery view → Shows all participants in a grid; no single video is highlighted. 
 

S10. Ans.(d) 
3D Printing, also known as Additive Manufacturing, builds objects by successively adding material 
layer by layer based on a digital 3D model. This contrasts with traditional methods that remove material 
or force it into shape. The term "additive" refers to the incremental deposition of material (plastic, 
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metal, resin, etc.) until the final part is complete. Standards bodies like ASTM International officially 
classify 3D printing under additive manufacturing processes. 
Important Key Points: 

1. 3D Printing is synonymous with Additive Manufacturing. 
2. It constructs objects layer by layer from a digital file (usually STL or AMF format). 
3. Reduces material waste compared to subtractive methods. 
4. Enables complex geometries, internal structures, and customization impossible with traditional 

processes. 
Knowledge Booster: 

• (a) Subtractive manufacturing → Involves removing material (e.g., CNC milling, lathe); opposite 
of 3D printing. 

• (b) Casting process → Pours molten material into a mold; not layer-based. 
• (c) Forming process → Shapes material by deformation (e.g., forging, bending); no material 

addition/removal. 
• (e) Injection molding → Forces molten material into a mold under pressure; mass-production, 

not additive. 
 

S11. Ans.(d) 
An operating system (OS) is system software that manages computer hardware, resources, and 
provides common services for application programs. Windows, Linux, macOS, and Android are all 
full-fledged operating systems used on computers and devices. Python, however, is a high-level 
programming language and interpreter, not an operating system. It runs on top of an existing OS to 
execute scripts and programs. 
Important Key Points: 

1. Operating System manages hardware, memory, processes, and file systems. 
2. Common OS examples include Windows, Linux, macOS, and Android. 
3. Python is a programming language, not system software. 
4. Python requires an underlying OS (like Windows or Linux) to run. 

Knowledge Booster: 
• (a) Windows → Full OS developed by Microsoft for PCs and servers. 
• (b) Linux → Open-source Unix-like OS kernel used in desktops, servers, and embedded systems. 
• (c) macOS → Apple's proprietary OS for Macintosh computers. 
• (e) Android → Google's Linux-based mobile OS, also used on tablets and some computers. 
 

S12. Ans.(b) 
Encryption is the process of transforming plaintext (readable data) into ciphertext (unreadable 
scrambled form) using an algorithm and a key. This ensures that only authorized users with the correct 
key can reverse the process (via decryption) and access the original data. Encryption is a core 
component of data security and confidentiality in computing. 
Important Key Points: 

1. Encryption converts plaintext to ciphertext for security. 
2. It uses cryptographic algorithms (e.g., AES, RSA) and keys. 
3. Primary goal is to protect data from unauthorized access. 
4. Reversible only through decryption with the proper key. 

Knowledge Booster: 
• (a) Decryption → Reverse process: converts ciphertext back to plaintext. 
• (c) Compression → Reduces file size; data remains readable without a key. 
• (d) Encoding → Transforms data for compatibility (e.g., Base64); not secure against reading. 
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• (e) Firewalling → Network security technique to filter traffic; not data transformation. 
 

S13. Ans.(d) 
The Central Processing Unit (CPU) is often called the "brain" of the computer. Its primary and most 
critical function is to execute program instructions by repeatedly performing the fetch-decode-
execute cycle. In this cycle, the CPU fetches instructions from memory, decodes them to understand 
what operation is required, and then executes the operation. This process enables all software running 
on the computer to perform tasks. 
Important Key Points: 

1. CPU performs the fetch-decode-execute cycle continuously. 
2. It processes instructions from programs stored in RAM. 
3. All computations, logical operations, and data manipulations occur in the CPU. 
4. Without this core function, no software can run on the system. 

Knowledge Booster: 
• (a) Managing input and output devices → Handled primarily by I/O controllers and the OS, not 

directly by CPU. 
• (b) Storing data permanently → Responsibility of storage devices like HDD/SSD. 
• (c) Controlling network communication → Managed by network interface cards and OS 

drivers. 
• (e) Managing files and folders → Performed by the operating system's file system, not the CPU 

hardware. 
 

S14. Ans.(b) 
A hub is a basic networking device that serves as the central connection point in a star topology 
network. It connects multiple devices (such as computers and printers) together by broadcasting 
incoming data to all connected ports. This allows the devices to communicate within the same network 
segment. Hubs operate at the physical layer (Layer 1) of the OSI model and simply repeat signals 
without intelligent filtering. 
Important Key Points: 

1. Hub acts as a central multi-port repeater in a network. 
2. It connects devices in a star topology to form a single collision domain. 
3. Data received on one port is broadcast to all other ports. 
4. Operates at Layer 1 (Physical layer) of the OSI model. 

Knowledge Booster: 
• (a) Router → Connects different networks and routes traffic using IP addresses (Layer 3). 
• (c) Repeater → Extends signal distance on a single network segment; not a central connection 

point. 
• (d) Bridge → Connects and filters traffic between network segments (Layer 2); reduces collision 

domains. 
• (e) Gateway → Connects networks with different protocols; acts as a translator between 

incompatible systems. 
 

S15. Ans.(c) 
A printer is the standard output device that converts digital data from a computer into a physical, 
printed copy on paper or other media. Common types include inkjet, laser, and thermal printers. They 
produce hard copies of documents, images, reports, and photos for offline use or distribution. 
Important Key Points: 

1. Printer creates hard copies (physical prints) from digital files. 
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2. It is the most common device for producing tangible output. 
3. Types include inkjet (for photos), laser (for text/documents), and dot-matrix (impact 

printing). 
4. Connects via USB, Wi-Fi, or network for receiving print jobs. 

Knowledge Booster: 
• (a) Monitor → Visual output device; displays data on screen only. 
• (b) Speaker → Audio output device; produces sound. 
• (d) Plotter → Specialized printer for large-format vector graphics (e.g., blueprints); not general-

purpose. 
• (e) Projector → Displays digital content on a surface/screen; no physical copy produced. 
 

S16. Ans.(b) 
COBOL (Common Business-Oriented Language) is a classic example of a third-generation high-level 
language (3GL). It was developed in 1959–1960 specifically to make programming more accessible to 
business users and easier for humans to read and write. COBOL uses English-like syntax (e.g., verbs like 
ADD, MOVE, PERFORM) to handle business data processing tasks. This human-readable design was a 
key goal of its creators, led by Grace Hopper, to reduce dependence on low-level languages. 
Important Key Points: 

1. COBOL is a 3GL (third-generation language) focused on business applications. 
2. It uses English-like statements for better readability and maintainability. 
3. Developed in the late 1950s by a committee including Grace Hopper. 
4. Still widely used today in legacy systems for banking and finance. 

Knowledge Booster: 
• (a) Assembly Language → Second-generation language (2GL); uses mnemonics but is 

hardware-specific and low-level. 
• (c) Machine Language → First-generation language (1GL); pure binary instructions directly 

understood by CPU. 
• (d) Binary Code → Same as machine language; raw 0s and 1s, not human-readable. 
• (e) Microprocessor Language → Not a standard programming language; likely refers to low-level 

machine or assembly code. 
 

S17. Ans.(b) 
UNIX is a multi-user, multitasking, time-sharing operating system originally developed in the early 
1970s at Bell Labs by Ken Thompson, Dennis Ritchie, and others. Written initially in assembly and later 
rewritten in the C programming language, UNIX introduced groundbreaking concepts such as 
hierarchical file systems, pipes, and portability. Its design profoundly influenced modern operating 
systems, including Linux, macOS, and many others. 
Important Key Points: 

1. UNIX was created at Bell Labs starting in 1969–1970s. 
2. It supports multi-user access and time-sharing for concurrent users. 
3. Rewritten in C in 1973, enabling easy portability across hardware. 
4. Highly influential; basis for POSIX standards and many modern OS. 

Knowledge Booster: 
• (a) MS-DOS → Single-user, single-tasking OS developed by Microsoft for IBM PC. 
• (c) Windows NT → Microsoft-developed OS; influenced by VMS, not directly by Bell Labs UNIX. 
• (d) macOS → Derived from NeXTSTEP/BSD UNIX, but originally developed by Apple/NeXT, not 

Bell Labs. 
• (e) CP/M → Single-user OS for microcomputers developed by Digital Research. 
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S18. Ans.(b) 
The Internet Protocol (IP) operates at Layer 3 (Network Layer) 
of the OSI model. It provides logical addressing through IP 
addresses (e.g., IPv4 or IPv6) and enables routing of packets 
across different networks. IP is responsible for packet forwarding, 
fragmentation, and delivery on a best-effort basis without 
guaranteeing reliability. 
Important Key Points: 

1. IP is the primary protocol at Layer 3 (Network Layer). 
2. It handles logical addressing using IP addresses. 
3. Enables routing between networks via routers. 
4. Connectionless and unreliable; reliability is handled by 

upper layers. 
Knowledge Booster: 

• (a) TCP → Operates at Layer 4 (Transport Layer); provides reliable, connection-oriented 
delivery. 

• (c) HTTP → Operates at Layer 7 (Application Layer); used for web data transfer. 
• (d) FTP → Operates at Layer 7 (Application Layer); file transfer protocol. 
• (e) ARP → Operates at the boundary of Layer 2 (Data Link) and Layer 3; maps IP addresses to 

MAC addresses. 
 

S19. Ans.(d) 
In Microsoft Excel, the Insert tab contains commands for adding various objects and elements to a 
worksheet. It includes options like Table, Chart, Picture (from file, online, or stock images), and 
Shapes (including icons and text boxes). However, Macros are not located under the Insert tab. Macros 
are managed through the Developer tab (which must be enabled in Excel options) using the Macros 
dialog, Record Macro, or Visual Basic editor. 
Important Key Points: 

1. Insert tab is used to add visual and structural elements to worksheets. 
2. Table, Chart, Picture, and Shapes are all directly available under the Insert tab. 
3. Macros are accessed via the Developer tab (not visible by default). 
4. Developer tab can be enabled from File → Options → Customize Ribbon. 

Knowledge Booster: 
• (a) Table → Available under Insert → Table group (Insert Table or Format as Table). 
• (b) Chart → Available under Insert → Charts group (recommended charts, column, pie, etc.). 
• (c) Picture → Available under Insert → Illustrations group (Pictures, Online Pictures). 
• (e) Shapes → Available under Insert → Illustrations group (Shapes, Icons, 3D Models). 
 

S20. Ans.(c) 
RAM (Random Access Memory) is the primary temporary storage area in a computer where data and 
instructions are held while waiting to be processed by the CPU. It is volatile memory, meaning contents 
are lost when power is off. The CPU frequently accesses RAM for quick read/write operations during 
program execution, making it essential for running applications. 
Important Key Points: 

1. RAM is the main volatile memory for temporary storage of data and instructions. 
2. It allows fast random access by the CPU during processing. 
3. Contents are erased when the computer is powered off. 
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4. Larger RAM capacity improves multitasking and system performance. 
Knowledge Booster: 

• (a) Hard Disk → Permanent non-volatile storage for files and OS; much slower access. 
• (b) ROM → Non-volatile memory for firmware; read-only, not used for temporary data. 
• (d) Cache → Small, ultra-fast memory inside or near CPU; temporary but not the primary area. 
• (e) Register → Tiny, fastest storage inside CPU; holds data during immediate processing only. 
 

S21. Ans.(b) 
Meta tags are HTML elements placed in the <head> section of a webpage that provide structured 
metadata about the page. Search engines like Google use this information to understand the page's 
content, purpose, title, description, keywords (historically), robots instructions, and canonical URLs. 
Key examples include <title>, <meta name="description">, <meta name="robots">, and Open Graph 
tags. These directly influence indexing, snippet display in search results, and overall SEO ranking. 
Important Key Points: 

1. Meta tags provide metadata in the head section for search engines. 
2. Common ones: title, description, robots, viewport, and canonical. 
3. They help with proper indexing, rich snippets, and search result appearance. 
4. Semantic HTML elements also assist, but meta tags are primary for direct instructions. 

Knowledge Booster: 
• (a) div tags → Generic containers for layout/styling; no semantic meaning for search engines. 
• (c) br tags → Line breaks for text formatting; purely presentational, no content understanding. 
• (d) table tags → Used for tabular data; helpful if structured properly, but not primarily for SEO 

metadata. 
• (e) form tags → Enable user input; searchable but do not provide metadata or content 

description. 
 

S22. Ans.(d) 
The MOD function in Microsoft Excel returns the remainder after a number is divided by a divisor. The 
syntax is =MOD(number, divisor). For example, =MOD(10,3) returns 1 because 10 divided by 3 gives 
a quotient of 3 and a remainder of 1. It works with both positive and negative numbers, following the 
sign of the divisor. 
Important Key Points: 

1. MOD(number, divisor) returns the remainder of division. 
2. Result has the same sign as the divisor. 
3. Useful for checking even/odd numbers, cycling values, or extracting parts of numbers. 
4. If divisor is 0, it returns #DIV/0! error. 

Knowledge Booster: 
• (a) QUOTIENT() → Returns only the integer portion (quotient) of division; discards remainder. 
• (b) DIVIDE() → No such built-in function exists in Excel. 
• (c) REMAINDER() → No such built-in function exists in Excel. 
• (e) ROUND() → Rounds a number to a specified number of digits; not related to division 

remainder. 
 

S23. Ans.(b) 
The process of creating an additional copy of data to protect it from loss, corruption, or damage is called 
a backup. Backups are stored separately (on external drives, cloud storage, or tapes) and can be used 
to recover the original data in case of hardware failure, accidental deletion, ransomware, or disasters. 
Regular backups are a fundamental part of data protection and disaster recovery strategies. 
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Important Key Points: 
1. Backup involves copying data to a separate location or medium. 
2. Purpose is to enable recovery after data loss or damage. 
3. Can be full, incremental, or differential depending on strategy. 
4. Essential for personal, business, and enterprise data security. 

Knowledge Booster: 
• (a) Formatting → Erases all data on a storage device and prepares it for use. 
• (c) Restoration → Process of recovering data from a previously created backup. 
• (d) Archiving → Moving infrequently accessed data to long-term storage; not primarily for 

protection. 
• (e) Encryption → Secures data by scrambling it; protects confidentiality, not against loss. 
 

S24. Ans.(b) 
In UNIX systems, the shell is the program that serves as the primary interface between the user and the 
operating system kernel. It accepts user commands, interprets them, and requests the kernel to execute 
programs, manage files, or interact with hardware resources through system calls. Common shells 
include bash, sh, csh, and zsh. The shell translates human-readable commands into actions performed 
by the kernel, which directly controls hardware. 
Important Key Points: 

1. Shell is a command-line interpreter in UNIX/Linux systems. 
2. It acts as the intermediary between users and the kernel. 
3. Handles input/output, command execution, scripting, and environment variables. 
4. Kernel communicates with hardware; shell enables users to invoke kernel services indirectly. 

Knowledge Booster: 
• (a) Compiler → Translates high-level code to machine code; no direct user-kernel interface role. 
• (c) Terminal → Hardware or software window for interacting with the shell; not the interface 

itself. 
• (d) Command → Individual instructions executed by the shell; not the interface program. 
• (e) Process → Running instance of a program; managed by the kernel, not the user interface. 
 

S25. Ans.(c) 
A Personal Area Network (PAN) connects devices within a very short range (typically up to 10 
meters) around an individual. Infrared (IrDA) is a common wireless technology historically used for 
PAN communication, especially for direct device-to-device data transfer (e.g., between older mobile 
phones, PDAs, laptops, or remote controls). While Bluetooth is the dominant modern PAN technology, 
Infrared remains a recognized and commonly cited option in networking fundamentals for short-range, 
line-of-sight communication in PANs. 
Important Key Points: 

1. PAN operates over a very limited personal range (few meters). 
2. Infrared uses light waves for direct, point-to-point wireless communication. 
3. Requires line-of-sight and is low-cost with moderate speed. 
4. Commonly associated with legacy PAN implementations alongside Bluetooth. 

Knowledge Booster: 
• (a) Twisted Pair Cable → Used in LANs (e.g., Ethernet UTP cables); wired, not typical for personal 

wireless PAN. 
• (b) Coaxial Cable → Used in older LANs or cable TV; medium-range wired medium. 
• (d) Satellite → Used for WAN communication over very long distances. 
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• (e) Fiber Optic Cable → High-speed medium for LAN/MAN/WAN backbones; not practical for 
personal area mobility. 

 
S26. Ans.(c) 
In Microsoft Excel, pressing the Alt key alone activates the ribbon menu bar. It displays key tips (small 
letters or numbers) overlaid on each ribbon tab (e.g., H for Home, N for Insert). The user can then press 
the corresponding key to access that tab and further keys to select commands. This provides full 
keyboard navigation of the menu options without using the mouse. 
Important Key Points: 

1. Alt key activates the ribbon key tips in Excel. 
2. Subsequent key presses navigate tabs and commands hierarchically. 
3. Works across all Microsoft Office applications with ribbon interface. 
4. Pressing Alt again or Esc deactivates the key tips mode. 

Knowledge Booster: 
• (a) Ctrl → Used for command shortcuts (e.g., Ctrl+S for Save); does not activate menu bar. 
• (b) Shift → Modifier for selection or case change; no menu activation role. 
• (d) Tab → Moves focus between cells or dialog controls; not for ribbon access. 
• (e) Esc → Cancels current action or closes dialogs; deactivates key tips if active. 
 

S27. Ans.(b) 
Integrated Circuits (ICs), particularly microprocessors built on IC chips, are the defining technology 
of microcomputers. Microcomputers (also called personal computers or PCs) rely on a single-chip CPU 
(e.g., Intel 4004 was the first microprocessor in 1971). This distinguishes them from earlier generations 
that used discrete transistors or multiple chips. While ICs are now used in all modern computer types, 
the question refers to the category originally defined by the use of IC-based microprocessors. 
Important Key Points: 

1. Microcomputers are built around microprocessor IC chips. 
2. The invention of the integrated circuit microprocessor enabled small, affordable personal 

computers. 
3. All modern computers use ICs, but microcomputers are specifically named after this technology. 
4. First commercial microcomputer: Altair 8800 (1975) using Intel 8080 IC. 

Knowledge Booster: 
• (a) Mini Computer → Used multiple ICs but not single-chip microprocessor; larger than 

microcomputers (e.g., PDP-8). 
• (c) Mainframe Computer → Large systems using many ICs; predated widespread microprocessor 

use. 
• (d) Super Computer → High-performance systems using thousands of ICs/processors; not 

defined by single IC. 
• (e) Hybrid Computer → Combines analog and digital; uses ICs but not specifically defined by 

them. 
 

S28. Ans.(e) 
A Uniform Resource Locator (URL) specifies the location of a resource on the internet. Its standard 
components include the protocol (e.g., HTTPS), domain (e.g., example.com), path (e.g., /page.html), 
and query (e.g., ?key=value). Bandwidth refers to the data transfer rate of a network connection and 
is not a part of a URL's structure. 
Important Key Points: 

1. Protocol indicates the access method (e.g., http:// or https://). 
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2. Domain specifies the server hostname or IP address. 
3. Path identifies the specific resource or file on the server. 
4. Query provides parameters for dynamic content in key-value pairs. 

Knowledge Booster: 
• (a) Protocol → Defines the communication scheme, mandatory in URLs. 
• (b) Domain → Core component identifying the destination server. 
• (c) Path → Points to the exact resource location on the server. 
• (d) Query → Optional string for passing data to the resource. 
 

S29. Ans.(c) 
An IPv6 address is a 128-bit address represented in hexadecimal format. It consists of eight groups of 
four hexadecimal digits, separated by colons (e.g., 2001:0db8:85a3:0000:0000:8a2e:0370:7334). 
Leading zeros in each group can be omitted, and consecutive sections of all zeros can be compressed 
with "::" once per address. This hexadecimal representation makes the long 128-bit address more 
compact and readable compared to binary or dotted-decimal formats. 
Important Key Points: 

1. IPv6 addresses are 128 bits long. 
2. Represented as eight 16-bit blocks in hexadecimal, separated by colons. 
3. Allows compression rules: omit leading zeros and replace one consecutive zero block with "::". 
4. Hexadecimal digits range from 0–9 and A–F (case-insensitive). 

Knowledge Booster: 
• (a) Binary → Too lengthy (128 bits as 0s and 1s); not used for human-readable representation. 
• (b) Decimal → Used in IPv4 (dotted-decimal); IPv6 would be extremely long if fully decimal. 
• (d) Octal → Not used for IP addressing standards. 
• (e) ASCII → Text encoding for characters; not a numeric representation for addresses. 
 

S30. Ans.(c) 
A dynamic website generates and updates content in real-time based on user interactions, database 
queries, session data, or external inputs. It uses server-side languages (e.g., PHP, Python, Node.js) or 
client-side scripting (e.g., JavaScript) to provide personalized and interactive experiences. Content 
changes frequently without manual page edits, such as showing different products, user profiles, or live 
feeds. 
Important Key Points: 

1. Dynamic websites render content on-the-fly using code and databases. 
2. They respond to user interaction (e.g., searches, logins, forms). 
3. Frequent updates occur automatically based on data or actions. 
4. Examples include e-commerce sites, social media, and news portals. 

Knowledge Booster: 
• (a) Displays fixed content to all users → Describes static websites. 
• (b) Created only with static HTML pages → Static sites use only HTML/CSS; dynamic require 

scripting. 
• (d) Cannot be modified once published → Opposite of dynamic; static sites need manual edits. 
• (e) Contains only text and images → Applies to basic static sites; dynamic can include multimedia 

and interactive elements. 
 

S31. Ans.(c) 
UNIX (and its derivatives like Linux, BSD) is historically and primarily recognized for its strong security 
features. Its design includes principles such as least privilege, modular architecture, user/group 
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permissions, secure process isolation, and robust access controls. These foundational security concepts 
originated in the original UNIX developed at Bell Labs and have influenced modern secure systems. 
UNIX-like systems are widely used in servers, critical infrastructure, and security-focused 
environments due to their proven reliability and security model. 
Important Key Points: 

1. UNIX introduced core security principles like file permissions and user isolation. 
2. It uses a multi-user design with strict access controls (read/write/execute bits). 
3. Features least privilege and process separation by default. 
4. Basis for POSIX standards; highly auditable and configurable for security. 

Knowledge Booster: 
• (a) Windows → Has improved security over time but historically vulnerable due to large attack 

surface and legacy compatibility. 
• (b) macOS → Strong security (e.g., SIP, Gatekeeper) but built on UNIX; not the primary historical 

reference. 
• (d) Android → Linux-based but modified for mobile; weakened by app permissions and 

fragmentation. 
• (e) MS-DOS → Single-user, no memory protection or access controls; highly insecure by modern 

standards. 
 

S32. Ans.(b) 
A worm is a standalone malware program that can self-replicate and spread automatically across 
networks or systems without needing to attach to another file or requiring user intervention. It exploits 
vulnerabilities in operating systems or networks to propagate rapidly (e.g., via email, shared drives, or 
open ports). Famous examples include the ILOVEYOU and Conficker worms. This autonomous 
spreading distinguishes worms from other malware types. 
Important Key Points: 

1. Worms self-replicate and spread independently over networks. 
2. They do not require a host file or user action to propagate. 
3. Often exploit security vulnerabilities for automatic transmission. 
4. Can cause massive outbreaks by consuming bandwidth and resources. 

Knowledge Booster: 
• (a) Virus → Attaches to legitimate files/programs; requires user action (e.g., opening file) to 

spread. 
• (c) Trojan → Disguises as useful software; does not self-replicate or spread automatically. 
• (d) Spyware → Secretly monitors and collects user data; no self-replication or automatic 

spreading. 
• (e) Adware → Displays unwanted advertisements; focuses on revenue, not replication or 

spreading. 
 

S33. Ans.(a) 
Core VoIP technology refers to platforms primarily designed for real-time voice (and video) 
communication over the internet using VoIP protocols. Skype, Zoom, and Google Meet are dedicated 
VoIP/video conferencing services built entirely around this technology. Skype pioneered consumer 
VoIP with its proprietary (later evolved) protocol. Zoom and Google Meet use VoIP standards with 
optimizations for high-quality audio/video calls and meetings. Other options include messaging apps 
with added VoIP features or non-VoIP streaming/email services. 
Important Key Points: 

1. VoIP transmits voice as digital packets over IP networks. 
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2. Skype, Zoom, and Google Meet are purpose-built VoIP/video calling platforms. 
3. They support real-time audio/video without relying on traditional telephony as primary 

function. 
4. "Purely" means the core service is VoIP-based communication. 

Knowledge Booster: 
• (b) WhatsApp, Facebook, Instagram → Primarily messaging/social apps; voice/video is 

secondary VoIP feature. 
• (c) Gmail, Outlook, Yahoo → Email services; no native VoIP calling. 
• (d) Telegram, Signal, Messenger → Messaging apps with optional VoIP calls; not core VoIP 

platforms. 
• (e) YouTube, Netflix, Spotify → Video/audio streaming services; not real-time VoIP 

communication. 
 

S34. Ans.(d) 
In research methodology, the Research Plan (also known as research design or methodology section) 
is the element that clearly defines the scope, boundaries, objectives, procedures, data collection 
methods, and overall framework of the study. It outlines what will be studied, what will be excluded 
(delimitations), and how the research will be conducted to achieve reliable and valid results. This 
ensures the research remains focused and manageable. 
Important Key Points: 

1. Research Plan details the overall strategy and structure of the study. 
2. It explicitly states scope (what is included) and boundaries/delimitations (what is excluded). 
3. Includes clear research objectives (general and specific). 
4. Forms the core of the research design in methodology. 

Knowledge Booster: 
• (a) Research Hypothesis → A testable prediction or assumed relationship; does not define 

overall scope or boundaries. 
• (b) Feasibility Study → Assesses practicality and resources before starting; preliminary, not part 

of research design. 
• (c) System Requirement Specification (SRS) → Document used in software engineering; not a 

research methodology element. 
• (e) Project Proposal → Outlines idea, objectives, and justification to seek approval/funding; less 

detailed than the full research plan. 
 

S35. Ans.(b) 
GPS (Global Positioning System) is a radio-based satellite navigation system. It works using a 
constellation of satellites (senders/transmitters) that broadcast signals, a network of ground control 
computers that manage the system, and receivers (in devices like phones or GPS units) that calculate 
position by trilateration. The communication is one-way from satellites to receivers, enabling precise 
global location and timing services. 
Important Key Points: 

1. GPS uses radio signals from satellites for navigation. 
2. System includes satellites (senders), control segment (computers), and user receivers. 
3. Receivers compute position using time differences in signals from multiple satellites. 
4. Operates worldwide, 24/7, independent of weather conditions. 

Knowledge Booster: 
• (a) Bluetooth → Short-range wireless technology for device-to-device communication; not a 

navigation system. 
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• (c) Wi-Fi → Wireless local network technology for internet access; no navigation capability. 
• (d) Radar → Radio-based detection and ranging system; measures distance/speed of objects, not 

global positioning. 
• (e) Infrared → Line-of-sight short-range communication (e.g., remote controls); not radio-based 

or used for navigation. 
 

S36. Ans.(a) 
Windows Server is a family of operating systems developed by Microsoft specifically for server 
environments. It is designed to manage networks, host applications, provide file and print services, act 
as a web server, and distribute data or services to multiple connected client systems. Features like 
Active Directory, IIS, remote desktop services, and robust networking make it the primary server OS 
focused on managing and distributing resources in enterprise settings. 
Important Key Points: 

1. Windows Server is Microsoft's dedicated server operating system. 
2. It supports roles like domain controller, file server, web server, and application hosting. 
3. Provides centralized management through tools like Active Directory. 
4. Designed for high availability, scalability, and multi-user client access. 

Knowledge Booster: 
• (b) Solaris → Server-capable Unix OS (originally by Sun, now Oracle); suitable but not the 

primary example in most contexts. 
• (c) MS-DOS → Single-user, single-tasking disk OS for personal computers; no server capabilities. 
• (d) VxWorks → Real-time embedded OS for devices; not a general-purpose server OS. 
• (e) UNIX (Time-sharing version) → Multi-user OS capable of server roles but refers to general 

Unix, not specifically a server edition. 
•  

Q37. Ans.(c) 
The Strikethrough option in Microsoft Word applies a horizontal line that runs through the middle of 
the selected text. This formatting is commonly used to indicate deleted or no-longer-relevant content 
(e.g., in drafts or revisions) while keeping the original text visible. It is found in the Home tab under the 
Font group or via the shortcut Ctrl + D (Font dialog) or Alt + K in some versions. 
Important Key Points: 

1. Strikethrough draws a horizontal line through the center of text. 
2. It is a font formatting option, not a color or case change. 
3. Useful for showing deletions in tracked changes or editing. 
4. Can be applied via Home tab → Font group → Strikethrough button. 

Knowledge Booster: 
• (a) Underlines the text → Performed by the Underline option. 
• (b) Draws a line above the text → Known as Overline (not standard in Word). 
• (d) Changes text color → Done via Font Color tool. 
• (e) Converts text to uppercase → Achieved with Change Case → UPPERCASE. 
 
 

S38. Ans.(a) 
In Windows File Explorer, the View modes (available under the View tab or right-click menu) control 
how files and folders are displayed. The classic and still-valid modes include Icons (large, medium, 
small, extra large), Tiles, List, and Details. These were the primary options in older Windows versions 
(XP, Vista, 7) and remain accessible in modern Windows (10/11) via the "Layout" section in the View 
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tab or legacy contexts. Modern Windows adds "Content" and "Compact" views, but option (a) contains 
only historically valid and still-supported view modes. 
Important Key Points: 

1. Icons, Tiles, List, and Details are long-standing File Explorer view modes. 
2. Accessed via View tab → Layout group in current Windows. 
3. Details shows columns (name, size, date); List shows small icons vertically; Tiles shows 

medium icons with info. 
4. These modes remain compatible and selectable in Windows 11. 

Knowledge Booster: 
• (b) Preview, Table, Grid, Zoom → Preview pane exists but is not a view mode; others are not 

valid modes. 
• (c) Outline, Summary, Report, Icon → Legacy terms from very old Windows or other apps; not 

File Explorer modes. 
• (d) Sort, Filter, Group, Arrange → These are organization commands, not display view modes. 
• (e) Folder, Link, Tree, Network → Navigation concepts or panes; not view modes for file listing. 
 

S39. Ans.(d) 
In computer networking, data is transmitted by adding multiple layers of headers as it passes down the 
protocol stack (e.g., TCP/IP or OSI model). Each layer (Application, Transport, Network, Data Link) 
appends its own header (and sometimes trailer) to the payload from the layer above. This combination 
of headers accompanies the original data packet from source to destination, allowing proper 
processing, routing, and delivery at each hop and layer. The term that refers to this layered set of 
protocols and their associated headers is the protocol stack. 
Important Key Points: 

1. Protocol stack is the layered set of protocols (e.g., TCP/IP stack). 
2. Each layer adds its own header during transmission (encapsulation). 
3. The combined headers guide the packet through networks to the destination. 
4. At the receiver, headers are removed layer by layer (decapsulation). 

Knowledge Booster: 
• (a) Data Link → Refers to Layer 2; handles framing, not the full header combination. 
• (b) Data Encapsulation → The process of adding headers; not the name for the header 

combination itself. 
• (c) Packet Switching → Network technique for routing packets; unrelated to headers. 
• (e) Frame Segmentation → Breaking large packets into smaller frames; not about headers. 
 

S40. Ans.(b) 
RAID (Redundant Array of Independent Disks) is a storage technology that combines multiple physical 
disks into a single logical unit. Certain RAID levels (e.g., RAID 1, RAID 5, RAID 6, RAID 10) store 
duplicate copies of data across disks using techniques like mirroring and parity. This provides 
redundancy (reliability against drive failure) and often striping (balanced distribution) to improve 
read/write performance. Data is automatically rebuilt if a disk fails, ensuring both speed and fault 
tolerance. 
Important Key Points: 

1. RAID uses multiple disks to store redundant (duplicate) data copies. 
2. Levels like RAID 1 (mirroring) and RAID 5 (striping with parity) balance performance and 

reliability. 
3. Improves fault tolerance (data survives disk failure) and I/O performance. 
4. Managed by hardware controllers or software in operating systems. 
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Knowledge Booster: 
• (a) Cloud Storage → Provides remote storage with possible 

replication, but not specifically for balanced local duplicate 
copies. 

• (c) Virtual Memory → Uses disk space to extend RAM; no 
duplication or redundancy for reliability. 

• (d) Cache Memory → Fast temporary storage for frequently 
accessed data; no duplication across devices. 

• (e) SSD → High-speed single storage drive; no built-in 
duplication or array management. 
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